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About

This

Manual

The LabVIEW Instrument I/O VI Reference Manual contains 
descriptions for the use and development of LabVIEW instrument 
drivers and LabVIEW virtual instruments (VIs) for GPIB, VXIbus, and 
serial port I/O operation. 

This manual is a supplement to your LabVIEW User Manual and 
assumes that you are familiar with that material. You should also know 
how to operate LabVIEW, and your computer and operating system. 

Organization of This Manual

The LabVIEW Instrument I/O VI Reference Manual is organized as 
follows:

• Chapter 1, Introduction, contains an overview of LabVIEW 
instrument drivers and the GPIB, serial port, instrument driver 
template and VISA transition library VIs. It also contains a history 
of the GPIB, and an explanation of GPIB improvements and 
standards. 

• Chapter 2, Overview of LabVIEW Instrument Drivers, contains an 
overview of the LabVIEW instrument driver model, VIs, and VI 
templates.

• Chapter 3, Developing a LabVIEW Instrument Driver, describes 
the procedure for developing a LabVIEW instrument driver.

• Chapter 4, Instrument Driver Template VIs, describes the 
Instrument Driver Template VIs.

• Chapter 5, VISA Library Reference, describes the VISA (Virtual 
Instrument Software Architecture) Transition Library.

• Chapter 6, Traditional GPIB Functions, describes the traditional 
GPIB Functions. You use these functions to handle situations 
outside the scope of the IEEE 488.2 standard.

• Chapter 7, GPIB 488.2 Functions, describes the IEEE 488.2 
(GPIB) Functions.
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• Chapter 8, Serial Port VIs, describes the VIs for serial port 
operations.

• Appendix A, Multiline Interface Messages, lists multiline interface 
messages, which are commands that IEEE 488 defines. 

• Appendix B, Operation of the GPIB, describes basic concepts you 
need to understand to operate the GPIB.

• Appendix C, Instrument I/O VI Common Questions, lists answers 
to questions frequently asked by LabVIEW users.

• Appendix D, Error Codes, lists error codes returned by LabVIEW 
functions, including the name and description of each code.

• Appendix E, Customer Communication, contains forms you can 
use to request help from National Instruments or to comment on 
our products and manuals.

• The Glossary contains an alphabetical list and description of terms 
used in this manual, including abbreviations, acronyms, metric 
prefixes, mnemonics, and symbols. 

• The Index contains an alphabetical list of key terms and topics in 
this manual, including the page where you can find each one.

Conventions Used in This Manual

The following conventions are used in this manual:

bold Bold text denotes a parameter, menu item, return value, function panel 

item, or dialog box button or option.

italic Italic text denotes emphasis, a cross reference, or an introduction to a 

key concept. 

bold italic Bold italic text denotes a note, caution, or warning.

monospace Text in this font denotes text or characters that you should literally 

enter from the keyboard.  Sections of code, programming examples, 

and syntax examples also appear in this font.  This font also is used for 

the proper names of disk drives, paths, directories, programs, 

subprograms, subroutines, device names, variables, filenames, and 

extensions, and for statements and comments taken from program code. 

italic Italic text in this font denotes that you must supply the appropriate

monospace words or values in the place of these items.

<> Angle brackets enclose the name of a key.  A hyphen between two or 

more key names enclosed in angle brackets denotes that you should 
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simultaneously press the named keys—for example, <Ctrl-Alt-

Delete>.

<enter> Key names are lowercase

» The » symbol leads you through nested menu items and dialog box 

options to a final action. The sequence 

File»Page Setup»Options»Substitute Fonts 

directs you to pull down the File menu, select the Page Setup item, 

select Options, and finally select the Substitute Fonts option from the 

last dialog box. 

paths Paths in this manual are denoted using backslashes (\) to separate drive 

names, directories, and files, as in 

drivename\dir1name\dir2name\myfile

IEEE 488.1 IEEE 488.1 and IEEE 488.2 refer to the ANSI/IEEE Standard 

and 488.1-1987 and the ANSI/IEEE Standard 488.2-1987, respectively,

IEEE 488.2 which define the GPIB.

Warning: This icon to the left of bold italicized text denotes a warning, which alerts 

you to the possibility of damage to you or your equipment.

Caution: This icon to the left of bold italicized text denotes a caution, which alerts 

you to the possibility of data loss or a system crash.

Note: This icon to the left of bold italicized text denotes a note, which alerts you 

to important information.

Data Types Each VI description gives a data type picture for 
each control and indicator, as illustrated in the 
following table.

Control Indicator Data Type

Boolean

String

Unsigned 32-Bit Integer

Unsigned 16-Bit Integer

Unsigned 8-Bit Integer
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Abbreviations, acronyms, metric prefixes, mnemonics, symbols, and 
terms are listed in the Glossary.

Related Documentation

The following documents contain information that you may find 
helpful as you read this manual:

• LabVIEW Tutorial

• LabVIEW User Manual

• LabVIEW Function Reference Manual

• LabVIEW VXI VI Reference Manual

• IEEE Standard Digital Interface for Programmable 

Instrumentation, ANSI/IEEE Standard 488.1-1987

• IEEE Standard Codes, Formats, Protocols, and Common 

Commands, ANSI/IEEE Standard 488.2-1987

Signed 32-Bit Integer

16-Bit Integer (Word)

Cluster of Clusters or Cluster of Arrays

Array of 16-Bit Integers (Word)

Array of Unsigned 8-bit integers

Boolean Array

String array

Refnum

Double-Precision Floating Point Number

Array of Double-Precision Floating Point 
Numbers

Control Indicator Data Type
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Customer Communication

National Instruments wants to receive your comments on our products 
and manuals. We are interested in the applications you develop with 
our products, and we want to help if you have problems with them. To 
make it easy for you to contact us, this manual contains comment and 
configuration forms for you to complete. These forms are in 
Appendix E, Customer Communication, at the end of this manual. 
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Introduction

Chapter

1

This chapter contains an overview of LabVIEW instrument drivers and 
the GPIB, serial port, instrument driver template and VISA VIs and 
functions. It also contains a history of the GPIB, and an explanation of 
GPIB improvements and standards. 

Instrument Driver Overview

Introduction to Instrument Drivers
A LabVIEW instrument driver is a set of VIs that control a 
programmable instrument. Each VI corresponds to a programmatic 
operation such as configuring, reading from, writing to, or triggering 
the instrument. LabVIEW instrument drivers simplify instrument 
control and reduce test program development time by eliminating the 
need to learn the low-level programming protocol for each instrument. 

The LabVIEW instrument driver library contains instrument drivers for 
a variety of programmable instrumentation, including GPIB, VXI, and 
serial. If a driver for your instrument is in the library, you can use it as 
is to control your instrument. Instrument drivers are distributed with 
their block diagram source code, so you can customize them for your 
specific application. If a driver for your particular instrument does not 
exist, you can:

• Try using a driver for a similar instrument. Often similar 
instruments from the same manufacturer have similar if not 
identical instrument drivers.

• Modify the Instrument Driver Template VIs to create a new driver 
for your instrument.

• Use either the GPIB, VXI, Serial, or VISA I/O libraries provided 
with LabVIEW to send commands directly to your instrument.

Instrument Driver Distribution
LabVIEW instrument drivers are distributed in a variety of media 
including electronic via bulletin board and internet and CD-ROM.
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Instrument Driver Bulletin Board Access
You can download the latest versions of the LabVIEW instrument 
drivers from one of the National Instruments bulletin boards. The 
bulletin boards are located in National Instruments offices in the 
United States, United Kingdom, and France. All of the bulletin boards 
can auto baud to 9,600 baud and use 8 data bits, 1 stop bit, and no 
parity. The United States bulletin board handles up to 14,400 baud. 
Telephone numbers for the bulletin boards are:

United States (512) 794-5422

United Kingdom (0635) 551422

Outside the United Kingdom (44) 635 551422

France (1) 48 65 15 59

Outside France (33) 1 48 65 15 59

Instrument Driver Internet Access
If you have internet access, you can download the latest instrument 
driver files from the National Instrument File Transfer Protocol (FTP) 
site. Use FTP to log on to host ftp.natinst.com. Use 
anonymous as the user name and your e-mail address as the password. 
The instrument drivers are in the following locations:

LabVIEW for Windows

/support/labview/windows/instruments/

LabVIEW for Sun

/support/labview/sun/instruments/

LabVIEW for Macintosh

/support/labview/mac/instruments/

CD-ROM Instrument Driver Distribution
The entire library of LabVIEW instrument drivers is available on 
CD-ROM. The instrument driver CD-ROM is available from National 
Instruments at no charge.

You can retrieve the latest instrument driver list on a touch-tone phone 
by calling the National Instruments automated fax system, Fax Back, 
at (512) 418-1111 or by calling National Instruments.
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Instrument Driver Template VIs
The LabVIEW instrument driver templates are the foundation for all 
LabVIEW instrument driver development. The templates have a 
simple, flexible structure and a common set of instrument driver VIs 
that you can use for driver development. The VIs establish a standard 
format for all LabVIEW drivers and each has instructions for 
modifying it for a particular instrument. 

The LabVIEW instrument driver templates are predefined instrument 
driver VIs that perform common operations such as initialization, 
self- test, reset, error query, and so on. Instead of developing your own 
VIs to accomplish these tasks, you should use the LabVIEW 
instrument driver template VIs, which already conform to the 
LabVIEW standards for instrument drivers. 

The following table lists the Instrument Driver Template VIs:

Instrument Driver Template VI Description

PREFIX Init Establishes communication with the instrument and 
performs user selectable identification query and reset 
operations.

PREFIX Close Terminates communication with the instrument.

PREFIX Revision Queries the instrument driver and instrument firmware 
revisions.

PREFIX Self-Test Performs an instrument self-test and returns the result. 

PREFIX Reset Places the instrument in a known state.

PREFIX Error Query Queries the instrument for errors.

PREFIX Error Message Converts error numbers from other instrument driver 
functions to user-readable strings.

PREFIX Message-Based Template A template for creating instrument driver VIs for a 
message-based instrument.

PREFIX Register-Based Template A template for creating instrument driver VIs for a 
register-based instrument.
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VISA Library Reference Overview

VISA Functions
VISA (Virtual Instrument Software Architecture) is a single interface 
library for controlling VXI, GPIB, RS-232, and other types of 
instruments. The VISA Library provides a standard set of I/O routines 
used by all LabVIEW instrument drivers. Using the VISA functions, 
you can construct a single instrument driver VI which controls a 
particular instrument model across different I/O interfaces. 

An instrument descriptor string is passed to the VISA Open function in 
order to select which kind of I/O will be used to communicate with the 
instrument. Once the session with the instrument is open, functions 
such as VISA Read and VISA Write perform the instrument I/O 
activities in a generic manner such that the program is not tied to any 
specific GPIB or VXI functions.   Such an instrument driver is 
considered to be interface independent and can be used as is in different 
systems.

Instrument drivers which use the VISA functions perform activities 
specific to the instrument, not to the communication interface. This 
creates more opportunities for using the instrument driver in many 
diverse situations.

The following table lists the VISA functions:

VISA Function Description

VISA Assert Trigger Asserts a software or hardware trigger.

VISA Clear Performs an IEEE 488.1-style clear of the device.

VISA Close Closes a specified device session.

VISA Disable Event Disables servicing of an event. Event occurrences already 
queued are not lost.

VISA Discard Events Discards all pending occurrences of the specified event types 
and mechanisms from the specified session.

VISA Enable Event Enables notification of a specified event.
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VISA Find Resource Queries the system to locate the devices associated with a 
specified interface.

VISA In 8/16/32 Reads in 8-bits, 16-bits, or 32-bits of data, respectively, from 
the specified memory space.

VISA Lock Establishes exclusive access to the specified resource.

VISA Map Address Maps in a specified memory space.

VISA Memory Allocation Returns an offset into a device’s region that has been allocated 
for use by the session.

VISA Memory Free Frees the memory previously allocated by the VISA Memory 
Allocation function.

VISA Move In 8/16/32 Moves a block of data from device memory to local memory 
in accesses of 8-bits, 16-bits, or 32-bits, respectively.

VISA Move Out 8/16/32 Moves a block of data from local memory to device memory 
in accesses of 8-bits, 16-bits, or 32-bits, respectively.

VISA Open Opens a session to the specified device and returns a session 
identifier.

VISA Out 8/16/32 Writes 8-bits, 16-bits, or 32-bits of data, respectively, to the 
specified memory space.

VISA Peek 8/16/32 Reads an 8-bit, 16-bit, or 32-bit value, respectively, from the 
mapped memory region.

VISA Poke 8/16/32 Writes an 8-bit, 16-bit, or 32-bit value, respectively, to the 
mapped memory region.

VISA Read Reads data from a device.

VISA Read STB Reads a service request status from a message-based device.

VISA Status Description Retrieves a user-readable string that describes the status code.

VISA Unlock Relinquishes the lock previously obtained using the VISA 
Lock function.

VISA Function Description
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VISA Attribute Node

The VISA Attribute Node gets and/or sets the indicated attributes. The 
following table lists the VISA attributes:

VISA Unmap Address Unmaps memory space previously mapped by VISA Map 
Address.

VISA Wait On Event Suspends execution of a thread of application and waits for an 
event of the specified type.

VISA Write Writes data to the device.

VISA Attribute Description

FDC Mode Specifies which fast data channel (FDC) transfer mode to use 
(VXI only).

FDC Number Determines which FDC will be used to transfer the buffer 
(VXI only).

FDC Pairs Specifies use of a channel pair for transferring data.

FDC Signal Enable Lets the servant send a signal when control of the FDC 
channel is passed back to the commander.

GPIB Primary Address Specifies the primary address of the GPIB device used by the 
given session.

GPIB Secondary Address Specifies the secondary address of the GPIB device used by 
the given session.

IO Protocol Specifies which protocol to use.

Immediate Servant Determines if the VXI device is an immediate servant of the 
local controller.

Increment Destination Count Specifies the number of elements by which to increment the 
destination address on block move operations.

VISA Function Description
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Increment Source Count Specifies the number of elements by which to increment the 
source address on block move operations.

Interface Number Specifies the board number for the given interface.

Interface Type Specifies the interface type of the given session.

Mainframe Logical Address Specifies the lowest logical address in the mainframe.

Manufacturer ID The manufacturer identification number of the VXIbus 
device.

Maximum Queue Length Specifies the maximum number of events that can be queued 
at any time on the given session.

Model Code Specifies the model code for the VXIbus device.

Resource Lock State Reflects the current locking state of the resource that is 
associated with the given session.

Resource Manufacturer ID A value corresponding to the VXI manufacturer ID of the 
manufacturer that created the implementation.

Resource Manufacturer Name A string that corresponds to the VXI manufacturer name of 
the manufacturer that created the implementation.

Resource Name Unique identifier for a resource.

Send End Enable Specifies whether to assert END during the transfer of the 
last byte of the buffer.

Slot Specifies the physical slot location of the VXIbus device.

Suppress End Enable Specifies whether to suppress the END bit termination.

Termination Character The termination character.

Termination Character Enable Determines whether the read operation should terminate 
when a termination character is received.

Timeout Value Specifies the timeout value to use when accessing the device 
associated with the given session.

VISA Attribute Description
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Trigger Identifier Identifier for the current triggering mechanism.

User Data Used privately by the application for a particular session.

Version of Implementation Uniquely identifies the current revision or implementation of 
a resource.

Version of Specification Uniquely identifies the version of the VISA specification to 
which the implementation is compliant.

VXI Commander LA The logical address of the commander of the VXI device.

VXI Logical Address Specifies the logical address of the VXI device used by the 
given session.

VXI Memory Address Space Specifies the VXIbus address space used by the device.

VXI Memory Base Address Specifies the base address of the device in VXIbus memory 
address space.

VXI Memory Size Specifies the size of memory requested by the device in 
VXIbus address space.

Window Access Specifies the modes in which the current window may be 
accessed.

Window Base Address Specifies the base address of the interface bus to which this 
window is mapped.

Window Size Specifies the size of the region mapped to this window.

VISA Attribute Description
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GPIB Function Overview

Introduction to the GPIB
The General Purpose Interface Bus (GPIB) is a link, or interface 
system, through which interconnected electronic devices 
communicate.

History of the GPIB
Hewlett-Packard designed the GPIB (originally called the HP-IB) to 
interconnect and control its line of programmable instruments. The 
GPIB was soon applied to other applications such as intercomputer 
communication and peripheral control because of its 1 Mbytes/s 
maximum data transfer rates. It was later accepted as IEEE Standard 
488-1975 and has since evolved into ANSI/IEEE Standard 488.1-1987. 
The versatility of the system prompted the name General Purpose 
Interface Bus. For a basic description of the GPIB, see Appendix B, 
Operation of the GPIB.

National Instruments brought the GPIB to users of 
non-Hewlett-Packard computers and devices, specializing in both 
high-performance, high-speed hardware interfaces and comprehensive, 
full-function software. The GPIB functions for LabVIEW follow the 
IEEE 488.1 specification.

The IEEE 488.2 Standard
The ANSI/IEEE Standard 488.2-1987 expanded on the earlier 
IEEE 488.1 standard to describe exactly how the Controller should 
manage the GPIB, including the standard messages that compliant 
devices should understand, the mechanisms for reporting device errors 
and other status information, and the various protocols that discover 
and configure compliant devices connected to the bus. 

The original standard, renamed IEEE 488.1, addressed only the 
hardware specifications of the GPIB cable and basic protocols. Its main 
shortcoming was that it left the interpretation of the standard as it 
applied to GPIB devices up to the instrument manufacturers. Thus, 
each GPIB instrument had a unique command set. To integrate each 
instrument into a particular GPIB system, programmers had to learn 
programming particulars for each device, a time-consuming and 
frustrating process. IEEE 488.2 specifically states how compliant 
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devices must communicate. This standard, along with Standard 
Commands for Programmable Instruments (SCPI), which defines 
specific function-dependent command sets, makes instrument 
programming more uniform. 

The IEEE 488.2 standard also addresses Controller issues, such as the 
capabilities a compatible Controller must have. For example, the 
ability to monitor any of the bus lines at any time is crucial for 
detecting active devices (Talkers and Listeners) on the GPIB. 
IEEE 488.2 also defines the bus commands and protocols a Controller 
must use. The new standard also lists minimum functionality 
requirements, which directly influence the style of the NI-488.2 
software in general and the GPIB 488.2 functions for LabVIEW in 
particular. See Appendix B, Operation of the GPIB, for more 
information on Talkers, Listeners, and Controllers.

Compatible GPIB Hardware
The following National Instruments GPIB hardware products are 
compatible with LabVIEW:

LabVIEW for Windows 3.x

AT-GPIB/TNT, AT-GPIB IEEE 488.2 interface board for the 
IBM PC AT and compatible computers 
that have 16-bit plug-in slots 

PCMCIA-GPIB IEEE 488.2 interface card for 
computers with Type II PCMCIA slots

MC-GPIB IEEE 488.2 interface board for the 
IBM PS/2 and compatible computers 
that have MicroChannel plug-in slots

GPIB-PCII/IIA IEEE 488.2 interface board for the 
IBM PC/XT/AT 

GD-GPIB IEEE 488.2 interface board for the 
GRiDCASE 1500 series computer

GPIB-232CT-A External RS-232/IEEE 488.2 
Controller

GPIB-1284CT External parallel/IEEE 488.2 
Controller



Chapter 1     Introduction

 National Instruments Corporation 1-11 LabVIEW Instrument I/O VI Reference Manual

LabVIEW for Windows NT

AT-GPIB/TNT, AT-GPIB IEEE 488.2 interface board for the 
IBM PC AT and compatible computers 
that have 16-bit plug-in slots 

LabVIEW for HP-UX

AT-GPIB/TNT Plug-in ISA IEEE 488.2 interface 
board for the HP series 700 

EISA-GPIB Plug-in EISA IEEE 488.2 interface 
board for the HP series 700

GPIB-ENET External Ethernet/IEEE 488.2 
Controller for the HP series 700

LabVIEW for Sun

SB-GPIB/TNT, SB-GPIB Plug-in IEEE 488.2 Controller for Sun 
SPARCstation series computers 

GPIB-SCSI-A External IEEE 488.2/SCSI Controller 
for Sun SPARCstation series 
computers

GPIB-ENET External Ethernet/IEEE 488.2 
Controller for Sun SPARCstation 
series computers

LabVIEW for Macintosh

NB-GPIB/TNT, NB-GPIB IEEE 488.2 interface board for 
Macintosh computers with full-size 
NuBus plug-in slots

NB-GPIB-P/TNT, NB-GPIB-P IEEE 488.2 interface board for 
Macintosh computers with half-size 
NuBus plug-in slots

LC-GPIB IEEE 488.2 interface board for the 
Macintosh LC series computers
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NB-DMA2800 IEEE 488 DMA interface board for 
Macintosh NuBus computers

NB-DMA-8-G IEEE 488 DMA interface board for 
Macintosh NuBus computers

GPIB-SCSI-A External SCSI-to-IEEE 488.2 
Controller

GPIB-SCSI External SCSI-to-IEEE 488 Controller

GPIB-422CT External RS-422/IEEE 488 Controller

Traditional GPIB Functions
The traditional GPIB functions are compatible with the GPIB boards 
listed in the Compatible GPIB Hardware section of this chapter. 

These traditional GPIB functions are compatible with existing 
LabVIEW programs. You can also use traditional GPIB functions with 
GPIB 488.2 functions to handle situations outside the scope of the 
IEEE 488.2 standard, such as communicating with devices that do not 
comply with the IEEE 488.2 standard and managing the bus in unusual 
ways. 

The following table lists the traditional GPIB functions:

Traditional GPIB 

Function

Description

GPIB Clear Clears a single device.

GPIB Initialization Configures characteristics of the GPIB interface.

GPIB Misc Performs specialized GPIB operations.

GPIB Read Reads data bytes from a GPIB device.

GPIB Serial Poll Serial polls a single device.

GPIB Status Indicates the status of the GPIB Controller.

GPIB Trigger Triggers a single device.

GPIB Wait Waits for a GPIB event to occur.
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LabVIEW GPIB 488.2 Functions
Using LabVIEW GPIB 488.2 functions together with 
IEEE 488.2-compatible devices improves the predictability of 
instrument and software behavior and lessens programming 
differences between instruments of different manufacturers.

The latest revisions of many National Instruments GPIB boards are 
fully compatible with the IEEE 488.2 specification for Controllers. 
The LabVIEW package also contains functions that make use of 
IEEE 488.2. By using these functions, your programming interface 
will strictly adhere to the IEEE 488.2 standard for command and data 
sequences.

The GPIB 488.2 functions contain the same basic functionality as the 
traditional GPIB functions, and include the following enhancements 
and additions:

• You specify the GPIB device address with an integer instead of a 
string. Further, you specify the bus number with an additional 
numeric control, which makes dealing with multiple GPIB 
interfaces easier.

• You can determine the GPIB status, error, and/or byte count 
immediately from the connector pane of each GPIB 488.2 
function. You no longer need to use the GPIB Status Function to 
obtain error and other information.

• The FindLstn Function implements the IEEE 488.2 Find All 
Listeners protocol. You can use this function at the beginning of 
an application to determine which devices are present on the bus 
without knowing their addresses.

• The GPIB Misc Function is still available, but it is no longer 
necessary in most cases. IEEE 488.2 specifies routines for most 
GPIB application needs, which are implemented as functions. 
However, you can mix the GPIB Misc Function, as well as other 
GPIB functions, with the GPIB 488.2 functions if you need to.

Wait for GPIB RQS Waits for the assertion of the SRQ line Service Request.

GPIB Write Sends data bytes to a single GPIB device.

Traditional GPIB 

Function

Description
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• There are GPIB 488.2 functions with low-level as well as 
high-level functionality, to suit any GPIB application. You can use 
the low-level functions in Non-Controller situations or when you 
need additional flexibility.

• Although you must use an IEEE 488.2-compatible Controller to 
use these functions, they can control both IEEE 488.1 and 
IEEE 488.2 devices. The GPIB 488.2 functions are divided into 
five functional categories: single-device, multiple-device, bus 
management, low-level, and general.

Single-Device Functions
The single-device functions perform GPIB I/O and control operations 
with a single GPIB device. In general, each function accepts a 
single-device address as one of its inputs. The following table lists the 
single-device functions:

Single-Device 

Function

Description

DevClear Clears a single device.

PPollConfig Configures a device for parallel polls.

PassControl Passes control to another device with Controller capability.

ReadStatusByte Serial polls a single device to get its status byte.

Receive Reads data bytes from a GPIB device.

Send Sends data bytes to a single GPIB device.

Trigger Triggers a single device.
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Multiple-Device Functions
The multiple-device functions perform GPIB I/O and control 
operations with several GPIB devices at once. In general, each function 
accepts an array of addresses as one of its inputs. 
The following table lists the mutiple-device functions:

Bus Management Functions
The bus management functions perform system-wide functions or 
report system-wide status. The following table lists the bus 
management functions:

Multiple-Device 

Function

Description

AllSpoll Serial polls all devices.

DevClearList Clears multiple devices simultaneously.

EnableLocal Enables operations from the devices' physical front panels.

EnableRemote Enables remote GPIB programming of devices.

FindRQS Determines which device is requesting service.

PPoll Performs a parallel poll.

PPollUnconfig Unconfigures a device for parallel polls.

SendList Sends data bytes to multiple GPIB devices.

TriggerList Triggers multiple devices simultaneously.

Bus Management 

Function

Description

FindLstn Finds all Listeners on the GPIB.

ResetSys Performs an IEEE 488.2 three-step system initialization.

SendIFC Clears the GPIB functions with Interface Clear.

SendLLO Sends the Local Lockout message to all devices.



Chapter 1     Introduction

LabVIEW Instrument I/O VI Reference Manual 1-16  National Instruments Corporation

Low-Level Functions
The low-level functions let you create a more specific, detailed 
program than higher-level functions. You use low-level functions for 
unusual situations or for situations requiring additional flexibility. 

The following table lists the low-level functions:

SetRWLS Places devices in the Remote Mode With Lockout State.

TestSRQ Determines the state of the SRQ line.

TestSys Instructs IEEE 488.2 devices to conduct self-tests.

WaitSRQ Suspends operation until SRQ is asserted.

Low-Level Function Description

SendDataBytes Sends data bytes to previously addressed devices.

RcvRespMsg Reads data bytes from a previously addressed device.

ReceiveSetup Prepares a device to send data bytes and prepares the GPIB 
interface to read them.

SendCmds Sends GPIB command bytes.

SendSetup Prepares particular devices to receive data bytes.

Bus Management 

Function

Description
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General Functions
The general functions are useful for special situations. The following 
table lists the general functions:

Serial Port VI Overview

The serial port VIs configure the serial port of your computer and 
conduct I/O using that port. The following table lists the serial port 
VIs:

General 

Function

Description

MakeAddr Formats a primary and secondary address for use with the GPIB 488.2 
Functions.

SetTimeOut Changes the global timeout period for all GPIB 488.2 Functions and sets the 
default timeout period for all GPIB functions.

Serial Port VI Description

Bytes at Serial Port Reports the number of bytes available in the serial port input 
buffer.

Serial Port Break Sends a break on the specified output port.

Serial Port Init Initializes the selected serial port by specifying the protocol, 
handshaking, and buffer size.

Serial Port Read Reads characters from the specified serial port.

Serial Port Write Writes a data string to the specified serial port.
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Overview of LabVIEW 
Instrument Drivers

Chapter

2

This chapter contains an overview of the LabVIEW instrument driver 
model, VIs, and VI templates.

Introduction

A LabVIEW instrument driver is a set of VIs that control a 
programmable instrument which each correspond to a programmatic 
operation. LabVIEW instrument drivers simplify instrument control 
and reduce test program development time by eliminating the need to 
learn the low-level programming protocol for each instrument.

The following two conceptual models help define a standard for 
LabVIEW instrument driver software design, development and use. 
The first model, the instrument driver external interface model, shows 
how the instrument driver interfaces with other system components. 
The second model, the instrument driver internal design model, defines 
the internal organization of an instrument driver software module. 
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LabVIEW Instrument Driver External Interface Model

The following figure shows a general model of how a LabVIEW 
instrument driver interfaces to the rest of the system:

Functional Body
The functional body is the actual code for the instrument driver. Refer 
to the LabVIEW Instrument Driver Internal Design Model section of this 
chapter, for more information.

The most successful instrument driver products have, historically, been 
developed by using a standard programming language for the 
functional body. This is the approach LabVIEW instrument drivers 
use. The advantages include greater developer control over the driver, 
more robust drivers, and increased functionality. LabVIEW instrument 
drivers are written using the standard LabVIEW graphical 
programming environment. 

The functional body of a LabVIEW instrument driver is a set of VIs 
that control a specific instrument. The source code for these VIs are 
block diagrams consisting of executable icons connected by data flow 
wires. Because the functional body is developed with the standard tools 

User Program

Instrument Driver

(Functional Body)

Interactive


Developer Interface

Programmatic


Developer Interface

VISA I/O InterfaceSubroutine Interface
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provided in LabVIEW, users can easily view instrument driver source 
code and optimize it for their application.

Interactive Developer Interface
The interactive developer interface of a LabVIEW instrument driver is 
the front panel. It is analogous to a physical instrument panel and is the 
interactive user interface of the VI. On the panel, controls and 
indicators graphically represent the inputs and outputs of the VI. With 
the LabVIEW front panel, users can interactively operate individual 
instrument driver VIs and verify communication.

Programmatic Developer Interface
The icon/connector is the programmatic interface of the LabVIEW 
instrument driver VI. It consists of a graphical representation of the VI 
(icon) and a definition of the input and output terminals for the VI 
(connector). When you call or execute a VI from another VI, you place 
a copy of the subVI icon/connector in the block diagram of the calling 
VI. Information passes between the two VIs through the connector 
terminals. There are several benefits to this approach. You can easily 
assemble test systems utilizing LabVIEW instrument drivers by 
combining a few instrument driver VIs, each using multiple 
parameters. The instrument driver interface in the user program is 
modular and easy to identify, and you can recall the VI front panels 
during debugging to understand how the program uses the instrument 
driver.

I/O Interface
An important consideration for instrument drivers is how they perform 
their I/O to and from instruments. The I/O interfaces for LabVIEW 
instrument drivers are the VISA and GPIB function libraries, and the 
VXI and Serial VI libraries. These libraries contain sets of functions 
and VIs that cover the capabilities of GPIB, VXIbus, and Serial bus 
capabilities, including both message-based and register-based 
programming, interrupt and event handling, and direct access to the 
VXI backplane.

VISA, an acronym for Virtual Interface Software Architecture, is a 
single interface library for controlling VXI, GPIB, RS-232, Ethernet, 
and other types of instruments. Refer to Chapter 5, VISA Library 

Reference, for further information.
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Subroutine Interface
Because you write LabVIEW instrument drivers in standard LabVIEW 
graphical code, an instrument driver is a software program with the 
same capabilities as any other LabVIEW VI. While some VIs (such as 
instrument drivers) perform only simple I/O to and from an instrument, 
other VIs may control multiple instruments or use support libraries to 
integrate data analysis or other measurement-specific operations. With 
LabVIEW, you can build virtual instruments that combine hardware 
and software capabilities. You can develop and package complete, 
high-level tests as single VIs, which other test developers can reuse. 

By ensuring compatibility with the virtual instrument concept, the 
LabVIEW instrument driver standard has unlimited potential for 
delivering baseline as well as sophisticated application-specific 
instrument drivers. The LabVIEW instrument driver standard defined 
in this document applies both to instrument drivers that control only a 
single instrument, and to virtual instrument drivers that combine 
features of multiple instruments and add software processing.

LabVIEW Instrument Driver Internal Design Model

The LabVIEW instrument driver internal design model, shown in the 
following figure, defines the organization of the LabVIEW instrument 
driver functional body. Because development guidelines and all 
LabVIEW instrument drivers are based on this model, it is important to 
both developers and end users of instrument drivers. When you 
understand the model and how to use one instrument driver, you can 
use that knowledge across numerous instrument drivers.
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The functional body of a LabVIEW instrument driver consists of two 
main categories of VIs. The first category is a collection of component 

VIs, which are individual software modules that each control a specific 
type of instrument function. The second category is a collection of 
higher-level application VIs that show how to combine the component 
VIs to perform basic test and measurement operations with the 
instrument.

The internal design model of LabVIEW instrument drivers is built on 
a proven methodology. With this model, you have the necessary 
granularity to control instruments properly in your software 
applications. You can, for example, initialize all instruments once at 
the start, configure multiple instruments, and then trigger several 
instruments simultaneously. As another example, you can initialize and 
configure an instrument once, and then trigger and read from the 
instrument several times. 
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Instrument Driver Application VIs
The application VIs are at the highest level of the instrument driver 
hierarchy. They are written in LabVIEW block diagram source code 
and control the most commonly used instrument configurations and 
measurements. These VIs serve as a code example for how to configure 
the instrument for a common operation, trigger the instrument, and take 
measurements. Because the application VIs are standard VIs, with 
icons and connector panes, you can call them from any higher-level 
application when you want a single, measurement-oriented, interface 
to the driver. For many developers, the application VIs are the only 
instrument driver VIs needed for instrument control. The Tek VX4790 
Example VI, shown in the following figure, demonstrates an 
application VI front panel.

The application VIs are built from a lower-level set of instrument 
driver component VIs.

Instrument Driver Component VIs
LabVIEW instrument drivers have component VIs, which are a modular 
set of VIs that contain all of the instrument configuration and 
measurement capabilities. The component VIs fit into six categories: 
initialize, configuration, action/status, data, utility, and close. 
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All LabVIEW instrument drivers should have an initialize VI. It is the 
first instrument driver VI called, and establishes communication with 
the instrument. Additionally, it can perform any necessary actions to 
place the instrument either in its default power on state or in some other 
specific state.

The configuration VIs are a collection of software routines that 
configure the instrument to perform the desired operation. There may 
be numerous configuration VIs, depending on the particular 
instrument. After these VIs are called, the instrument is ready to take 
measurements or stimulate a system. 

The action/status category contains two types of VIs. Action VIs cause 
the instrument to initiate or terminate test and measurement operations. 
These operations can include arming the trigger system or generating a 
stimulus. These VIs are different from the configuration VIs because 
they do not change the instrument settings, but only order the 
instrument to carry out an action based on its current configuration. 

The status VIs obtain the current status of the instrument or the status 
of pending operations. The specific routines in this category and the 
actual operations they perform are left up to you.

The data VIs transfer data to or from the instrument. Examples include 
VIs for reading a measured value or waveform from a measurement 
instrument, VIs for downloading waveforms or digital patterns to a 
source instrument, and so on. The specific routines in this category and 
the actual operations performed by those routines are left up to you.

The utility VIs can perform a variety of operations that are auxiliary to 
the most often used instrument driver VIs. These VIs include the 
majority of the instrument driver template VIs such as reset, self-test, 
revision, error query, and error message and may include other custom 
instrument driver VIs, such as calibration or storing and recalling 
setups.

All LabVIEW instrument drivers should include a close VI. The close 
VI terminates the software connection to the instrument and 
deallocates system resources. 

Each of these categories, with the exception of the initialize and close 
VIs, consists of several modular VIs. Most of the critical work in 
developing an instrument driver lies in the initial design and 
organization of the instrument driver component VIs. The specific 
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routines in each category are further categorized as either template VIs 
or developer-specified VIs.

The template VIs are instrument driver VIs that you can use as 
templates or examples. These VIs perform common operations such as 
initialize, close, reset, self-test, and revision query. The template VIs 
contain modification instructions for their use in a specific instrument 
driver for a particular instrument. For more information, refer to 
Chapter 4, Instrument Driver Template VIs.

The remainder of instrument driver VIs are known as 
developer-specified VIs, and the actual operations performed by those 
routines are left up you. Although all instruments will have 
configuration VIs, some instruments can have a different number of 
configuration VIs depending on the unique capabilities of the 
instrument.

Figure 2-1 shows how the Tek VX4790 Example application VI 
diagram uses the instrument driver component VIs:

The block diagram of the instrument driver component VIs uses 
standard LabVIEW VIs, as well as VISA VIs to build command strings 
and send them to the instrument. In the following figure, the Tek 
VX4790 Config Std Wave component VI block diagram assembles the 
command string and wires it into the VISA Write function. This 
function performs the necessary I/O, checks for errors, and updates the 
appropriate error indicators.

Figure 2-1.   VIs in Tek VX4790 Example Diagram
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Error Reporting
LabVIEW instrument drivers use error clusters to report all errors, as 
shown in the following figure. Inside the cluster, a Boolean error 
indicator, a numeric error code, and an error source string indicator 
report if there is an error, the specific error condition, and the source 
(name) of the VI in which the error occurred. Additional comments 
may also be included. Each instrument driver VI has an error in and an 
error out terminal defined on its connector pane in the lower left and 
lower right terminals respectively. By wiring the error out cluster of 
one VI to the error in cluster of another VI, you can pass error 
information all the way through your instrument driver and out to your 
full application. 

Another benefit of error input/output is that data dependency is added 
to VIs that are not otherwise data dependent.

Figure 2-2.   Tek VX4790 Config Std Wave Diagram
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Developing a LabVIEW 
Instrument Driver

Chapter

3

This chapter describes the procedure for developing a LabVIEW 
instrument driver. The ideal LabVIEW instrument driver has full 
function control of the instrument. Rather than mandate the required 
functionality of all instrument types, such as DMMs, counter/timers, 
and so on, this chapter focuses on the architectural guidelines of all 
drivers. With this information, driver developers can implement 
functionality unique to a particular instrument, and still organize, 
package and use all drivers in the same way.

Development Procedure

The best way to develop a LabVIEW Instrument Driver is to follow a 
three-step process. In step one, you design the instrument driver 
structure. In step two, you modify the instrument driver templates VIs. 
In step three, you add developer defined VIs.

Designing the Instrument Driver Structure
The ideal instrument driver does what the user needs—no more and no 
less. No particular type of driver design is perfect for everyone, but by 
carefully studying the instrument and grouping controls into modular 
VIs, you can satisfy most users. 

When the number of programmable controls in an instrument 
increases, so does the need for modular instrument driver design since 
a single VI cannot access all features. However, when an instrument 
driver contains hundreds of VIs, each controlling a single instrument 
feature, more instrument rules regarding command order and 
interaction apply. Modular design simplifies the tasks of controlling 
the instrument and modifying VIs to meet special requirements.

Ideally, you should devise the overall structure of your instrument 
driver before you build the individual VIs. A useful instrument driver 
is more than a series of VIs; it is a tool to help users develop application 
programs. You should design an instrument driver with the application 
and end user in mind. 

 

This document was created with FrameMaker 4.0.4
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You must create some instrument driver VIs that control unique 
instrument features. However, you can use template VIs for common 
operations. For more information about template VIs see Chapter 4, 
Instrument Driver Template VIs.

Instrument Driver Structure and VI Hierarchy
When you develop a LabVIEW instrument driver, it is important to 
clearly define the structure and VI hierarchy of the driver. First, define 
the primary VIs and develop a modular VI hierarchy. This hierarchy is 
the design document for a LabVIEW instrument driver. 

Useful instrument drivers come from an in-depth knowledge of the 
instrument operation and use in test applications. The following steps 
outline one approach to developing the structure for the LabVIEW 
instrument drivers:

1. Familiarize yourself with the instrument operation. Read the 
operating manual thoroughly. Typically the foundation of the 
driver hierarchy is in the instrument programming manual. Learn 
how to use the instrument interactively before you attempt any 
programming. 

2. Use the instrument in an actual test set-up to get practical 
experience. (The operating manual may explain how to set up a 
simple test.) 

3. Study the programming section of the manual. Skim the 
instruction set to see which controls and functions are available 
and how the features are organized. Decide which features are best 
suited for programmatic use.

4. Examine instrument drivers for similar instruments. Often 
instruments from the same family have the same programming 
command set and you can easily modify their corresponding 
instrument drivers.

5. Determine which LabVIEW template VIs are suitable for use with 
your instrument.

6. Develop a structure for the driver by looking for controls that are 
used together to perform a single task or function. The sections of 
a well organized manual often correspond to the functional 
groupings of an instrument driver.
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Instrument Driver VI Organization

After you have developed your Instrument Driver structure, you can 
develop a VI hierarchy to organize the VIs that will be necessary to 
create the driver.

The VI organization of an instrument driver defines the hierarchy and 
overall relationship of the instrument driver component VIs. 

You define the majority of instrument driver VIs and design them to 
access the unique capabilities of a particular instrument. However, 
many operations common to all types of instrumentation are performed 
by the template instrument driver VIs: initialize, close, reset, self-test, 
revision, error query, and error message. 

The template VIs for LabVIEW instrument drivers include prewritten 
VIs to perform these common instrument operations. The command 
strings are based on IEEE 488.2 Common Commands. To include these 
VIs in your instrument driver, modify the command strings as required 
for your instrument. If the instrument is IEEE 488.2 compliant, little or 
no modifications are needed. If you are developing a driver for a 
non-IEEE 488.2 compliant or a register-based device, you will develop 
equivalent VIs for your instrument.

A class is a group of VIs that perform similar operations. Common 
classes of VIs are configuration, action, data, and utility. 

The following table shows an example instrument driver organization 
for an oscilloscope. At the highest level of the hierarchy, you see the 
template VIs, initialize and close and the typical classes of VIs.

VI Hierarchy Type

Initialize VI (Template)

Application VIs
• Autosetup and Read Waveform
• Rise-Time/Fall-Time Measurement

(Developer Defined)
(Developer Defined)
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Guidelines and Recommendations
• Design an instrument driver VI front panel that contains all the 

controls required to perform the VI task. 

For example, a configure measurement VI would contain only the 
necessary controls to configure the instrument to take the 
measurement. It would not take the measurement or configure any 
other features. Additional VIs included in the instrument driver 
perform these tasks.

• Design a modular instrument driver that contains a set of VIs, each 
performing a logical task or function such as configuring the 
instrument or taking a measurement. 

A modular instrument driver is flexible and easy to use. For 
example, consider a digital multimeter driver design that uses a 
single VI to both configure the instrument and read a 
measurement. The user cannot read multiple measurements 
without reconfiguring the meter each time the VI executes. A 

Configuration VIs
• Configure Vertical
• Configure Horizontal
• Configure Trigger
• Configure Acquisition Mode
• Autosetup

(Developer Defined)
(Developer Defined)
(Developer Defined
(Developer Defined)
(Developer Defined)

Action VIs
• Acquire Data (Developer Defined)

Data VIs
• Read Waveform
• Voltmeter Measurement
• Counter/Timer Measurement

(Developer Defined)
(Developer Defined)
(Developer Defined)

Utilities VIs
• Reset
• Self-Test
• Revision
• Error Query
• Error Message

(Template)
(Template)
(Template)
(Template)
(Template)

Close VI (Template)

VI Hierarchy Type
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better approach is to build two VIs: one to configure the 
instrument, and one to read a measurement. Then the user can 
configure the meter once and take multiple measurements.

• Concentrate on the correct level of granularity of driver VIs and 
how these VIs will be used in a system. 

An instrument driver with a few very high-level VIs may not give 
the user enough control of the instrument operation. Conversely, 
an instrument driver with many low-level VIs is difficult for users 
unfamiliar with instrument rules regarding command order and 
interaction. For example, when using a measurement device such 
as an oscilloscope, the user typically configures the instrument 
once and takes many measurements. In this case, you should write 
high-level configuration VIs for the device. On the other hand, 
when using a stimulus device such as a pulse generator, the user 
may want to vary individual parameters of the pulse to test the 
boundary conditions of his system, or perform frequency response 
tests. In this case, you should write lower-level VIs, so that users 
can access individual instrument capabilities instead of 
reconfiguring each time they want to change one component of the 
output.

• Consider the relationship of the driver with other instrument 
drivers in the system. 

Typically, test designers want to initialize all of the instruments in 
a system at once, then configure them, take measurements, and 
finally close them at the end of the test. Good driver design 
includes logical division of operations.

• Create an instrument driver design (both in appearance and 
functional structure) that is similar to other instruments of the 
same type. 

Instrument drivers across a family of similar instruments should be 
consistent in appearance, structure, and style. For example, all 
oscilloscope drivers should resemble each other, as should all 
multimeters, scanners, and sources. If possible, modify a copy of 
an existing driver of a similar instrument. 

• Design an instrument driver that optimizes the programming 
capability of the instrument. 

You can sometimes exclude documented functions that are not 
well-suited for programmatic use.
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• Design each VI to be independent of other VIs. 

If two or more VIs must always be used together, consolidate them 
into one VI.

• Minimize redundant parameters. 

For example, the parameters for each channel of a multi-channel 
oscilloscope are similar or identical. Rather than duplicate the 
programming controls for each channel, you can include a VI 
control for selecting which channel to configure. The user can use 
this VI to change the settings for an individual channel, rather than 
configuring every channel each time the VI is called.

Design Example
Deciding which parameters to include in an instrument driver VI is one 
of the greatest challenges facing the instrument driver developer. 
Fortunately, organizational information is often available in the 
instrument’s manuals. In particular, the programming section of the 
manual may group the commands into sections such as configuring a 
measurement, triggering, reading measurements, and so on. These 
groupings can serve as a model for a driver hierarchy. Begin to develop 
a structure for the driver by looking for controls that are used together 
to perform a single task or function. A modular driver will contain 
individual VIs for each of the control groups.

The following table shows how the command summary from the 
Tektronix VX4790 Arbitrary Waveform Generator Operating Manual 
relates to developer specified instrument driver VIs.

Instrument Manual Section Instrument Driver VI

Setup Commands
• External clock input enable
• External trigger source
• Sync pulse control
• Isolation relay control

TKVX4790 Setup

Pre-Programmed Waveform Commands
• Sine wave
• Square wave
• Triangle wave
• Sawtooth wave

TKVX4790 Config Std. Waveform
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While the instrument manual can provide a great deal of information 
about how to structure the instrument driver, you should not rely on it 
exclusively. Your knowledge of the instrument and how it is used 
should be the ultimate guide. The preceding table shows manual 
sections that map nicely to VIs found in the instrument driver. There 
are instances when it is more appropriate to place commands from 
several different command groups in your VI.

Conversely, it is often necessary to take one group of commands and 
divide it into two or more VIs. Consider how an instrument manual 
groups the trigger configuration commands with the commands that 
actually perform the trigger arming and execution. In this case, you 
should separate the commands into two VIs; one to configure the 
trigger, and one that arms or triggers the instrument.

The following figure shows the LabVIEW instrument driver VIs for 
the Tektronix VX4790 Arbitrary Function Generator:

Frequency Commands
• Frequency
• Period
• Divide
• Low-Pass filters

TKVX4790 Config Sample Frequency

Voltage/Attenuator Commands
• Voltage control
• Attenuator enable
• Attenuation level

TKVX4790 Config Volt/Atten.

Arbitrary Waveform Commands
• Sample voltage
• Breakpoint/Last commands

TKVX4790 Download Arb. 
Waveform

Trigger Commands
• Start location
• Breakpoint/last commands

TKVX4790 Run/Stop

Instrument Manual Section Instrument Driver VI
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Modifying the Instrument Driver Templates
After you design the LabVIEW instrument driver structure, the next 
step is to modify the template VIs to represent your instrument. Most 
of the modifications involve the instrument prefix. The prefix is a 
unique identifier for the instrument driver, and is used as the filename 
for all files associated with the driver and as the prefix to all instrument 
VI names. Typically, the prefix is the combination of an abbreviation 
for the instrument vendor name and the model number. For example, 
the instrument prefix for the Tektronix VX4790 instrument driver is 
tkvx4790. As a default, the template instrument drivers use PREFIX 
as the instrument prefix.

Use the following procedure for modifying the LabVIEW instrument 
driver template:

1. Open the PREFIX Initialize VI in the file insttmpl.llb.

2. Save the VI into a new VI library file by using the prefix for your 
instrument as the filename of the.llb file. Save the VI replacing 
PREFIX in the VI name with the prefix for your instrument.

Application VI

Configuration VIs

Initialize VI

Action VIs

Close VI

Data VI

Utility VIs
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3. Follow the instructions in the Instructions to Modify This VI string 
control on the initialize panel to modify the VI for your particular 
instrument. 

4. Edit all Show VI Info... and control and indicator descriptions.

5. Edit the icon. Create an icon for each of the color modes of the 
icon: Black and White, 16-Color, and 256-Color.

6. Delete the Instructions to Modify This VI string control after you 
have completed the modifications.

7. Resize the front panel and save the VI.

8. Repeat steps 1 through 7 for PREFIX Close VI and the remaining 
template VIs that your instrument uses. All LabVIEW instrument 
drivers should have initialize, close, reset, revision, and error 
message VIs.

After completing this procedure, you will have a base level driver that 
implements all template instrument driver VIs and is a good framework 
from which you can create your driver.

Adding Instrument Driver Component VI VIs
The final step in developing a LabVIEW instrument driver is to add the 
developer defined component VIs that define the functionality of the 
instrument driver and access the unique capabilities of your 
instrument. The VIs that you create will be added to the source code 
along with the template VIs in the file prefix.llb.

You can use the following procedure to add your new VIs:

1. Open either the PREFIX Message-Based or PREFIX Register-Based 
templates VI in the file insttmpl.llb. Use the PREFIX 
Message-Based template VI for message-based operations. Use the 
PREFIX Register-Based template VI for register-based operations.

2. Edit the VI front panel. Create the controls and indicators for the 
VI. 

3. Edit all control and indicator Help information. Edit the Show VI 

Info... description.

4. Edit the icon. Create an icon for each of the color modes of the 
icon: Black and White, 16-Color, and 256-Color.

5. Edit the connector pane. Select an appropriate connector pattern 
and wire all controls and indicators to the terminals.
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6. Edit the block diagram. Program all operations necessary to carry 
out the functionality of the instrument driver VI.

7. Save the VI.

8. Test the instrument driver VI.

9. Repeat these steps for every instrument driver component VI and 
application VI that you define for your instrument.

10. Edit the instrument driver .llb by selecting File»Edit VI 

Library... from the menu. Edit the Functions and Controls names. 
Edit the arrangement of icons in the Functions and Controls 
palettes.

Editing the block diagram source code is the most difficult step in 
adding a component VI to the instrument driver. Defining a block 
diagram structure makes it easier to edit the block diagram source code. 
You can divide this process into the following steps:

1. Place the appropriate I/O routines in the block diagram.

2. Wire the error in cluster terminal to the first I/O VI error input 
connector. Then wire the error out connector of that VI to the 
error in connector of the next VI. Continue this process for all of 
the I/O VIs. Then wire the error out connector of the last VI to the 
error out terminal of the icon.

3. Wire the VISA session to every I/O VI.

4. Use the LabVIEW string VIs to assemble a command string based 
on the VI inputs.

5. Wire the command string to the viWrite I/O VI.

6. Use the viRead I/O VI to read the response if an instrument 
response is generated. 

7. Use the string VIs to parse the response and wire it to the 
appropriate indicator terminals.

Tips for Developing a LabVIEW Instrument Driver

Loop Termination Conditions
When you use looping structures in instrument driver block diagrams, 
you must include a way to escape from While Loops if an error occurs. 
This escape method is important if you are using a While Loop 
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containing I/O routines and the loop termination depends on the result 
of the I/O.

If there is an error, the I/O routines automatically shut down and 
LabVIEW may be stuck in an endless loop. Therefore, always test the 
error cluster status in conjunction with your normal loop termination 
condition to determine when to terminate the loop. The following two 
figures show incorrect and correct mechanisms for terminating a While 
Loop, respectively:

Assembling Command Strings
After you develop your front panel, the next step is to create the block 
diagram which performs the function required by the VI. Each type of 
front panel control has a corresponding block diagram string VI that 
simplifies the task of building command strings. 

Incorrect Mechanism for Escaping from a While Loop
(Incoming error shuts down I/O and causes an endless loop)

Correct Mechanism for Escaping from a While Loop
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You can use Pick Line & Append to choose from a selection of strings 
and concatenate it to another string in a single step. This procedure is 
easier than using a Case structure and Concatenate Strings.

You can use Format & Append to format and concatenate simple 
numeric values. This procedure is easier than using one of the To 
Decimal or To Exponential type conversion VIs in conjunction with 
Concatenate Strings.

By using Select & Append you can select a string constant and 
concatenate it to another string in a single step. This procedure is easier 
than using Select and Concatenate Strings.

Use this block diagram... rather than this one...

Use this block diagram... rather than this one...

Use this block diagram... rather than this one...
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Data Dependency
Carefully consider the control flow when you build your diagrams. 
LabVIEW does not necessarily execute in a left-to-right, top-to-bottom 
fashion. Data dependency automatically determines execution order. 
Add artificial data dependency wherever appropriate (see the LabVIEW 

User Manual for more information). By using the clusters to chain I/O 
VIs together, you can define the execution order without using Case or 
Sequence structures, as illustrated in Figure 2-1, VIs in Tek VX4790 

Example Diagram. Sequence structures, which hide parts of the 
diagram, are also effective at controlling execution order. Whichever 
method you use, make sure that you clearly define control flow so that 
the correct branch of the diagram executes first.

Programmatically Checking Parameter Ranges
Be prepared to handle unexpected values entered into controls. The 
front panel Data Range... item is a deterrent to many range errors. 
When circumstances prevent its use, you can either build a block 
diagram routine based on the Range Test VI shown in Figure 3-1 to 
report range errors to the error cluster, or you can build block diagram 
routines to coerce the data into range. Also, you must often account for 
control interaction by using case statements to alter the block diagram 
routines based on the setting of a particular control. Ideally, you can 
run the VI with any combination of settings and values without 
crashing the instrument. If not, add more error detection/correction to 
your block diagrams. Even though programmatic range checking can 
simplify the VI use, it can also complicate the development of the VI.
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Figure 3-1.   Range Test VI (Front Panel and Block Diagram)

Front Panel

Block Diagram
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Programmatic range checking can easily double the size of your VI and 
add some execution speed penalties. Figures 3-2 and 3-3 show the 
changes made to the Simple Trigger VI to programmatically check the 
ranges of the numeric inputs.

Figure 3-2.   Simple Trigger VI with Programmatic Range Testing

Figure 3-3.   Simple Trigger VI without Programmatic Range Testing
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Guidelines
Like the LabVIEW VI, the standard components of an instrument 
driver VI are the front panel, block diagram, and icon/connector pane. 
Special guidelines concerning these components, as well as error 
reporting and on-line help information, are described in the following 
sections.

Front Panel
Each VI in your instrument driver should contain a front panel that 
groups all the necessary controls together to perform the function of the 
VI. When you develop an instrument driver VI, decide which control 
styles best represent the instrument commands and options. Typically, 
you can categorize instrument commands into three types of control 
styles: Boolean, digital numeric, and text or ring numeric. 

For example, you can represent any instrument command that has two 
options (such as TRIG:MODE:AUTO | NORMAL) on the front panel 
with a Boolean switch. In this case, label the switch Trigger Mode and 
add a free label showing the options: auto or normal. For commands that 
have a discrete number of options (such as TRIG:COUP:AC | DC | 
HFREJ), use a text ring rather than a digital numeric because the text 
ring labels each numeric value with the command it represents. Any 
command requiring a numeric parameter whose value varies over a 
wide range and cannot be better represented by a ring can be 
represented with a digital numeric.

The three control types of Boolean, numeric, and text ring represent 
most instrument commands on the front panel of your VIs. In addition, 
block diagram string icons specifically designed for use with these 
controls exist. These features can simplify string formatting and 
appending instrument commands into command messages, as 
discussed in the Assembling Command Strings and Block Diagram 
sections of this chapter.

Required Front Panel Controls
In addition to the controls required to operate the instrument, your 
front panel must also have the following controls:
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VISA session (except for the initialize VI) input is a unique identifier 
reference to a device I/O session. It identifies the device with which the 
VI communicates and all configuration information necessary to 
perform the I/O.

dup VISA session output is a unique identifier reference to a device 
I/O session. It identifies the device with which the VI communicates 
and all configuration information necessary to perform the I/O. 

error in describes error conditions that occur before this VI executes. 
The default input of this cluster is no error. See the Instrument 
Driver Template VI Error Reporting in chapter four for more 
information on errors in clusters. 

error out is a cluster containing error information. If error in indicates 
an error, the status, code, and source elements of error out have the 
same values as the corresponding elements of error in. If error in does 
not indicate an error, error out describes the error encountered by the 
VI. Refer to Appendix D, Error Codes, for a description of the possible 
error codes. See the Instrument Driver Template VI Error Reporting in 
chapter four for more information on errors in clusters.

To gain consistency with other LabVIEW instrument drivers, place the 
VISA session control and dup VISA session indicator in the upper left 
and upper right corners of the front panel, and the error in and error 

out clusters in the lower left and lower right corners, respectively. 

Note: You can place the error in cluster outside the panel window because it has 

no interactive meaning and is only needed for programmatic use.

Control Guidelines

When placing controls on your front panels, use the following style 
guidelines to ensure uniformity with other LabVIEW VI front panels:
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• Use the default font (application) for all LabVIEW instrument 
driver front panel control labels.The application font is available 
on all platforms that are using LabVIEW.

• Use bold text for control name labels that denote important or 
primary controls, and reserve plain text for secondary controls.

Note: In most cases, all instrument driver controls are primary and require bold 

text. If you are finding yourself placing many secondary or auxiliary 

controls on panels, this may indicate the need to subdivide your VI into 

two or more VIs.

• Use lowercase letters in all words, except abbreviations or 
acronyms, which require caps (such as ID or GPIB)

• Enclose control default information in parentheses in the control 
name.

By including default information in the control name, you can later 
access that information through the help window. This feature is 
helpful when you are using the VI in higher-level applications. 

For example, label a function selector ring control whose default 
is DC volts as item zero Function (DCV:0), and label a Boolean 
mode switch that defaults to true indicating automatic Mode 

(auto:T). (Notice that the default information is in plain text).

The following figures shows the simple trigger VI after modification 
to meet the style guidelines:
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Block Diagram
Proper wiring style improves the diagram appearance and eases 
understanding. The following are recommendations for developing 
your instrument driver block diagrams: 

• Add text labels to each frame of Case and Sequence structures.

• Label control and indicator nodes with normal text.

• Use bold text to make your free label comments stand out. 

• Leave room for labels and wires. Do not crowd the diagram. Do 
not cover wires with loops, cases, labels, or other diagram objects. 

• Reduce the number of bends in the wires by aligning data terminals 
whenever possible. You can use the cursor keys to move objects 
one pixel width at a time. Use the Align and Distribute options in 
the Edit menu to add symmetry and straight lines to your diagram.

• Label long wires and complex operations to increase 
understandability.

Figure 3-4.   Simple Trigger VI Front Panel (See Figure 3-3 for Diagram)
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Icon
When you use an instrument driver VI programmatically, the icon 
graphically represents the function (much like the function name of a 
C library call). Use meaningful icons for every VI. Include text in the 
icon that identifies the instrument model controlled by the VI. If you 
are unable to create an icon to express the function of the VI, you can 
use text only.

You can borrow icons from similar VIs in other instrument drivers. The 
following figure shows some examples of icons. These sample icons 
are available in the file insticon.llb.

Connector Pane
When you use an instrument driver programmatically, the connector 
pane defines how to pass parameters to and from the VI. Use the 
following rules when creating your instrument driver connector panes:

• Place the VISA session input and dup VISA session output in the 
upper left and upper right terminals of the LabVIEW instrument 
driver connector pane.
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• Place the error in and error out clusters in the lower left and lower 
right terminals of the LabVIEW instrument driver connector pane 

respectively.

• Place inputs on the left and outputs on the right of the connector 
pane whenever possible. This promotes a left-to-right data flow 
when the VI is used in a block diagram.

Note: It is acceptable to choose a connector pane pattern that has extra 

terminals in case you make unforeseen control or indicator additions to 

your instrument driver VIs in the future. This procedure prevents you 

from having to change the pattern and replace all instances of calls to a 

modified VI. 

Error Reporting
Refer to Appendix D, Error Codes, for a list of error codes reserved for 
LabVIEW instrument drivers. 

Online Help Information
LabVIEW has two types of help mechanisms available to users: VI 

Descriptions and Control Descriptions. You should implement both VI 

Descriptions and Control Descriptions for all LabVIEW instrument 
driver VIs and controls that you develop.
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VI Descriptions
Users can access VI Description help from the description box of the 
information window by selecting Windows»Show VI Info..., as shown 
in the following figure. 

This dialog box should contain the following information:

• A general description of the instrument driver VI

• Control usage rules

• VI interaction with other instrument driver VIs

• Important information concerning the use of the VI

Control and Indicator Descriptions
Control and indicator help is the information most frequently viewed 
by the user. You can obtain control or indicator help by selecting Data 
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Operations»Description... from the control or indicator pop-up menu, 
as shown in the following figure:

The control and indicator help information should contain the 
following:

• Name of the parameter

• Brief description of the parameter

• Valid range

• Default value

• Interaction with other controls

Be sure to include information showing index numbers and 
corresponding settings for all ring and slide controls, and settings 
corresponding to True/False positions on Boolean controls.

Application VIs 
The application VIs demonstrate a common use of the instrument and 
show how the component VIs are used programmatically to perform a 
task. For example, an oscilloscope application VI would configure the 
vertical and horizontal amplifiers, trigger the instrument, acquire a 
waveform, and report errors. Consider the following points when 
developing application VIs for your instrument driver:
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• Concentrate on building simple, quality examples that can serve as 
general models for users. It is not necessary to make your 
application VIs perform every function found in your instrument 
driver.

• Build the instrument driver top-level examples from the 
instrument driver component VIs, and perform common test- and 
measurement-oriented operations for this particular instrument.

• Do not use the instrument driver application VIs to call the 
initialize or close instrument driver VIs, because doing so will 
make the application VIs less useful to higher level applications.

LabVIEW Instrument Driver Standards Checklist

All LabVIEW instrument drivers should conform to recommendations 
for programming style, error handling, front panels, block diagrams, 
and online help described in this section. Use the following checklist 
to verify that your instrument driver complies with library standards:

General Issues

____ All VIs designed for programmatic use; no pop-up VIs or dialog 
boxes; no interactive input; all controls wired to connector pane.  
(‘Soft front panel’ VIs are allowed only as additional examples 
built upon the driver VIs; the driver VIs themselves must be for 
programmatic use.) 

____ All VIs are multi-instance: no uninitialized shift registers; no 
global storage VIs unless specifically designed to work with 
multiple instruments simultaneously.

____ All VIs fully documented including Show VI Info... and control 
descriptions.

____ Driver uses VISA for all instrument I/O.

____ Driver follows instrument internal driver model: Initialize, 
Configure, Action/Status, Data, Utility, and Close VIs; also 
Getting Started, Application, and VI Tree VIs.

____ All VIs use error I/O clusters.
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Files Created

____ All VIs in one or more LabVIEW instrument driver archives 
(*.llb).

____ All .llb files must have instrument prefix in file name 
(abbreviate as necessary, for example: FL45conf.llb, 
FL45trig.llb, or FL45meas.llb).

____ Text file allowed with name in the form ‘prefix.txt’ 
(example: FL45.txt).

____ All .llb and .txt files placed in directory named with 
instrument prefix.

____ Instrument directory and files compressed into ‘prefix.zip’ 
using PKzip (for example, FL45.zip).

LabVIEW Instrument Driver Archive - .LLB

____ All VIs saved with meaningful names including instrument prefix 
and description; no special characters; use Initial Cap form (for 
example, Fluke 45 Read Measurement).

____ Function and control menu palettes well organized, and names 
entered.

____Getting Started, Application, and VI Tree VIs given top-level 
status.

____ Support VIs hidden from the function menu palette.

VI Front Panels

____ Contain VISA session, dup VISA session, error in, and error out 
controls.

____ Front panel Show VI Info... description is complete.

____ VI History is updated with comments as needed.

____ Control and Indicators: 

____ All descriptions are complete. Include defaults, range, items 
in rings, etc.

____ Place labels at upper left of controls; color labels transparent; 
use the Size to Text feature.
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____ Capitalize initial letters of control names; use the 
Application font; bold for primary controls (most) and plain 
for secondary controls (rarely needed).

____ Proper defaults are set for each control and default included 
in name (example: ring control with default DC Volts 
selection at value zero: Function Select (DCV:0)).

____The proper display format is used, such as hexadecimal for 
status registers, etc.

____ Use color sparingly or standard gray.

Icon/Connector Pane/VI Setup

____ Create meaningful icons for all VIs.

____ Place instrument prefix in upper 1/3 and description text in 
lower 1/3 of icon.

____ Try to keep a common theme for all VIs of a particular driver 
(if nothing else, use an image of the instrument).

____ Create icons for Black & White (required), 16-Color and 
256-Color (optional).

____ Select appropriate connector pane.

____ Try to keep inputs on left & top; outputs on right & bottom.

____ Instrument handle in/out on upper left/right terminal; Error 
in/out on lower left/right terminal.

____ Extra terminals are acceptable for future modifications.

____ Use VI Setups and window options carefully; do not create 
pop-up panels.

Block Diagram

____ Use bold text labels (Application font) to describe each frame of 
Case and Sequence structures; left-justify; color borders 
transparent.

____ Use plain text labels (Application font) for controls/indicators; 
place beneath control; left-justify; color borders transparent.

____ Don’t crowd diagram or cover wires with labels, objects, 
structures, etc.
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____ Try for general left-right, top-down data flow.

____ Use proper Error I/O wiring techniques; use correct error codes 
for error reporting.

____ Save diagrams with first (or most important) frames or cases 
showing.
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Instrument Driver Template VIs

Chapter

4

This chapter describes the Instrument Driver Template VIs. These VIs 
are located in examples\instr\insttmpl.llb.

Instrument Driver Template VI Overview

The LabVIEW instrument driver templates are the foundation for all 
LabVIEW instrument driver development. The templates have a 
simple, flexible structure and a common set of instrument driver VIs 
that you can use for driver development. The templates establish a 
standard format for all LabVIEW drivers and each has instructions for 
modifying it for a particular instrument. The LabVIEW instrument 
driver templates contain the following nine predefined template 
component VIs:

• PREFIX Initialize

• PREFIX Close

• PREFIX Reset

• PREFIX Self Test

• PREFIX Error Query

• PREFIX Error Message

• PREFIX Revision Query

• PREFIX Message-Based Template

• PREFIX Register-Based Template

Rather than developing your own VIs to accomplish these tasks, you 
should use the LabVIEW instrument driver template VIs which already 
conform to the LabVIEW standards for instrument drivers. The 
template VIs are IEEE 488.2 compatible and work with IEEE 488.2 
instruments with minimal modifications. For non-IEEE 488.2 
instruments, use the template VIs as a shell or pattern, which you can 
modify by substituting your corresponding instrument-specific 
commands where applicable. After modifying the VIs, you will have 
the base level driver that implements all of the template instrument 
driver VIs for your particular instrument.

 

This document was created with FrameMaker 4.0.4
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Additionally, LabVIEW instrument drivers developed from the 
template VIs will be similar to other instrument drivers in the library. 
Therefore, you will have a higher level of familiarity and 
understanding when you work with multiple instrument drivers.

Initialize
The Initialize VI is the first VI called when you are accessing an 
instrument driver. It configures the communications interface, 
manages handles, and sends a default command to the instrument. 
Typically, the default setup configures the instrument operation for the 
rest of the driver (including turning headers on or off, or using long or 
short form for queries). After successful operation, the Initialize VI 
returns a VISA session that addresses the instrument in all subsequent 
instrument driver VIs.

The VI has an instrument descriptor string as an input. Based on the 
syntax of this input, the VI configures the I/O interface and generates 
an instrument handle for all other instrument driver VIs. The following 
table shows the grammar for the instrument descriptor. Optional 
parameters are shown in square brackets ([]).

The GPIB keyword is used with GPIB instruments. The VXI keyword 
is used for either embedded or MXIbus controllers. The GPIB-VXI 
keyword is used for a National Instruments GPIB-VXI controller.

Additionally, the Initialize VI can perform selectable ID query and 
reset operations. In other words, you can disable the ID query when 
you are attempting to use the driver with a similar but different 
instrument without modifying the driver source code. Also, you can 
enable or disable the reset operation. This feature is useful for 
debugging when resetting would take the instrument out of the state 
you were trying to test.

Interface Syntax

GPIB GPIB[board]::primary address[::secondary address][::INSTR]

VXI VXI::VXI logical address[::INSTR]

GPIB-VXI GPIB-VXI[board][::GPIB-VXI primary address]::VXI logical 

address[::INSTR]
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Close
All LabVIEW instrument drivers should include a Close VI. The Close 
VI is the last VI called when controlling an instrument. It terminates 
the software connection to the instrument and deallocates system 
resources. Additionally, you can choose to place the instrument in an 
idle state. For example, if you are developing a switch driver, you can 
disconnect all switches when closing the instrument driver.

Reset
All LabVIEW instrument drivers have a Reset VI that places the 
instrument in a default state. The default state that the Reset VI places 
the instrument in should be documented in the help information for the 
Reset VI. In an IEEE 488.2 instrument, this VI sends the command 
string *RST to the instrument. When you reset the instrument from the 
Initialize VI, this VI is called. Also, you can call the Reset VI 
separately.

Self-Test
If an instrument has self-test capability, the LabVIEW instrument 
driver should contain a Self-test VI to instruct the instrument to perform 
a self-test and return the result of that self-test.

Error Query and Error Message
If an instrument has error query capability, the LabVIEW instrument 
driver has Error Query and Error Message VIs. The Error Query VI 
queries the instrument and returns the instrument-specific error 
information. The Error Message VI translates the error status 
information returned from a LabVIEW instrument driver VI into a 
user-readable string.

Revision Query
LabVIEW instrument drivers have a Revision Query VI. This VI outputs 
the following:

• The revision of the instrument driver.

• The firmware revision of the instrument being used (If the 
instrument firmware revision cannot be queried, the Revision 
Query VI should return the literal string Not Available.)
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Message-Based Template and Register-Based 
Template
The Message-Based and Register-Based template VIs are the starting 
point for developing your own instrument driver VIs. The template VIs 
have all required instrument driver controls, and instructions for 
modification for a particular instrument.

Example
The following table shows the LabVIEW VI organization of the 
instrument driver for the Tektronix VX4790 Arbitrary Function 
Generator. The hierarchy shows the developer specified VIs derived 
from the instrument manual as well as the template VIs.

Level Name Type

Application VIs Output Standard Waveform (Developer Specified)

Output Arbitrary Waveform (Developer Specified)

Component VIs Initialize VI (Template)

Configuration VIs
• Configure Setup
• Configure Sample Frequency
• Configure Voltage / Attenuation
• Configure Standard Waveform

(Developer Specified)
(Developer Specified)
(Developer Specified)
(Developer Specified)

Actions VIs
• Run / Stop (Developer Specified)

Data Functions
• Download Arbitrary Waveform (Developer Specified)

Component VIs Utilities VIs
• Reset
• Self-Test
• Revision Query
• Error Query
• Error Message
• Send Message
• Receive Message

(Template)
(Template)
(Template)
(Template)
(Template)
(Template)



Chapter 4     Instrument Driver Template VIs

 National Instruments Corporation 4-5 LabVIEW Instrument I/O VI Reference Manual

Instrument Driver Template VI Error Reporting

The instrument driver template VIs report errors in clusters, as the 
following illustration shows. 

error in describes error conditions that occur before this VI executes. 
The default input of this cluster is no error. The error in cluster 
contains the following parameters.

status is TRUE if an error occurred. If status is TRUE, this 
VI does not perform an operation. Instead it places the 
value of the error in cluster in the error out cluster.

code is the error code associated with an error. A value of 
0 means there is no error. Refer to Appendix D, Error 

Codes, for a description of the possible error codes.

source is the name of the VI that produced the error.

error out is a cluster containing error information. If error in indicates 
an error, the status, code, and source elements of error out have the 
same values as the corresponding elements of error in. If error in does 
not indicate an error, error out describes the error encountered by the 
VI. Refer to Appendix D, Error Codes, for a description of the possible 
error codes.

Close VI (Template)

Level Name Type
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When you use an instrument driver VI in a While Loop, you should 
stop the loop if the status Boolean in the error out cluster is TRUE. 
You can also wire the error cluster to the General Error Handler VI, 
which can then decipher the error information and inform the user.

The General Error Handler VI is in Functions»Utilities. For more 
information on this VI, refer to the LabVIEW for Windows User Manual.

Instrument Driver Template VI Descriptions

PREFIX Close
The PREFIX Close VI is a template for creating a Close VI for your particular 
instrument. It terminates communication with the instrument and deallocates system 
resources.

Modify this VI according to the following instructions:

1. Save a copy of this VI.

a. Select File»Save As.... 

b. Replace the word PREFIX in the name of the VI with the prefix for your 
instrument. For example, you could name the close VI for the Tektronix 
VX4790 Arbitrary Waveform Generator the TKVX4790 Close VI.

c. Save the VI in the file prefix.llb where prefix is the prefix for your 
instrument. If you have not already made this .llb, you can create it while 
saving the VI.

2. Edit the icon pane on the front panel.

a. Open the icon editor by double-clicking on the icon pane.

b. Change the word PREFIX to the prefix for your instrument. 

c. Edit the icon for all three color modes: Black and White, 16-color, and 
256-color.

3. Edit the block diagram. Replace the word PREFIX in the string constant labeled VI 
name with the prefix for your instrument.

4. Edit Show VI Info... and all control and indicator description information.
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5. Delete the Modification Instructions text box from the front panel, resize the front 
panel, and save this VI.

VISA session input is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O. The Prefix Close VI terminates 
communication with a device and therefore does not have a dup VISA session output.

error in describes error conditions that occur before this VI executes. The default 
input of this cluster is no error. See the Instrument Driver Template VI Error 

Reporting section of this chapter for a description of the parameters in the error in 
and error out clusters.

error out contains error information. If error in indicates an error, then error out 
contains the same error information. Otherwise it describes the error status that this 
VI produces.

PREFIX Error Message
The PREFIX Error Message VI is a template for creating an Error Message VI for your 
particular instrument. It translates the error status information returned from a 
LabVIEW instrument driver VI to a user-readable string.

Modify this VI according to the following instructions:

1. Save a copy of this VI.

a. Select File»Save As.... 

b. Replace the word PREFIX in the name of the VI with the prefix for your 
instrument. For example, you could name the error message VI for the Tektronix 
VX4790 Arbitrary Waveform Generator the TKVX4790 Error Message VI.

c. Save the VI in the file prefix.llb where prefix is the prefix for your 
instrument. If you have not already made this .llb, you can create it while 
saving the VI.
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2. Edit the icon pane on the front panel.

a. Open the icon editor by double-clicking on the icon pane.

b. Change the word PREFIX to the prefix for your instrument. 

c. Edit the icon for all three color modes: Black and White, 16-color, and 
256-color.

3. Edit the block diagram. Replace the word PREFIX in the string constant labeled VI 

name with the prefix for your instrument.

4. Edit the user-defined codes and user-defined descriptions array controls that are 
located on the front panel. Enter instrument specific error codes in the user-defined 
codes array and enter their corresponding descriptions in the user-defined 
descriptions array.

5. Select Operate»Make Current Values Default.

6. Edit Show VI Info... and all control and indicator description information.

7. Delete the Modification Instructions text box from the front panel, resize the front 
panel, and save this VI.

VISA session input is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O.

error in describes error conditions that occur before this VI executes. The default 
input of this cluster is no error. See the Instrument Driver Template VI Error 

Reporting section of this chapter for a description of the parameters in the error in 
and error out clusters.

dup VISA session output is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O. 

code contains the error number from the error in input cluster.

error out contains error information. If error in indicates an error, then error out 
contains the same error information. Otherwise it describes the error status that this 
VI produces.

status contains the status from the error in input cluster.

error message returns a user-readable string based on the error in input cluster.
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PREFIX Error Query
The PREFIX Error Query VI is a template for creating an error query VI for your 
particular instrument. It queries the instrument and returns instrument-specific error 
information.

Modify this VI according to the following instructions:

1. Save a copy of this VI.

a. Select File»Save As....

b. Replace the word PREFIX in the name of the VI with the prefix for your 
instrument. For example, you could name the error query VI for the Tektronix 
VX4790 Arbitrary Waveform Generator the TKVX4790 Error Query VI.

c. Save the VI in the file prefix.llb where prefix is the prefix for your 
instrument. If you have not already made this .llb, you can create it while 
saving the VI.

2. Edit the icon pane on the front panel.

a. Open the icon editor by double-clicking on the icon pane.

b. Change the word PREFIX to the prefix for your instrument. 

c. Edit the icon for all three color modes: Black and White, 16-color, and 
256-color.

3. Edit the block diagram.

a. Replace the word PREFIX in the string constant labeled VI name with the prefix 
for your instrument.

b. Edit the string constant labeled error query command by entering the reset 
command for your instrument.

4. Edit Show VI Info... and all control and indicator description information.

5. Delete the Modification Instructions text box from the front panel, resize the front 
panel, and save this VI.

VISA session input is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O.
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error in describes error conditions that occur before this VI executes. The default 
input of this cluster is no error. See the Instrument Driver Template VI Error 

Reporting section of this chapter for a description of the parameters in the error in 
and error out clusters.

dup VISA session output is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O.

error is the error which has occurred.

error message contains any error messages from the instrument.

error out contains error information. If error in indicates an error, then error out 
contains the same error information. Otherwise it describes the error status that this 
VI produces.

PREFIX Initialize
The PREFIX Initialize VI is a template for creating an Initialize VI for message-based 
instruments. The function is used to establish communication with a remote instrument. 
Also the VI can perform user selectable ID query and/or reset operations.

Modify this VI according to the following instructions:

1. Save a copy of this VI.

a. Select File»Save As.... 

b. Replace the word PREFIX in the name of the VI with the prefix for your 
instrument. For example, you could name the Initialize VI for the Tektronix 
VX4790 Arbitrary Waveform Generator the TKVX4790 Initialize VI.

c. Save the VI in the file prefix.llb where prefix is the prefix for your 
instrument. If you have not already made this .llb, you can create it while 
saving the VI.
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2. Edit the icon pane on the front panel.

a. Open the icon editor by double-clicking on the icon pane.

b. Change the word PREFIX to the prefix for your instrument. 

c. Edit the icon for all three color modes: Black and White, 16-color, and 
256-color.

3. Edit the block diagram.

a. Replace the word PREFIX in the string constant labeled VI name with the prefix 
for your instrument.

b. Set the value of ID Query command to be the ID Query for your instrument. 
Change the constant labeled ID Query Response to be the ID Query response for 
your instrument. If your instrument driver is meant to work with multiple 
instruments, place all possible ID Query responses in the string constant 
separated by carriage returns.

4. Replace the PREFIX Reset VI with the name of the reset VI for your instrument. If 
you have not created a reset VI for your instrument, load the PREFIX Reset VI in 
the file instrtmp.llb by selecting File»Open... and following the instructions on 
the front panel.

5. Change the string constant labeled default setup string by entering the command 
string you want to send to the instrument.

6. Edit Show VI Info... and all control and indicator description information.

7. Delete the Modification Instructions text box from the front panel, resize the front 
panel, and save this VI.

instrument descriptor. Based on the syntax of the instrument descriptor input, the 
INSTR Open VI configures the I/O interface and generates an instrument handle that 
is used by all other instrument driver functions. The grammar for the instrument 

descriptor is shown below. Optional parameters are shown in square brackets ([ ]).

As shown in the preceding table, the GPIB keyword is used for GPIB instruments. The 
VXI keyword is used for VXI instruments through either embedded or MXIbus 

Interface Syntax

GPIB GPIB[board]::primary address[::secondary address][::INSTR]

VXI VXI::VXI logical address[::INSTR]

GPIB-VXI GPIB-VXI[board][::GPIB-VXI primary address]::VXI logical 

address[::INSTR]
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controllers. The GPIB-VXI keyword is used for a National Instruments GPIB-VXI 
controller.

The following table shows the default values for optional parameters:

ID query determines if the Initialize VI will attempt to perform identification query.

TRUE: Perform identification query.

FALSE: Do not perform identification query.

reset determines if the Initialize VI will reset the device.

TRUE: Reset the device.

FALSE: Do not reset the device.

error in describes error conditions that occur before this VI executes. The default 
input of this cluster is no error. See the Instrument Driver Template VI Error 

Reporting section of this chapter for a description of the parameters in the error in 
and error out clusters.

VISA session output is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O.

error out contains error information. If error in indicates an error, then error out 
contains the same error information. Otherwise it describes the error status that this 
VI produces.

Optional Parameter Default Value

board 0

secondary address none

GPIB-VXI primary address 1
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PREFIX Message-Based Template
The PREFIX Message-Based Template VI is a template for creating a message-based VI 
for your particular instrument.

Modify this VI according to the following instructions:

1. Save a copy of this VI.

a. Select File»Save As.... 

b. Rename the VI substituting the prefix for your instrument and a unique name 
describing the VI’s purpose.

c. Save the VI in the file prefix.llb where prefix is the prefix for your 
instrument. If you have not already made this .llb, you can create it while 
saving the VI.

2. Edit the front panel. Add controls and indicators as necessary to perform the VI 
function.

3. Edit the icon pane on the front panel.

a. Open the icon editor by double-clicking on the icon pane.

b. Change the word PREFIX to the prefix for your instrument. 

c. Edit the icon for all three color modes: Black and White, 16-color, and 
256-color.

4. Edit the icon connector pane on the front panel.

a. Pop-up on the icon pane and select Show Connector.

b. Pop-up on the connector pane and select Patterns. Choose a pattern suitable for 
the controls and indicators on the front panel. Remember the instrument handle 
control goes in the upper left-hand corner, and the error in and error out clusters 
go in the lower left-hand and right-hand corners, respectively. 

5. Edit the block diagram. Replace the word PREFIX in the string constant labeled VI 

name with the prefix for your instrument.

6. Use the String functions found in the Functions palette to build a command string 
based on the input controls. Wire the resulting command string to the write buffer 
control of the INSTR Send Message VI.   
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7. If the instrument generates a response, use the INSTR Receive Message VI to read 
from the instrument. Use the String functions found in the Functions palette to parse 
the response and wire it to the indicator terminals.

8. Edit Show VI Info... and all control and indicator description information.

9. Delete the Modification Instructions text box from the front panel, resize the front 
panel, and save this VI.

VISA session input is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O.

error in describes error conditions that occur before this VI executes. The default 
input of this cluster is no error. See the Instrument Driver Template VI Error 

Reporting section of this chapter for a description of the parameters in the error in 
and error out clusters

dupVISA session output is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O.

error out contains error information. If error in indicates an error, then error out 
contains the same error information. Otherwise it describes the error status that this 
VI produces.

PREFIX Register-Based Template
The PREFIX Register-Based Template VI is a template for creating a register-based VI 
for your particular instrument. 

Modify this VI according to the following instructions:

1. Save a copy of this VI.

a. Select File»Save As.... 
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b. Rename the VI substituting the prefix for your instrument and a unique name 
describing the VI’s purpose.

c. Save the VI in the file prefix.llb where prefix is the prefix for your 
instrument. If you have not already made this .llb, you can create it while 
saving the VI.

2. Edit the front panel. Add controls and indicators as necessary to perform the VI 
function.

3. Edit the icon pane on the front panel.

a. Open the icon editor by double-clicking on the icon pane.

b. Change the word PREFIX to the prefix for your instrument. 

c. Edit the icon for all three color modes: Black and White, 16-color, and 
256-color.

4. Edit the icon connector pane on the front panel.

a. Pop-up on the icon pane and select Show Connector.

b. Pop-up on the connector pane and select Patterns. Choose a pattern suitable for 
the controls and indicators on the front panel. Remember the instrument handle 
control goes in the upper left-hand corner, and the error in and error out clusters 
go in the lower left-hand and right-hand corners, respectively. 

5. Edit the block diagram.

a. Replace the word PREFIX in the string constant labeled VI name with the prefix 
for your instrument.

b. Change the enumerated type labeled memory space to be the memory space you 
plan to access, and change the constant labeled base address to be the base 
address of your instrument.   

c. Change the constants labeled register offset to be the registers that you plan to 
peek or poke. Add or remove the VISA Peek 16 function or the VISA Poke 16 
function, as necessary. If you want to access A24 or A32 addresses, replace 
these functions with the appropriate VIs from the LabVIEW Instrument Driver 
Support Library.

6. Edit Show VI Info... and all control and indicator description information.

7. Delete the Modification Instructions text box from the front panel, resize the front 
panel, and save this VI.

VISA session input is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O.
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error in describes error conditions that occur before this VI executes. The default 
input of this cluster is no error. See the Instrument Driver Template VI Error 

Reporting section of this chapter for a description of the parameters in the error in 
and error out cl usters.

dupVISA session output is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O.

error out contains error information. If error in indicates an error, then error out 
contains the same error information. Otherwise it describes the error status that this 
VI produces.

PREFIX Reset
The PREFIX Reset VI is a template for creating a reset VI for your particular instrument. 
The Reset VI places the instrument in a default state.

Modify this VI according to the following instructions:

1. Save a copy of this VI.

a. Select File»Save As.... 

b. Replace the word PREFIX in the name of the VI with the prefix for your 
instrument. For example, you could name the reset VI for the Tektronix VX4790 
Arbitrary Waveform Generator the TKVX4790 Reset VI.

c. Save the VI in the file prefix.llb where prefix is the prefix for your 
instrument. If you have not already made this .llb, you can create it while 
saving the VI.

2. Edit the icon pane on the front panel.

a. Open the icon editor by double-clicking on the icon pane.

b. Change the word PREFIX to the prefix for your instrument.

c. Edit the icon for all three color modes: Black and White, 16-color, and 
256-color.
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3. Edit the block diagram.

a. Replace the word PREFIX in the string constant labeled VI name with the prefix 
for your instrument.

b. Edit the string constant labeled Reset Command by entering the reset command 
for your instrument.

4. Edit Show VI Info... and all control and indicator description information.

5. Delete the Modification Instructions text box from the front panel, resize the front 
panel, and save this VI.

VISA session input is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O.

error in describes error conditions that occur before this VI executes. The default 
input of this cluster is no error. See the Instrument Driver Template VI Error 

Reporting section of this chapter for a description of the parameters in the error in 
and error out clusters

dup VISA session output is a unique identifier reference to a device 
I/O session. It identifies the device with which the VI communicates and all 
configuration information necessary to perform the I/O.

error out contains error information. If error in indicates an error, then error out 
contains the same error information. Otherwise it describes the error status that this 
VI produces.

PREFIX Revision Query
The PREFIX Revision Query VI is a template for creating a Revision Query VI for your 
particular instrument. It returns the revision of the instrument driver and the firmware 
revision of the instrument.

Modify this VI according to the following instructions:
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1. Save a copy of this VI.

a. Select File»Save As.... 

b. Replace the word PREFIX in the name of the VI with the prefix for your 
instrument. For example, you could name the revision VI for the Tektronix 
VX4790 Arbitrary Waveform Generator the TKVX4790 Revision VI.

c. Save the VI in the file prefix.llb where prefix is the prefix for your 
instrument. If you have not already made this .llb, you can create it while 
saving the VI.

2. Edit the icon pane on the front panel.

a. Open the icon editor by double-clicking on the icon pane.

b. Change the word PREFIX to the prefix for your instrument. 

c. Edit the icon for all three color modes: Black and White, 16-color, and 
256-color.

3. Edit the block diagram.

a. Replace the word PREFIX in the string constant labeled VI name with the prefix 
for your instrument.

b. Edit the string constant labeled revision query command by entering the 
revision command for your instrument.

4. Edit Show VI Info... and all control and indicator description information.

5. Delete the Modification Instructions text box from the front panel, resize the front 
panel, and save this VI.

VISA session input is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O.

error in describes error conditions that occur before this VI executes. The default 
input of this cluster is no error. See the Instrument Driver Template VI Error 

Reporting section of this chapter for a description of the parameters in the error in 
and error out clusters.

dup VISA session output is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O. 

error out contains error information. If error in indicates an error, then error out 
contains the same error information. Otherwise it describes the error status that this 
VI produces.
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instr driver revision contains the revision level of the instrument driver source code.

instr firmware revision contains the firmware revision level of the instrument.

PREFIX Self-Test
The PREFIX Self-Test VI is a template for creating a self-test VI for your particular 
instrument. It tells the instrument to perform a self-test and returns the result.

Modify this VI according to the following instructions:

1. Save a copy of this VI.

a. Select File»Save As.... 

b. Replace the word PREFIX in the name of the VI with the prefix for your 
instrument. For example, you could name the self-test VI for the Tektronix 
VX4790 Arbitrary Waveform Generator the TKVX4790 Self-Test VI.

c. Save the VI in the file prefix.llb where prefix is the prefix for your 
instrument. If you have not already made this .llb, you can create it while 
saving the VI.

2. Edit the icon pane on the front panel.

a. Open the icon editor by double-clicking on the icon pane.

b. Change the word PREFIX to the prefix for your instrument. 

c. Edit the icon for all three color modes: Black and White, 16-color, and 
256-color.

3. Edit the block diagram.

a. Replace the word PREFIX in the string constant labeled VI name with the prefix 
for your instrument.

b. Edit the string constant labeled self-test command by entering the self-test 
command for your instrument.

4. Edit Show VI Info... and all control and indicator description information.
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5. Delete the Modification Instructions text box from the front panel, resize the front 
panel, and save this VI.

VISA session input is a unique identifier reference to a device I/O session. It 
identifies the device with which the VI communicates and all configuration 
information necessary to perform the I/O. 

error in describes error conditions that occur before this VI executes. The default 
input of this cluster is no error. See the Instrument Driver Template VI Error 

Reporting section of this chapter for a description of the parameters in the error in 
and error out clusters.

dup VISA session output is a unique identifier reference to a device 
I/O session. It identifies the device with which the VI communicates and all 
configuration information necessary to perform the I/O.

self-test error returns the error code from the instrument.

self-test response contains the result of the instrument driver self-test.

error out contains error information. If error in indicates an error, then error out 
contains the same error information. Otherwise it describes the error status that this 
VI produces.
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VISA Library Reference

Chapter

5

This chapter contains descriptions of the VISA Library Reference 
operations and attributes. 

The following figure shows the VISA palette, which you access by 
selecting Functions»Instrument I/O»VISA: 

You can find helpful information about individual VIs online by using 
the LabVIEW Help window (Help»Show Help). When you place the 
cursor on a VI icon, the wiring diagram and parameter names for that 
VI appear in the Help window. You can also find information for front 
panel controls or indicators by placing the cursor over the control or 
indicator with the Help window open. For more information on the 
LabVIEW Help window, refer to the Getting Help section in Chapter 2, 
Creating VIs, of the LabVIEW User Manual.

In addition to the Help window, LabVIEW has more extensive online 
information available. To access this information, select Help»Online 

Reference. For most block diagram objects, you can select Online 

Reference from the object’s pop-up menu to access the online 
description. You can also access this information by pressing the 
button shown to the left, which is located at the bottom of LabVIEW’s 
Help window. For information on creating your own online reference 
files, see the Creating Your Own Help Files section in Chapter 25, 
Managing Your Applications of the LabVIEW User Manual.

 

This document was created with FrameMaker 4.0.4
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Operations

This section describes the VISA Library Reference operations. 

VISA Library Reference Parameters
Most of the VISA Library Operations use the following parameters:

• VISA session is a unique logical identifier to a session. It is produced 
by the VISA Open function and used by the VISA primitives. dup 

VISA session is the VISA session passed to a function. The dup 
simplifies dataflow programming and is similar to the dup file 
refnums provided by file I/O functions.

The VISA session drops by default with class Instr. You can 
change the class by popping up on it at edit time. The following 
classes are currently supported:

– Instr

– GPIB Instr

– VXI/GPIB-VXI RBD Instr

– VXI/GPIB-VXI MBD Instr

– Serial Instr

– Generic Event

– Service Request Event

– Trigger Event

– VXI Signal Event

Note: The Generic Event, Service Request Event, Trigger Event, and VXI Signal 

Event classes work only with the VISA Close function and the VISA 

Attribute Node.

VISA functions vary in the class of VISA session which can be 
wired to them. The valid classes for each function are indicated in 
the documentation. For example, the functions on the High Level 
and Low Level Register Access palettes do not accept VISA 
sessions of class GPIB Instr or Serial Instr. If you wire a VISA 

session to a function that does not accept the class of the session, 
or if you wire two VISA sessions of differing classes together, 
your diagram will be broken and the error will be reported as a 
Class Conflict.
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• error in and error out terminals comprise the error clusters in each 
VISA function. The error cluster contains three fields. The status 

field is a Boolean which is TRUE when an error occurs, FALSE when 
no error occurs. The code field will be a VISA error code value if 
an error occurs during a VISA function. Appendix D lists the 
VISA Reference Library error codes. The source field is a string 
which describes where the error has occurred. By wiring the error 

out of each function to the error in of the next function, the first 
error condition is recorded and propagated to the end of the 
diagram where it is reported in only one place. 

VISA Operation Descriptions

These functions appear on the main VISA palette. The valid classes for these functions 
are: Instr (default), GPIB Instr, Serial Instr, VXI/GPIB-VXI RBD Instr, and 
VXI/GPIB-VXI MBD Instr. 

VISA Assert Trigger
Asserts a software or hardware trigger, depending on the interface type. 

Note: The Serial Instr class is not valid for VISA Assert Trigger.

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

protocol is the trigger protocol to use during assertion. Valid protocol values are:

0: default
1: on
2: off
5: sync

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.
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error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Clear
Performs an IEEE 488.1-style clear of the device. For VXI, this is the Word Serial Clear 
command; for GPIB systems, this is the Selected Device Clear command. 

Note: The Serial Instr class is not valid for VISA Clear.

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Close
Closes a specified device session or event object. VISA Close accepts all available 
classes. For a listing of available classes, see the VISA Operation Parameters section 
earlier in this chapter.
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VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Find Resource
Queries the system to locate the devices associated with a specified interface. 

expression matches the value specified with the devices available for a particular 
interface. The description string specified sets the criteria to search an interface (GPIB, 
GPIB-VXI, VXI, All VXI, Serial or All) for existing devices. The description string 
format is shown in the following table:

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

find list. An array of strings, each string specifying one interface found by the function.

Interface Expression

GPIB GPIB[0-9]*::?*INSTR

GPIB-VXI GPIB-VXI?*INSTR

GPIB or GPIB-VXI GPIB?*INSTR

VXI VXI?*INSTR

All VXI ?*VXI[0-9]*::?*INSTR

Serial ASRL[0-9]*::?*INSTR

All ?*INSTR
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return count. Specifies the number of matches found; (the number of strings in the find 

list array).

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Lock
Establishes exclusive access to the specified source.

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

timeout. Period of time to wait for access to lock.

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.
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VISA Open
Opens a session to the specified device and returns a session identifier that can be used 
to call any other operations of that device. 

timeout should be set to zero (0).

VISA session is wired to indicate the class of the session being opened. It need not be a 
valid session, only the class of the session is important. 

resource name. Unique symbolic name of a resource.

access mode should be set to zero (0).

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

VISA session is the session opened by the function. It must match the class of the input 
VISA session.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

The following table shows the grammar for the address string. Optional parameters are 
shown in square brackets ([ ]).

Interface Grammar

GPIB GPIB[board]::primary address[::secondary address][::INSTR]

GPIB-VXI GPIB-VXI[board]::VXI logical address[::INSTR]

VXI VXI[board]::VXI logical address[::INSTR]

Serial ASRL[board][::INSTR]
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The GPIB keyword can be used to establish communication with a GPIB device. The 
GPIB-VXI keyword is used for a GPIB-VXI controller. The VXI keyword is used for 
VXI instruments via either embedded or MXIbus controllers. The Serial keyword is used 
to establish communication with an asynchronous serial (such as RS-232) device.

The INSTR keyword specifies a VISA resource of the type INSTR. 

The following table shows the default value for optional parameters:

The following table shows examples of address strings:

See the VISA Close description earlier in this chapter. 

VISA Read
Reads data from a device. On UNIX platforms data is read synchronously; on all other 
platforms data is read asynchronously.

Optional Parameter Default Value

board 0

secondary address none

Address String Description

GPIB::1::0::INSTR A GPIB device at primary address 1 and secondary 
address 0 in GPIB interface 0.

GPIB-

VXI::9::INSTR

A VXI device at logical address 9 in a GPIB-VXI controlled 
VXI system.

VXI0::1::INSTR A VXI device at logical address 1 in VXI interface VXI0.

ASRL0::INSTR A serial device located on port 0.
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VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

byte count (0). Number of bytes to be read.

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

read buffer contains the data read from the device.

return count contains the number of bytes actually read.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Read STB
Reads a service request status from a message-based device. For example, on the IEEE 
488.2 interface, the message is read by polling devices. For other types of interfaces, a 
message is sent in response to a service request to retrieve status information. If the 
status information is only one byte long, the most significant byte is returned with the 
zero value. 

Note: The Serial Instr class is not valid for VISA Read STB.

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.
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dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

status contains the status byte read from the instrument.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Status Description
Retrieves a user-readable string that describes the status code presented in error in. 

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

status description contains the user-readable string interpretation of the status code 
passed to the operation.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.
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VISA Unlock
Relinquishes the lock previously obtained using the VISA Lock function.

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Write
Writes data to the device. On UNIX platforms data is written synchronously; on all other 
platforms data is written asynchronously.

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

write buffer contains the data to be written to the device.

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.
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dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

return count contains the actual number of bytes written.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

Event Handling Functions
The following section describes the VISA Event Handling functions. Valid classes for 
these functions are: Instr (default), GPIB Instr, Serial Instr, VXI/GPIB-VXI  RBD Instr, 
and VXI/GPIB-VXI  MBD Instr.

To access the VISA Event Handling functions, pop up on the Event Handling icon on 
the VISA palette:

VISA Disable Event
Disables servicing of an event. This operation prevents new event occurrences from 
being queued. However, event occurrences already queued are not lost; use VISA 
Discard Events if you want to discard queued events.

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.
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event type is the logical event identifier. Special values are:

Trigger:  0xBFFF200A

VXI Signal:  0x3FFF2020

Service Request:  0x3FFF200B

All Events:  0x3FFF7FFF

mechanism. Specifies the event handling mechanism to be disabled. Currently only 
accepts VI_QUEUE (1). 

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Discard Events
Discards all pending occurrences of the specified event types and mechanisms from the 
specified session. 

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

event type is the logical event identifier. Special values are:

Trigger:  0xBFFF200A

VXI Signal:  0x3FFF2020

Service Request:  0x3FFF200B

All Events:  0x3FFF7FFF
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mechanism. Specifies the event handling mechanism to be disabled. Currently only 
accepts VI_QUEUE (1).

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Enable Event
Enables notification of a specified event. 

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

event type is the logical event identifier. Special values are:

Trigger:  0xBFFF200A

VXI Signal:  0x3FFF2020

Service Request:  0x3FFF200B

mechanism. Specifies the event handling mechanism to be disabled. Currently only 
accepts VI_QUEUE (1).

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.
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dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Wait On Event
Suspends execution of a thread of application and waits for an event Event Type for a 
time period not to exceed that specified by timeout. Refer to individual event 
descriptions for context definitions. If the specified event type is All Events, the 
operation waits for any event that is enabled for the given session.

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

event session (for class) specifies the class of event being waited for.

timeout. Period of time to wait for the event.

event type is the logical event identifier. Special values are:

Trigger:  0xBFFF200A

VXI Signal:  0x3FFF2020

Service Request:  0x3FFF200B

All Events:  0x3FFF7FFF

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

event type identifies the event type received if the wait was successful.
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event session is valid if the wait was successful. Can be wired to an attribute node to get 
further information about the event and should be wired to the VISA Close function when 
examination of the event is complete.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

High Level Register Access Functions
The following section describes the VISA High Level Register Access functions. Valid 
classes for these functions are: Instr (default), VXI/GPIB-VXI RBD Instr, and 
VXI/GPIB-VXI MBD Instr. To access the VISA High Level Register Access functions, 
pop up on the High Level icon on the VISA palette:

VISA In8 / In16 / In32
Reads in 8-bits, 16-bits, or 32-bits of data, respectively, from the specified memory 
space (assigned memory base + offset). 
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VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

address space. Specifies the address space without requiring VISA Map Address to be 
called. The following table lists the valid entries for specifying address space:

offset. Offset (in bytes) of the device to read from. It is the offset address relative to the 
device’s allocated address base for the corresponding specified address space. For 
example, if address space specifies A16 SPACE, then offset specifies the offset from 
the logical address base address of the VXI device specified. If address space specifies 
A24 or A32 SPACE, offset specifies the offset from the base address of the VXI 
device’s memory space allocated by the VXI Resource Manager within VXI A24 or 
A32 SPACE. See the VISA In description earlier in this section.

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

value contains the data read from bus (8-bits for In8, 16-bits for In16, 32-bits for In32; 
8-bits is shown).

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

Value Description

A16 SPACE (1) Addresses the A16 address space of VXI/MXI bus.

A24 SPACE (2) Addresses the A24 address space of VXI/MXI bus.

A32 SPACE (3) Addresses the A32 address space of VXI/MXI bus.
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VISA Memory Allocation
Returns an offset into a device’s region that has been allocated for use by the session. 
The memory can be allocated on either the device itself or on the computer’s system 
memory.

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

size specifies the size of the allocation.

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

offset returns the offset which specifies where the memory was allocated.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Memory Free
Frees the memory previously allocated by the VISA Memory Allocation function.

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

offset specifies the memory previously allocated by VISA Memory Allocation.
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error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Move In8 / Move In16 / Move In32
Moves a block of data from device memory to local memory in accesses of 8-bits, 
16-bits, or 32-bits, respectively.

address space. Specifies the address space to map. For more information, see the table 
listed under address space, VISA In.

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

offset. Offset (in bytes) of the device to read from. It is the offset address relative to the 
device’s allocated address base for the corresponding specified address space. For 
example, if address space specifies A16 SPACE, then offset specifies the offset from 
the logical address base address of the VXI device specified. If address space specifies 
A24 or A32 SPACE, offset specifies the offset from the base address of the VXI 
device’s memory space allocated by the VXI Resource Manager within VXI A24 or 
A32 SPACE. 

count. Counts the number of data items to move.
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error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

data is the data which is being moved (8-bits for Move In8, 16-bits for Move In16, 
32-bits for Move In32; 8-bits is shown).

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Move Out8 / Move Out16 / Move Out32
Moves a block of data from local memory to device memory in accesses of 8-bits, 
16-bits, or 32-bits, respectively.

address space. Specifies the address space to map. For more information, see the table 
listed under address space, VISA In.

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

offset. Offset (in bytes) of the device to write to. It is the offset address relative to the 
device’s allocated address base for the corresponding specified address space. For 
example, if address space specifies A16 SPACE, then offset specifies the offset from 
the logical address base address of the VXI device specified. If address space specifies 
A24 or A32 SPACE, offset specifies the offset from the base address of the VXI 
device’s memory space allocated by the VXI Resource Manager within VXI A24 or 
A32 SPACE. 
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data is the data which is being moved (8-bits for Move Out8, 16-bits for Move Out16, 
32-bits for Move Out32; 8-bits is shown).

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

count. Counts the number of data items to move.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Out8 / Out16 / Out32
Writes 8-bits, 16-bits, or 32-bits of data, respectively, to the specified memory space 
(assigned memory base + offset).

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

address space. Specifies the address space to map. For more information, see the table 
listed under address space, VISA In.
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offset. Offset (in bytes) of the device to read from. It is the offset address relative to the 
device’s allocated address base for the corresponding specified address space. For 
example, if address space specifies A16 SPACE, then offset specifies the offset from 
the logical address base address of the VXI device specified. If address space specifies 
A24 or A32 SPACE, offset specifies the offset from the base address of the VXI 
device’s memory space allocated by the VXI Resource Manager within VXI A24 or 
A32 SPACE. 

. value contains the data to write to bus (8-bits for Out8, 16-bits for Out16, 32-bits for 
Out32; 8-bits is shown).

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

Low Level Register Access Functions
The following section describes the VISA Low Level Register Access functions. Valid 
classes for these functions are: Instr (default), VXI/GPIB-VXI  RBD Instr, and 
VXI/GPIB-VXI  MBD Instr.To access the VISA Low Level Register Access functions, 
pop up on the Low Level icon on the VISA palette:
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VISA Map Address
Maps in a specified memory space. 

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

address space. Specifies the address space to map. For more information, see the table 
listed under address space, VISA In.

map base contains the offset (in bytes) of the memory to be mapped.

map size contains the amount of memory to map.

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

access should be set to false (F).

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Memory Allocation
For information on the VISA Memory Allocation function, see the High Level Register 

Access Functions section of this chapter.
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VISA Memory Free
For information on the VISA Memory Free function, see the High Level Register Access 

Functions section of this chapter.

VISA Peek8 / Peek16 / Peek32
Reads an 8-bit, 16-bit, or 32-bit value, respectively, from the specified address. 

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

offset contains the offset (in bytes) from the register location originally mapped in the 
mapped memory space.

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

value contains the read data (8-bits for VISA Peek8, 16-bits for Peek16, 32-bits for 
Peek32; 8-bits is shown).

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.
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VISA Poke8 / Poke16 / Poke32
Writes an 8-bit, 16-bit, or 32-bit value, respectively, to the specified address. 

VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

offset contains the offset (in bytes) from the register location originally mapped in the 
mapped memory space.

value contains the value to write (8-bits for Poke8, 16-bits for Poke16, 32-bits for 
Poke32; 8-bits is shown).

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Unmap Address
Unmaps memory space previously mapped by VISA Map Address.
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VISA session. See the VISA Library Reference Parameters section of this chapter for 
more information.

error in (no error). See the VISA Library Reference Parameters section of this 
chapter for more information.

dup VISA session. See the VISA Library Reference Parameters section of this 
chapter for more information.

error out. See the VISA Library Reference Parameters section of this chapter for 
more information.

VISA Attribute Node

This section describes the VISA Library attributes. The VISA 
Attribute Node gets and/or sets the indicated attributes. The node is 
growable; evaluation starts from the top and proceeds downward until 
an error, or until the final evaluation, occurs.

To access the attribute node, select Functions»Instrument I/O»
VISA. Then select the attribute node icon located on the bottom row of 
the VISA palette.

The VISA Attribute Node only displays attributes for the class of the 
session that is wired to it. You can change the class of a VISA Attribute 
Node as long as you have not wired it to a VISA session. Once a VISA 

session is wired to a VISA Attribute Node, it adapts to the class of the 
session and any displayed attributes which are not valid for that class 
become invalid (this is indicated by turning the attribute item black). 
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VISA Attribute Descriptions

Each attribute description includes the attribute’s range of values, default value, and 
access privilege. Local applies the current session only. Global refers to all sessions to 
the same VISA resource.

Fast Data Channel Mode

Specifies which FDC mode to use (either normal or stream mode).

Range: FDC Normal (1)/FDC Stream (2)
Default: FDC Normal (1)
Access Privilege: Read/Write Local

Fast Data Channel Number

Determines which fast data channel (FDC) will be used to transfer the buffer.

Range: 0 to 7
Default: N/A
Access Privilege: Read/Write Local

Fast Data Channel Pairs

Specifies use of a channel pair for transferring data; (otherwise, only one channel will 
be used).

Range: True/False
Default: False
Access Privilege: Read/Write Local
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Fast Data Channel Signal Enable

Lets the servant send a signal when control of the FDC channel is passed back to the 
commander. This action frees the commander from having to poll the FDC header 
while engaging in an FDC transfer.

Range: True/False
Default: False
Access Privilege: Read/Write Local

GPIB Primary Address

Specifies the primary address of the GPIB device used by the given session. 

Range: 0 to 30
Default: N/A
Access Privilege: Read Only Global

GPIB Secondary Address

Specifies the secondary address of the GPIB device used by the given session.

Range: 0 to 31; FFFF for no secondary address
Default: N/A
Access Privilege: Read Only Global

IO Protocol

Specifies which protocol to use. In VXI systems you can choose between normal 
word serial or fast data channel (FDC). In GPIB, you can choose between normal and 
high-speed (HS488) data transfers. 
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Range: GPIB: Normal (1)/HS488 (3)
VXI, GPIB-VXI: Normal (1)/FDC(2)

Default: Normal (1)
Access Privilege: Read/Write Local

Immediate Servant

I Determines if the VXI device is an immediate servant of the local controller.

Range: True/False
Default: N/A
Access Privilege: Read Only Global

Increment Destination Count

Specifies the number of elements by which to increment the destination address on block 
move operations.

Range: 0, 1
Default: 1
Access Privilege: Read/Write Local

Increment Source Count

Specifies the number of elements by which to increment the source address on block 
move operations.

Range: 0,1
Default: 1
Access Privilege: Read/Write Local
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Interface Number

Specifies the board number for the given interface. 

Range: 0h to FFFFh
Default: 0
Access Privilege: Read Only Global

InterfaceType

Specifies the interface type of the given session.

Range: GPIB (1), GPIB-VXI (3), VXI (2), Serial (4)
Default: N/A
Access Privilege: Read Only Global

Mainframe Logical Address

Specifies the lowest logical address in the mainframe. If the logical address is not 
known, UNKNOWN LA is returned.

Range: 0 to 255; UNKNOWN LA (-1)
Default: N/A
Access Privilege: Read Only Global

Manufacturer ID

The manufacturer identification number of the VXIbus device.

Range: 0h to FFFh
Default: N/A
Access Privilege: Read Only Global
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Maximum Queue Length

Specifies the maximum number of events that can be queued at any time on the given 
session. This attribute is Read/Write until the first time Enable Event is called on a 
session. Thereafter, this attribute is Read Only. 

Range: 1h to FFFFFFFFh
Default: 50
Access Privilege: Read/Write Local

Model Code

Specifies the model code for the VXIbus device.

Range: 0h to FFFFh
Default: N/A
Access Privilege: Read Only Global

Resource Lock State

Reflects the current locking state of the resource that is associated with the given session.

Range: No Lock (0), Exclusive Lock (1), Shared Lock (2)
Default: No Lock (0)
Access Privilege: Read Only Global

Resource Manufacturer Identification

A value corresponding to the VXI manufacturer ID of the manufacturer that created 
the implementation.

Range: 0h to 3FFFh
Default: N/A
Access Privilege: Read Only Global
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Resource Manufacturer Name

A string that corresponds to the VXI manufacturer name of the manufacturer that 
created the implementation.

Range: N/A
Default: N/A
Access Privilege: Read Only Global

Resource Name

Unique identifier for a resource.

Range: N/A
Default: N/A
Access Privilege: Read Only Global

The address structure is shown in the following table. Optional parameters are shown in 
square brackets:  

Interface Grammar

GPIB GPIB[board]::primary address[::secondary 

address][::INSTR]

GPIB-VXI GPIB-VXI[board]::VXI logical address[::INSTR]

VXI VXI[board]::VXI logical address[::INSTR]

Serial ASRL[board][::INSTR]

Address String Description

GPIB::1::0::INSTR A GPIB device at primary address 1 and secondary 
address 0 in GPIB interface 0.

GPIB-

VXI::9::INSTR

A VXI device at logical address 9 in a GPIB-VXI controlled 
VXI system.
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Send End Enable

Specifies whether to assert END during the transfer of the last byte of the buffer. 

Range: True/False
Default: True
Access Privilege: Read/Write Local

Slot

Specifies the physical slot location of the VXIbus device. If the slot number is not 
known, UNKNOWN SLOT is returned.

Range: 0-12; UNKNOWN SLOT (-1)
Default: N/A
Access Privilege: Read Only Global

VXI0::1::INSTR A VXI device at logical address 1 in VXI interface VXI0.

ASRL0::INSTR A serial device located on port 0.

Address String Description
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Suppress End Enable

Specifies whether to suppress the END bit termination. If this attribute is set to 
TRUE, the END bit does not terminate read operations. If this attribute is set to 
FALSE, the END bit terminates read operations.

Range: True/False
Default: False
Access Privilege: Read/Write Local

Termination Character

The termination character. When the termination character is read and Termination 
Character Enable is enabled during a read operation, the read operation terminates. 
See the description for Termination Character Enable listed below.

Range: 0 to FFh
Default: 0Ah (line feed)
Access Privilege: Read/Write Local

Termination Character Enable

Determines whether the read operation should terminate when a termination 
character is received. 

Range: True/False
Default: False
Access Privilege: Read/Write Local

Timeout Value

Specifies the timeout value to use (in milliseconds) when accessing the device 
associated with the given session. A timeout value of TMO IMMEDIATE means that 
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operations should never wait for the device to respond. A timeout value of TMO 
INFINITE disables the timeout mechanism.

Range: IMMEDIATE (0); INFINITE (FFFFFFFFh)

Entire range 1 to FFFFFFFEh
Default: 2000
Access Privilege: Read/Write Local

Trigger Identifier

Identifier for the current triggering mechanism.

Range: GPIB: VI_TRIG_SW (-1)

GPIB-VXI, VXI: VI_TRIG_SW (-1);

VI_TRIG_TTL0 to VI_TRIG_TTL7 (0-7);

VI_TRIG_ECL0 to VI_TRIG_ECL1 (8-9)
Default: VI_TRIG_SW (-1)

Access Privilege: Read/Write Local

Note: Trigger ID is Read/Write when the corresponding session is not 

enabled to receive trigger events. When the session is enabled to 

receive trigger events, the attribute is Read Only.

User Data

Used privately by the application for a particular session. This data is not used by 
VISA for any purposes. It is provided to the application for its own use.

Range: 0h to FFFFFFFFh
Default: N/A
Access Privilege: Read/Write Local
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Version of Implementation

Uniquely identifies each of the different revisions or implementations of a resource. 
This attribute value is defined by the individual manufacturer and increments with 
each new revision. The format of the value has the upper 12 bits as the major number 
of the version, the next lower 12 bits as the minor number of the version, and the 
lowest 8 bits as the sub-minor number of the version.

Range: 0h to FFFFFFFFh
Default: N/A
Access Privilege: Read Only Global

Version of Specification

Uniquely identifies the version of the VISA specification to which the 
implementation is compliant. The format of the value has the upper 12 bits as the 
major number of the version, the next lower 12 bits as the minor number of the 
version, and the lowest 8 bits as the sub-minor number of the version.

Range: 0h to FFFFFFFFh
Default: 00100000h
Access Privilege: Read Only Global

VXI Commander Logical Address

The logical address of the commander of the VXI device.

Range: 0 to 255
Default: N/A
Access Privilege: Read Only Global
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VXI Logical Address

Specifies the logical address of the VXI device used by the given session.

Range: 0 to 255
Default: N/A
Access Privilege: Read Only Global

VXI Memory Address Space

Specifies the VXIbus address space used by the device. The three types are A16 only, 
A16/A24, or A16/A32 memory address space.

Range: A16 (1), A24 (2), A32 (3)
Default: A16 (1)
Access Privilege: Read Only Global

VXI Memory Base Address

Specifies the base address of the device in VXIbus memory address space. This base 
address is applicable to A24 or A32 address space.

Range: 0h to FFFFFFFFh
Default: N/A
Access Privilege: Read Only Global

VXI Memory Size

Specifies the size of memory requested by the device in VXIbus address space.

Range: 0h to FFFFFFFFh
Default: N/A
Access Privilege: Read Only Global
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Window Access

Specifies the modes in which the current window may be accessed.

Range: NMAPPED (1), USE_OPERS (2)
Default: NMAPPED (1)

Access Privilege: Read Only Local

Window Base Address

Specifies the base address of the interface bus to which this window is mapped.

Range: 0h to FFFFFFFFh
Default: N/A
Access Privilege: Read Only Local

Window Size

Specifies the size of the region mapped to this window.

Range: 0h to FFFFFFFFh
Default: N/A
Access Privilege: Read Only Local
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Traditional GPIB Functions

Chapter

6

This chapter describes the traditional GPIB functions. You use these 
functions to handle situations outside the scope of the IEEE 488.2 
standard. 

The following figure shows the GPIB Traditional Functions palette 
which you access by selecting Functions»Instrument I/O»GPIB 

Traditional:

For examples of how to use the traditional GPIB functions, see 
examples\instr\smplgpib.llb.

You can find helpful information about individual VIs online by using 
the LabVIEW Help window (Help»Show Help). When you place the 
cursor on a VI icon, the wiring diagram and parameter names for that 
VI appear in the Help window. You can also find information for front 
panel controls or indicators by placing the cursor over the control or 
indicator with the Help window open. For more information on the 
LabVIEW Help window, refer to the Getting Help section in Chapter 2, 
Creating VIs, of the LabVIEW User Manual.

In addition to the Help window, LabVIEW has more extensive online 
information available. To access this information, select Help»Online 

Reference. For most block diagram objects, you can select Online 

Reference from the object’s pop-up menu to access the online 
description. You can also access this information by pressing the 
button shown to the left, which is located at the bottom of LabVIEW’s 

 

This document was created with FrameMaker 4.0.4
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Help window. For information on creating your own online reference 
files, see the Creating Your Own Help Files section in Chapter 25, 
Managing Your Applications of the LabVIEW User Manual.

Traditional GPIB Function Parameters

Most of the traditional GPIB functions use the following parameters:

• address string contains the address of the GPIB device with which 
the function communicates. You can input both the primary and 
secondary addresses in address string by using the form 
primary+secondary. Both primary and secondary are decimal 
values, so if primary is 2 and secondary is 3, address string is 2+3.

If you do not specify an address, the functions do not perform 
addressing before they attempt to read and write the string. They 
assume you have either sent these commands another way or that 
another Controller is in charge and therefore responsible for the 
addressing. If the Controller is supposed to address the device but 
does not do so before the time limit expires, the functions 
terminate with GPIB error 6 (timeout) and set bit 14 in status. If 
the GPIB is not the Controller-In-Charge, you must not specify an 
address string.

When there are multiple GPIB Controllers that LabVIEW can use, 
a prefix to the address string in the form ID:address (or ID: if 
no address is necessary) determines the Controller that a specific 
function uses. If a Controller ID is not present, the functions 
assume Controller (or bus) 0.

• status is a 16-bit Boolean array in which each bit describes a state 
of the GPIB Controller. If an error occurs, bit 15 is set. The error 
code field of the error out cluster is a GPIB error code only if bit 15 
of status is set. Refer to GPIB Status in the GPIB Function 

Descriptions section of this chapter for status bit error codes.

• error in and error out terminals comprise the error clusters in each 
traditional GPIB function. The error cluster contains three fields. The 
status field is a Boolean which is TRUE when an error occurs, 
FALSE when no error occurs. The code field will be a GPIB error 
code value if an error occurs during a GPIB function. Table 6-3 
lists the GPIB error codes. The source field is a string which 
describes where the error has occurred. If the status field of the 
error in parameter to a function is set, the function is not executed 
and the same error cluster is passed out. By wiring the error out 
of each function to the error in of the next function, the first error 
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condition is recorded and propagated to the end of the diagram 
where it is reported in only one place. 

Traditional GPIB Function Behavior

The GPIB Read and GPIB Write functions leave the device in the 
addressed state when they finish executing. If your device cannot 
tolerate being left in the addressed state, use the GPIB Misc function 
to send the appropriate unaddress message or configure the NI-488.2 
software to unaddress automatically for all devices on the GPIB. 

The traditional GPIB Read and Write functions can execute 
asynchronously. This means other LabVIEW activity can continue 
while these GPIB functions are operating. When set to execute 
asynchronously, a small wristwatch icon appears as part of the function 
icons. A popup item on the Traditional GPIB Read and GPIB Write 
functions allows for switching their behavior to and from asynchronous 
operation.
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Traditional GPIB Function Descriptions

GPIB Clear
Sends either SDC (Selected Device Clear) or DCL (Device Clear). 

address string. If you specify an address in address string, the function sends SDC 
to that address. If address string is unwired, the function sends DCL. See the 
Traditional GPIB Function Parameters section of this chapter for more information.

error in. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

status. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

error out. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

GPIB Initialization
Configures the GPIB interface at address string.
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require re-addressing. If require re-addressing is TRUE, the function addresses the 
device before every read or write. If FALSE, the device must be able to retain 
addressing from one read or write to the next. 

assert REN with IFC. If assert REN with IFC is TRUE, and if this Controller 
(specified by the ID in address string) is the System Controller, the function asserts 
the Remote Enable line. 

system controller. If system controller is TRUE, this Controller acts as the System 
Controller. 

address string. The address string sets the GPIB address of the GPIB controller 
itself. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

IST bit sense. If IST bit sense is TRUE, the Individual Status bit of the device 
responds TRUE to a parallel poll; if IST bit sense is FALSE, the Individual Status bit 
of the device responds FALSE to a parallel poll. 

error in. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

disallow DMA. If disallow DMA is TRUE, this device uses programmed I/O for data 
transfers.

error out. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

GPIB Misc
Performs the GPIB operation indicated by command string. Use this low-level function 
when the previously described high-level functions are not suitable. 



Chapter 6     Traditional GPIB Functions

LabVIEW Instrument I/O VI Reference Manual 6-6  National Instruments Corporation

command string. The following table shows the functions you can specify in 
command string. See the GPIB Device and Controller Functions section for more 
information.

Table 6-1.      Command String Functions 

Device Functions Description

loc address Go to local.

off address Take device offline.

pct address Pass control.

ppc byte address Parallel poll configure (enable or disable).

GPIB Controller 

Functions Description

cac 0/1 Become active Controller.

cmd string Send IEEE 488 commands.

dma 0/1 Set DMA mode or programmed I/O mode. 

gts 0/1 Go from active Controller to standby.

ist 0/1 Set individual status bit.

llo Local lockout.

loc Place Controller in local state.

off Take controller offline.

ppc byte Parallel poll configure (enable or disable).

ppu Parallel poll unconfigure all devices.

rpp Conduct parallel poll.

rsc 0/1 Request or release system control.

rsv byte Request service and/or set the serial poll 
status byte.
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To specify the GPIB Controller used by this function, use a command string in the 
form ID: xxx, where ID is the GPIB Controller (bus number) and xxx is the 
three-character command and its corresponding arguments, if any. If you do not 
specify a Controller ID, LabVIEW assumes 0.

error in. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

output string is the response the function returns when you conduct a parallel poll 
with the rpp command string.

status describes the state of the GPIB Controller. See the Traditional GPIB Function 

Parameters section of this chapter for more information.

error out. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

GPIB Read
Reads byte count number of bytes from the GPIB device at address string. 

timeout ms. The operation aborts if it does not complete within timeout ms. If a 
timeout occurs, bit 14 of status is set. To disable timeouts, set timeout ms to 0. To 
use the 488.2 global timeout, leave this input unwired.

sic Send interface clear.

sre 0/1 Set or clear remote enable.

Table 6-1.      Command String Functions (Continued)

Device Functions Description



Chapter 6     Traditional GPIB Functions

LabVIEW Instrument I/O VI Reference Manual 6-8  National Instruments Corporation

You use the SetTimeOut function to change the default value (the 488.2 global 
timeout) of timeout ms. Initially, timeout ms defaults to 25,000. See the description 
of the SetTimeOut function in Chapter 7, GPIB 488.2 Functions, for more 
information.

address string. See the Traditional GPIB Function Parameters section of this 
chapter for more information.

byte count specifies the number of bytes the function reads from the GPIB device.

mode specifies conditions other than reaching byte count for terminating the read. 

0: No EOS character. The EOS termination mode is disabled.
1: EOS character is CR. Read terminated on EOI, byte count, or CR.
2: EOS character is LF. Read terminated on EOI, byte count, or LF.
x: Any other mode indicates the number (decimal) of the desired EOS 

character. See Appendix A, Multiline Interface Messages.

error in. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

data string. The function returns the data read in data string. 

status. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

The GPIB Read Function terminates when it:

• Reads the number of bytes requested.

• Detects an error.

• Exceeds the time limit.

• Detects the END message (EOI asserted).

• Detects the EOS character (if this option is enabled by the value supplied to 
mode).

Note: The function compares all eight bits when it checks for the 

EOS character.

error out. See the Traditional GPIB Function Parameters section of this chapter for 
more information.
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GPIB Serial Poll
Performs a serial poll of the device indicated by address string. 

address string is the address of the device the function polls. See the Traditional 

GPIB Function Parameters section of this chapter for more information.

error in. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

serial poll byte is the response from the device. If the addressed device does not 
respond within the timeout limit, serial poll byte is -1.

status. If the addressed device does not respond within the timeout limit, the function 
returns GPIB error 6 (bit 14 of status is set). See the Traditional GPIB Function 

Parameters section of this chapter for more information.

error out. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

GPIB Status
Shows the status of the GPIB Controller indicated by address string after the previous 
GPIB operation. 
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address string. See the Traditional GPIB Function Parameters section of this chapter 
for more information.

error in. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

status. The following table shows the numeric value and symbolic status of each bit 
in status. This table also includes a description of each bit.  

GPIB error contains the most recent error code reported by any of the GPIB 
functions. The following table shows the possible values for GPIB error if bit 15 of 
status is set.

Table 6-2.      Status Bits 

Status Bit Numeric 

Value

Symbolic 

Status

Description

0 1 DCAS Device Clear state

1 2 DTAS Device Trigger State

2 4 LACS Listener Active

3 8 TACS Talker Active

4 16 ATN Attention Asserted

5 32 CIC Controller-In-Charge

6 64 REM Remote State

7 128 LOK Lockout State

8 256 CMPL Operation Completed

12 4096 SRQI SRQ Detected while CIC

13 8192 END EOI or EOS Detected

14 16384 TIMO Timeout

15 -32768 ERR Error Detected
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Table 6-3.      GPIB Error Codes 

GPIB 

Error

Symbolic 

Status

Description

0 EDVR Error Connecting to Driver

1 ECIC Command Requires GPIB Controller to be CIC

2 ENOL Write Detected No Listeners

3 EADR GPIB Controller Not Addressed Correctly

4 EARG Invalid Argument or Arguments

5 ESAC Command Requires GPIB to be System 
Controller

6 EABO I/O Operation Aborted

7 ENEB Non-existent Board

8 EDMA DMA Hardware Not Detected

9 EBTO DMA Hardware uP Bus Timeout

11 ECAP No Capability

12 EFSO File System Operation Error

13 EOWN Shareable Board Exclusively Owned

14 EBUS GPIB Bus Error

15 ESTB Serial Poll Byte Queue Overflow

16 ESRQ SRQ Stuck On

17 ECMD Unrecognized Command

19 EBNP Board Not Present

20 ETAB Table Error

30 NADDR No GPIB Address Input
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 byte count is the number of bytes the previous GPIB operation sent.

error out. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

GPIB Trigger
Sends GET (Group Execute Trigger) to the device indicated by address string.

address string. See the Traditional GPIB Function Parameters section of this chapter 
for more information.

error in. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

31 NSTRG No String Input (Write)

32 NCNT No Count Input (Read)

61 EPAR Serial Port Parity Error

62 EORN Serial Port Overrun

63 EOFL Port Receive Buffer Overflow

64 EFRM Serial Port Framing Error

65 SPTMO Serial Port Timeout, Bytes Not Received at 
Serial Port

Table 6-3.      GPIB Error Codes (Continued)

GPIB 

Error

Symbolic 

Status

Description
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status. See the Traditional GPIB Function Parameters section of this chapter for more 
information.

error out. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

GPIB Wait
Waits for the state(s) indicated by wait state vector at the device indicated by address 

string. 

timeout ms. The operation aborts if it does not complete within timeout ms. If a 
timeout occurs, the function sets bit 14 of status. To disable timeouts, set timeout ms 
to 0. To use the 488.2 global timeout, leave this input unwired.

You use the SetTimeOut function to change the default value (the 488.2 global 
timeout) of timeout ms. Initially, timeout ms defaults to 25,000. See the description 
of the SetTimeOut function in Chapter 7, GPIB 488.2 Functions, for more 
information. 

address string. See the Traditional GPIB Function Parameters section of this chapter 
for more information.

wait state vector. Bits set to TRUE in wait state vector indicate states for which the 
function waits. If more than one bit is set, the function terminates when any one of 
the desired states exists.

The following table defines the bits that you can set in wait state vector. This table 
also lists the numeric value and description of each bit. These bits are the same as the 
ones that other GPIB functions return; however, only the bits listed are valid for this 
function.
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error in. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

status. If you are waiting for multiple states, check status to see which state caused 
the function to terminate. Refer to the GPIB Status function for other status bit 
descriptions. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

This function can run in parallel with other functions because LabVIEW alternately 
checks for status and executes other functions. In addition, multiple calls to this 
function can execute in parallel, so you can wait for different states on different 
Controllers at the same time or for multiple states to exist. 

error out. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

Table 6-4.      Wait State Vector Bits 

Wait State 

Vector Bit

Numeric 

Value

Symbolic 

Status

Description

0 1 DCAS Device Clear state

1 2 DTAS Device Trigger State

2 4 LACS Listener Active

3 8 TACS Talker Active

4 16 ATN Attention Asserted

5 32 CIC Controller-In-Charge

6 64 REM Remote State

7 128 LOK Lockout State

12 4096 SRQI SRQ Detected while CIC

13 8192 END EOI or EOS Detected

14 16384 TIMO Timeout
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Wait for GPIB RQS
Waits for the device indicated by address string to assert SRQ. 

timeout ms. The operation aborts if it does not complete within timeout ms. If a 
timeout occurs, poll response byte is -1. To disable timeouts, set timeout ms to 0. To 
use the 488.2 global timeout, leave this input unwired.

You use the SetTimeOut function to change the default value (the 488.2 global 
timeout) of timeout ms. Initially, timeout ms defaults to 25,000. See the description 
of the SetTimeOut function in Chapter 7, GPIB 488.2 Functions, for more 
information.

address string. See the Traditional GPIB Function Parameters section of this chapter 
for more information.

error in. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

poll response byte. If SRQI is set, the function polls the device at the specified 
address to see if it requested service. When the specified device requests service (bit 
6 is set in poll response byte), the function returns the serial poll response.

If the device indicated by address string does not respond within the timeout limit, 
poll response byte is -1.

error out. See the Traditional GPIB Function Parameters section of this chapter for 
more information.
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GPIB Write
Writes data to the GPIB device identified by address string. 

timeout ms. The operation aborts if it does not complete within timeout ms. If a 
timeout occurs, bit 14 of status is set. To disable timeouts, set timeout ms to 0. To 
use the 488.2 global timeout, leave this input unwired.

You use the SetTimeOut function to change the default value (the 488.2 global 
timeout) of timeout ms. Initially, timeout ms defaults to 25,000. See the description 
of the SetTimeOut function in Chapter 7, GPIB 488.2 Functions, for more 
information.

address string. See the Traditional GPIB Function Parameters section of this 
chapter for more information.

data is the data the function writes to the GPIB device. 

mode indicates how to terminate the GPIB Write.

0: Send EOI with the last character of the string.
1: Append CR to the string and send EOI with CR.
2: Append LF to the string and send EOI with LF.
3: Append CR LF to the string and send EOI with LF.
4: Append CR to the string but do not send EOI.
5: Append LF to the string but do not send EOI.
6: Append CR LF to the string but do not send EOI.
7: Do not send EOI.

error in. See the Traditional GPIB Function Parameters section of this chapter for 
more information.
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status. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

error out. See the Traditional GPIB Function Parameters section of this chapter for 
more information.

GPIB Device and Controller Functions

This section describes the functions listed in the GPIB Misc function 
description. The device functions send configuration information to a 
specific instrument (device). The GPIB Controller functions configure 
the Controller or send IEEE 488 commands to which all instruments 
respond. Notice that there are both device and Controller versions of 
the ppc and loc commands. The syntax and use of the commands are 
slightly different for each version.

You can use these functions with all GPIB Controllers accessible by 
LabVIEW, unless stated otherwise in the function description below. 
An ECMD error (17) results when you execute a function for a GPIB 
Controller without the specified capability. The function syntax is 
strict. Each function recognizes only lowercase characters and allows 
only one space between the function name and the arguments.

Device Functions

loc – Go to local
syntax loc address

loc temporarily moves devices from a remote program mode to a local 
mode.

address is the GPIB address of the device. This argument indicates 
both primary and secondary addresses if you use the form 
primary+secondary, where primary and secondary are the decimal 
values of the primary and secondary addresses. For example, if 
primary is 2 and secondary is 3, then address is 2+3.

loc sends the GTL (Go To Local) message to the GPIB device. 
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off– Take device offline
syntax off address

off takes the device at the specified GPIB address offline. This is only 
needed when sharing a device with another application which is using 
the NI 488 GPIB Library.

address is the GPIB address of the device. This argument indicates 
both primary and secondary addresses if you use the form 
primary+secondary, where primary and secondary are the decimal 
values of the primary and secondary addresses. For example, if 
primary is 2 and secondary is 3, then address is 2+3.

pct – Pass control 
syntax pct address

pct passes Controller-in-Charge (CIC) authority to the device at the 
specified address. The GPIB Controller automatically goes into an idle 
state. The function assumes that the device to which pct passes control 
has Controller capability.

address is the GPIB address of the device. This argument indicates 
both primary and secondary addresses if you use the form 
primary+secondary, where primary and secondary are the decimal 
values of the primary and secondary addresses. For example, if 
primary is 2 and secondary is 3, then address is 2+3.

pct sends the following command sequence:

1. Talk address of the device

2. Secondary address of the device, if applicable

3. Take Control (TCT)

ppc – Parallel poll configure
syntax ppc byte address

ppc enables the instrument to respond to parallel polls.
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byte is 0 or a valid parallel poll enable (PPE) command. If byte is 0, the 
parallel poll disable (PPD) byte 0x70 is sent to disable the device from 
responding to a parallel poll. Each of the 16 PPE messages selects a 
GPIB data line (DIO1 through DIO8) and sense (1 or 0) that the device 
must use when it responds to the Identify (IDY) message during a 
parallel poll. The device compares the ist sense and drives the indicated 
DIO line TRUE or FALSE. 

address is the GPIB address of the device. This argument indicates 
both primary and secondary addresses if you use the form 
primary+secondary, where primary and secondary are the decimal 
values of the primary and secondary addresses. For example, if 
primary is 2 and secondary is 3, then address is 2+3.

Controller Functions

cac – Become active Controller
syntax cac 0 (take control synchronously)

cac 1 (take control immediately)

cac takes control either synchronously or immediately (and in some 
cases asynchronously). You generally do not need to use the cac 

function because other functions, such as cmd and rpp, take control 
automatically.

If you try to take control synchronously when a data handshake is in 
progress, the function postpones the take control action until the 
handshake is complete. If a handshake is not in progress, the function 
executes the take control action immediately. Synchronous take 
control is not guaranteed if a read or write operation completes with a 
timeout or other error.

You should take control asynchronously when it is impossible to gain 
control synchronously (for example, after a timeout error).

The ECIC error results if the GPIB Controller is not CIC.
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cmd – Send IEEE 488 commands
syntax cmd string

cmd sends GPIB command messages. These command messages 
include device talk and listen addresses, secondary addresses, serial 
and parallel poll configuration messages, and device clear and trigger 
messages. 

You do not use cmd to transmit programming instructions to devices. 
The GPIB Read and GPIB Write functions transmit programming 
instructions and other device-dependent information.

string contains the command bytes the Controller sends. ASCII 
characters represent these bytes in cmd string. If you must send 
nondisplayable characters, you can enable backslash codes on the 
string control or string constant or you can use a format function to list 
the commands in hexadecimal.

 

dma – Set DMA mode or programmed I/O mode
syntax dma 0    (use programmed I/O)

dma 1    (use DMA)

dma indicates whether data transfers use DMA. 

Some GPIB boards do not have DMA capability. If you try to execute 
dma 1, the function returns GPIB error 11 to indicate no capability.

gts – Go from active Controller to standby
syntax gts 0   (no shadow handshaking)

gts 1   (shadow handshaking)

Description:

gts sets the GPIB Controller to the Controller Standby state and 
unasserts the ATN signal if it is the active Controller. Normally, the 
GPIB Controller is involved in the data transfer. gts permits GPIB 
devices to transfer data without involving the GPIB Controller.
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If shadow handshaking is active, the GPIB Controller participates in 
the GPIB transfer as a Listener, but does not accept any data. When it 
detects the END message, the GPIB Controller asserts the Not Ready 
For Data (NRFD) to create a handshake holdoff state. 

If shadow handshaking is not active, the GPIB Controller performs 
neither shadow handshaking nor a handshake holdoff.

If you activate the shadow handshake option, the GPIB Controller 
participates in a data handshake as a Listener without actually reading 
the data. It monitors the transfer for the END message and stops 
subsequent transfers. This mechanism allows the GPIB Controller to 
take control synchronously on subsequent operations such as cmd or 
rpp. 

After sending the gts command, you should always wait for END 
before you initiate another GPIB command. You can do this with the 
GPIB Wait function. 

The ECIC error results if the GPIB Controller is not CIC.

ist – Set individual status bit
syntax ist 0 (individual status bit is cleared)

ist 1 (individual status bit is set)

ist sets the sense of the individual status (ist) bit.

You use ist when the GPIB Controller is not the CIC but participates 
in a parallel poll conducted by a device that is the active Controller. 
The CIC conducts a parallel poll by asserting the EOI and ATN signals, 
which send the Identify (IDY) message. While this message is active, 
each device that you configured to participate in the poll responds by 
asserting a predetermined GPIB data line either TRUE or FALSE, 
depending on the value of its local ist bit. For example, you can assign 
the GPIB Controller to drive the DIO3 data line TRUE if ist is 1 and 
FALSE if ist is 0. Conversely, you can assign it to drive DIO3 TRUE 
if ist is 0 and FALSE if ist is 1. 

The Parallel Poll Enable (PPE) message in effect for each device 
determines the relationship among the value of ist, the line that is 
driven, and the sense at which the line is driven. The Controller is 



Chapter 6     Traditional GPIB Functions

LabVIEW Instrument I/O VI Reference Manual 6-22  National Instruments Corporation

capable of receiving this message either locally via ppc or remotely via 
a command from the CIC. Once the PPE message executes, ist changes 
the sense at which the GPIB Controller drives the line during the 
parallel poll, and the GPIB Controller can convey a one-bit, 
device-dependent message to the Controller.

llo – Local lockout
syntax llo

llo places all devices in local lockout state. This action usually inhibits 
recognition of inputs from the front panel of the device.

llo sends the Local Lockout (LLO) command. 

loc – Place Controller in local state
syntax loc

loc places the GPIB Controller in a local state by sending the local 
message Return To Local (RTL) if it is not locked in remote mode 
(indicated by the LOK bit of status). You use loc to simulate a front 
panel RTL switch when you use a computer to simulate an instrument.

off– Take controller offline
syntax off

off takes the controller offline. This is only needed when sharing the 
controller with another application which is using the NI 488 Library.

 

ppc – Parallel poll configure (enable and disable)
syntax ppc byte

ppc configures the GPIB Controller to participate in a parallel poll by 
setting its Local Poll Enable (LPE) message to the value of byte. If the 
value of byte is 0, the GPIB Controller unconfigures itself. 
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Each of the 16 Parallel Poll Enable (PPE) messages selects the GPIB 
data line (DIO1 through DIO8) and sense (1 or 0) that the device must 
use when responding to the Identify (IDY) message during a parallel 
poll. The device interprets the assigned message and the current value 
of the individual status (ist) bit to determine if the selected line is 
driven TRUE or FALSE. For example, if PPE=0x64, DIO5 is driven 
TRUE if ist is 0 and FALSE if ist is 1. If PPE=0x68, DIO1 PPE 
message is in effect. You must know which PPE and PPD messages are 
sent and determine what the responses indicate. 

 

ppu – Parallel poll unconfigure 
syntax ppu 

ppu disables all devices from responding to parallel polls.

ppu sends the Parallel Poll Unconfigure (PPU) command.

rpp – Conduct parallel poll
syntax rpp

rpp conducts a parallel poll of previously configured devices by 
asserting the ATN and EOI signals, which sends the IDY message. 

rpp places the parallel poll response in the output string as ASCII 
characters. 

rsc – Release or request system control
syntax rsc 0 (release system control)

rsc 1 (request system control)

rsc releases or requests the capability of the GPIB Controller to send 
the Interface Clear (IFC) and Remote Enable (REN) messages to GPIB 
devices using the sic and sre functions. For the GPIB Controller to 
respond to IFC sent by another Controller, the GPIB Controller must 
not be the System Controller.
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In most applications, the GPIB Controller is always the System 
Controller. You use rsc only if the computer is not the System 
Controller for the duration of the program execution. 

rsv – Request service and/or set the serial poll 
status byte

syntax rsv byte

rsv sets the serial poll status byte of the GPIB Controller to byte. If the 
0x40 bit is set in byte, the GPIB Controller also requests service from 
the Controller by asserting the GPIB SRQ line. For instance, if you 
want to assert the GPIB SRQ line, send the ASCII character @, in 
which the 0x40 bit is set. 

You use rsv to request service from the Controller using the Service 
Request (SRQ) signal and to provide a system-dependent status byte 
when the Controller serial polls the GPIB port.

sic – Send interface clear
syntax sic

sic causes the Controller to assert the IFC signal for at least 100 msec 
if the Controller has System Controller authority. This action initializes 
the GPIB and makes the Controller port CIC. You generally use sic 
when you want a device to become CIC or to clear a bus fault 
condition.

The IFC signal resets only the GPIB functions of bus devices; it does 
not reset internal device functions. The Device Clear (DCL) and 
Selected Device Clear (SDC) commands reset the device functions. 
Consult the instrument documentation to determine the effect of these 
messages.
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sre – Unassert or assert remote enable
syntax sre 0 (unassert Remote Enable)

sre 1 (assert Remote Enable)

sre unasserts or asserts the GPIB REN line. Devices monitor REN 
when they select between local and remote modes of operation. A 
device does not actually enter remote mode until it receives its listen 
address. 

The ESAC error occurs if the Controller is not System Controller.
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GPIB 488.2 Functions

Chapter

7

This chapter describes the IEEE 488.2 (GPIB) Functions. 

The following figure shows the GPIB 488.2 palette which you access 
by selecting Functions»Instrument I/O»GPIB 488.2:

For examples of how to use the GPIB 488.2 Functions, see 
examples\instr\smplgpib.llb.

You can find helpful information about individual VIs online by using 
the LabVIEW Help window (Help»Show Help). When you place the 
cursor on a VI icon, the wiring diagram and parameter names for that 
VI appear in the Help window. You can also find information for front 
panel controls or indicators by placing the cursor over the control or 
indicator with the Help window open. For more information on the 
LabVIEW Help window, refer to the Getting Help section in Chapter 2, 
Creating VIs, of the LabVIEW User Manual.

In addition to the Help window, LabVIEW has more extensive online 
information available. To access this information, select Help»Online 

Reference. For most block diagram objects, you can select Online 

Reference from the object’s pop-up menu to access the online 
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description. You can also access this information by pressing the 
button shown to the left, which is located at the bottom of LabVIEW’s 
Help window. For information on creating your own online reference 
files, see the Creating Your Own Help Files section in Chapter 25, 
Managing Your Applications of the LabVIEW User Manual

GPIB 488.2 Common Function Parameters

Most of the GPIB 488.2 Functions use the following parameters:

• address contains the primary address of the GPIB device with 
which the function communicates. If a secondary address is 
required, use the MakeAddr function to put the primary and 
secondary addresses in the proper format. Unless specified 
otherwise, address and address list are data types integer and 
integer array, respectively. 

• The default primary address of the GPIB board is 0, with no 
secondary address. It is designated as System Controller. The 
default timeout value for the functions is 10 seconds. If you want 
to change any of these parameters, use the configuration utility 
included with your GPIB board. You can also use the GPIB Init 
and SetTimeOut functions to set the primary address and to change 
the default timeout value at run time, but these functions affect the 
interface only when you use it with LabVIEW. For more 
information, see the documentation supplied with your hardware 
interface. 

• bus refers to the GPIB bus number. If you have only one GPIB 
interface in your computer, the default bus number is 0. For 
additional GPIB interfaces, see the software installation 
instructions included with your GPIB board.

• byte count refers to the number of bytes that pass over the GPIB.

• status is a Boolean array in which each bit describes a state of the 
GPIB Controller. If an error occurs, the GPIB functions set bit 15. 
GPIB error is valid only if bit 15 of status is set. See the status bit 
and GPIB error tables in the GPIB Status function description in 
Chapter 6, Traditional GPIB Functions.

• error in; error out. See the GPIB Traditional Function Parameters 

section of Chapter 6 for a description.
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GPIB 488.2 Function Descriptions

Single-Device Functions

DevClear
Clears a single device. To send the Selected Device Clear (SDC) message to several 
GPIB devices, use the DevClearList function.

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address. The function sends the GPIB SDC message to the device at address. If the 
address terminal is not wired, the function sends the Universal Device Clear message 
to all devices on the GPIB. See the GPIB 488.2 Function Parameters section of this 
chapter for more information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.
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PPollConfig
Configures a device for parallel polls. 

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address. The function configures the GPIB device at address for parallel polls 
according to the dataline and sense parameters. See the GPIB 488.2 Function 

Parameters section of this chapter for more information.

dataline is the data line (1 to 8) on which the device responds to the parallel poll.

sense indicates the condition under which the data line is asserted or unasserted. The 
device compares this sense value (TRUE or FALSE) to its individual status bit and 
responds accordingly.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

Devices have the option of configuring themselves for parallel polls, in which case 
they ignore attempts by the Controller to configure them. You should determine 
whether the device is locally or remotely configured before you use PPollConfig or 
PPollUnconfig.
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PassControl
Passes control to another device with Controller capability. 

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address. The function sends the GPIB Device Take Control message to the device 
specified by address. See the GPIB 488.2 Function Parameters section of this chapter 
for more information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

ReadStatus
Serial polls a single device to get its status byte.

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.
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address. The function serial polls the device at address. See the GPIB 488.2 Function 

Parameters section of this chapter for more information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

serial poll response is the status byte of the device at address. You can learn how to 
interpret this byte from the documentation supplied with your device.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

Receive
Reads data bytes from a GPIB device.

Receive terminates when the function does one of the following:

• reads the number of bytes requested

• detects an error

• exceeds the time limit

• detects the END message (EOI asserted)

• detects the EOS character (assuming the value supplied to mode has enabled this 
option)

bus. The function addresses the interface indicated by bus as a Listener. See the GPIB 

488.2 Function Parameters section of this chapter for more information.

address. The function addresses the device indicated by address as a Talker. See the 

GPIB 488.2 Function Parameters section of this chapter for more information.
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mode selects the method that signals the end of the data. If mode is a value from 
decimal 0 through 255, the ASCII character that corresponds to it is the termination 
character, and the function stops the read when it detects the character. If mode is not 
wired, or is decimal 256, the function stops the read when it detects END. 

count. The function returns up to count data bytes from the device in data string. 

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

data string contains count data bytes from the GPIB device. 

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

byte count. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

Send
Sends data bytes to a single GPIB device.

bus. The function addresses the interface indicated by bus as a Talker. See the GPIB 

488.2 Function Parameters section of this chapter for more information.

address. The function addresses the device indicated by address as a Listener. If you 
do not wire address, the function sends data string with no addressing, thereby 
sending it to all previously addressed Listeners. To send data string to several 
devices, use the SendList function. See the GPIB 488.2 Function Parameters section 
of this chapter for more information.
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mode describes how to signal the end of the data to the Listener.

0: Do nothing to mark the end of the transfer.
1: Send NL (linefeed) with EOI after the data bytes.
2: Send EOI with the last data byte in the string.

data string contains the data bytes that the function sends to the GPIB device. 

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

byte count. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

Trigger
Triggers a single device. To send a single message that triggers several GPIB devices, 
use the TriggerList function.

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address. The function sends the GPIB Group Execute Trigger message to the device 
at address. If the address terminal is not wired, the function sends the Group Execute 
Trigger message with no addressing, and this triggers all previously addressed 
Listeners. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.
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error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

Multiple-Device Functions

AllSPoll
Serial polls all devices. 

Although the AllSPoll function is general enough to serial poll any number of GPIB 
devices, you should use the ReadStatus function when you serial poll only one GPIB 
device.

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address list. The function serial polls GPIB devices whose addresses appear in 
address list. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

serial poll byte list contains the responses of the devices whose addresses are 
contained in the corresponding elements of address list.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 
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byte count contains the index of any device that times out instead of responding to 
the poll. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

DevClearList
Clears multiple devices simultaneously. 

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address list. The function sends the GPIB Selected Device Clear (SDC) message to 
the devices listed in address list. If the address list terminal is not wired, the function 
sends the Universal Device Clear message to all devices on the GPIB. See the GPIB 

488.2 Function Parameters section of this chapter for more information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 
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EnableLocal
Enables local mode for multiple devices. 

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address list. The function sends the GPIB Go To Local (GTL) command to the 
devices listed in address list. If the address list terminal is not wired, Remote Enable 
(REN) unasserts, which places all GPIB devices in local mode. See the GPIB 488.2 

Function Parameters section of this chapter for more information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

EnableRemote
Enables remote programming of multiple GPIB devices.

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address list. The function sends the GPIB Remote Enable (REN) command to 
devices listed in address list. If the address list terminal is not wired, the function 
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performs no addressing, and the Remote Enable (REN) line asserts. See the GPIB 

488.2 Function Parameters section of this chapter for more information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

FindRQS
Determines which device is requesting service. 

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address list. Starting at the beginning of the address list array, the function serial 
polls the GPIB devices listed in address list until the function finds the device 
asserting SRQ. See the GPIB 488.2 Function Parameters section of this chapter for 
more information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

requester status byte is the status byte for the device asserting SRQ.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

requester index is the index of the address in address list of the device asserting 
SRQ. Arrays are zero-indexed. A requester index of -1 indicates that none of the 
devices specified in the address list are requesting service.



Chapter 7     GPIB 488.2 Functions

 National Instruments Corporation 7-13 LabVIEW Instrument I/O VI Reference Manual

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

PPoll
Performs a parallel poll. 

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

parallel poll byte is the result of the parallel poll. Each bit of the poll result returns 
one bit of status information from each device configured for parallel polls. The state 
of each bit (0 or 1) and the interpretation of these states are based on the latest parallel 
poll configuration sent to the devices and on the individual status of the devices.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.
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PPollUnconfig
Unconfigures devices for parallel polls. The function unconfigures the GPIB devices 
whose addresses are contained in the address list array for parallel polls; that is, they no 
longer participate in polls. 

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address list. If the address list terminal is not wired, the function sends the GPIB 
Parallel Poll Unconfigure (PPU) message, unconfiguring all devices. See the GPIB 

488.2 Function Parameters section of this chapter for more information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

SendList
Sends data bytes to multiple GPIB devices. This function is similar to Send, except that 
SendList sends data to multiple Listeners with only one transmission.

bus. The function addresses the interface indicated by bus as a Talker. See the GPIB 

488.2 Function Parameters section of this chapter for more information.
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address list. The address list array contains a list of GPIB addresses for devices, 
which the function addresses as Listeners. See the GPIB 488.2 Function Parameters 
section of this chapter for more information.

mode describes how to signal the end of the data to the Listener.

0: Do nothing to mark the end of the transfer.
1: Send NL (linefeed) with EOI after the data bytes.
2: Send EOI with the last data byte in the string.

data string contains the data bytes that the function sends to the addressed devices.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

byte count. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

TriggerList
Triggers multiple devices simultaneously. 

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address list. The function simultaneously triggers GPIB devices whose addresses 
appear in address list. If the address list terminal is not wired, the function sends the 
Group Execute Trigger message without addressing, which triggers all previously 
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addressed Listeners. See the GPIB 488.2 Function Parameters section of this chapter 
for more information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

Bus Management Functions

FindLstn
Finds all Listeners on the GPIB. You normally use this function to detect the presence 
of devices at particular addresses because most GPIB devices have the ability to listen. 
When you detect them, you can usually interrogate the devices with to determine their 
identity.

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address list. The function tests for the presence of a Listener for all devices listed in 
address list. If the function does not detect a listening device at the particular primary 
address, it tests all the secondary addresses associated with that primary address. See 
the GPIB 488.2 Function Parameters section of this chapter for more information.

limit. If more Listeners are present on the bus than limit specifies, the function 
truncates listener address list after limit entries.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.
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listener address list contains the addresses of all the Listeners the function finds.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

number of listeners contains the number of addresses placed in listener address list. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

ResetSys
Performs bus initialization, message exchange initialization, and device initialization. 
First, the function asserts Remote Enable (REN), followed by Interface Clear (IFC), 
unaddressing all devices and making the GPIB board (the System Controller) the 
Controller-in-Charge. 

Second, the function sends the Device Clear (DCL) message to all connected devices. 
This ensures that all IEEE 488.2-compatible devices can receive the Reset (RST) 
message that follows. 

Third, the function sends the *RST message to all devices whose addresses are contained 
in the address list array. This message initializes device-specific functions within each 
device.

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address list. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 
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error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

SendIFC

Clears the GPIB functions with Interface Clear (IFC). When you issue the GPIB Device 
IFC message, the interface functions of all connected devices return to their cleared 
states.

You should use this function as part of a GPIB initialization. It forces the GPIB board 
to be Controller of the GPIB and ensures that the connected devices are all unaddressed 
and that the interface functions of the devices are in their idle states.

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

SendLLO
Sends the Local Lockout (LLO) message to all devices. When the function sends the 
GPIB Local Lockout message, a device cannot independently choose the local or remote 
state. While Local Lockout is in effect, only the Controller can alter the local or remote 
state of the devices by sending the appropriate GPIB messages.You should use 
SendLLO only in unusual local/remote situations, particularly those in which you must 



Chapter 7     GPIB 488.2 Functions

 National Instruments Corporation 7-19 LabVIEW Instrument I/O VI Reference Manual

lock all devices into local programming state. Use the SetRWLS Function when you 
want to place devices in Remote Mode With Lockout State.

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

SetRWLS
Places particular devices in the Remote With Lockout State. The function sends Remote 
Enable (REN) to the GPIB devices listed in address list. It also places all devices in 
Lockout State, which prevents them from independently returning to local programming 
mode without intervention by the Controller. 

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address list. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.
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status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

TestSRQ
Determines the current state of the SRQ line. This function is similar in format to the 
WaitSRQ function, except that WaitSRQ suspends itself while it waits for an occurrence 
of SRQ, and TestSRQ immediately returns the current SRQ state.

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

SRQ is TRUE if the SRQ line is asserted and FALSE if it is not.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.
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TestSys
Directs multiple devices to conduct IEEE 488.2 self-tests.

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

address list. The function simultaneously sends to the GPIB devices whose addresses 
appear in address list a message that instructs them to conduct their self-test 
procedures. See the GPIB 488.2 Function Parameters section of this chapter for 
more information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

result list. Each device returns an integer code signifying the results of its tests, and 
the function returns these codes in the corresponding elements of result list. A result 
code of 0 indicates that the device passed its tests, and any other value indicates that 
the tests resulted in an error. 

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

failed devices contains the number of devices that failed their tests.

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.
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WaitSRQ
Waits until a device asserts Service Request. The function suspends execution until a 
GPIB device connected on the GPIB asserts the Service Request (SRQ) line. 

This function is similar in format to TestSRQ, except that TestSRQ returns the SRQ 
status immediately, whereas WaitSRQ suspends the program for the duration of the 
timeout period (but no longer) waiting for an SRQ to occur.

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

SRQ. If the SRQ occurs within the timeout period specified in the GPIB 
configuration, the function returns TRUE in SRQ. Otherwise, the function returns 
FALSE.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.
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Low-Level I/O Functions

RcvRespMsg
Reads data bytes from a previously addressed device. This function assumes that another 
function, such as ReceiveSetup, Receive, or SendCmds, has already addressed the GPIB 
Talkers and Listeners. You use RcvRespMsg specifically to skip the addressing step of 
GPIB management. You normally use the Receive function to perform the entire 
sequence of addressing and then to receive the data bytes.

bus. The function addresses the interface indicated by bus as a Talker. See the GPIB 

488.2 Function Parameters section of this chapter for more information.

mode determines the data termination method. If mode is from 0 through decimal 
255, the ASCII character that corresponds to it is the termination character, and the 
function stops the read when it detects the character. If mode is not wired or is 
decimal 256, the read stops when the function detects the END message (EOI).

count. The function reads up to count data bytes from the GPIB. 

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

data string contains the bytes read from the GPIB.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

byte count. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.
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ReceiveSetup
Prepares a device to send data bytes and prepares the GPIB board to read data bytes. 
After you call this function, you can use a function such as RcvRespMsg to transfer the 
data from the Talker. In this way, you eliminate the need to re-address the devices 
between blocks of reads. 

bus. The function addresses the interface indicated by bus as a Listener. See the GPIB 

488.2 Function Parameters section of this chapter for more information.

address. The function addresses the device specified by address as a Talker. See the 

GPIB 488.2 Function Parameters section of this chapter for more information. 

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

byte count. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.
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SendCmds
Sends GPIB command bytes. 

You normally do not need to use SendCmds for GPIB operation. You use it when 
specialized command sequences, not provided for in other functions, must be sent over 
the GPIB.

bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

command string contains the command bytes the function sends over the GPIB. 

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

byte count. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

SendDataBytes
Sends data bytes to previously addressed devices. 
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bus. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

mode indicates the method of signaling the end of the data to the Listeners.

0: Do nothing to mark the end of the transfer.
1: Send NL (linefeed) with EOI after the data bytes.
2: Send EOI with the last data byte in the string.

data string contains the data bytes the function sends over the GPIB. 

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

byte count. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

SendSetup
Prepares particular devices to receive data bytes. You normally follow a call to this 
function with a call to a function such as SendDataBytes to actually transfer the data to 
the Listeners. This sequence eliminates the need to re-address the devices between 
blocks of sends.

bus. The function addresses the interface indicated by bus as a Talker. See the GPIB 

488.2 Function Parameters section of this chapter for more information.
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address list. The function addresses GPIB devices whose addresses appear in address 

list as Listeners. See the GPIB 488.2 Function Parameters section of this chapter for 
more information.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

status. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

byte count. See the GPIB 488.2 Function Parameters section of this chapter for more 
information. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

General Functions

MakeAddr
Combines primary address and secondary address in a specially formatted packed 

address for devices that require both a primary and secondary GPIB address. 

primary address. The function places primary address in the lower byte of the 
packed address.

secondary address. The function places secondary address in the upper byte of the 
packed address.

error in. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.
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packed address contains primary address in its lower byte and secondary address 
in its upper byte. You can use packed address as the address input to the GPIB 488.2 
Functions. 

error out. See the GPIB 488.2 Function Parameters section of this chapter for more 
information.

SetTimeOut
Changes the global timeout period for all GPIB 488.2 Functions. This function also sets 
the default timeout period for all GPIB functions.

new timeout defaults to 10,000 ms.

previous timeout is the previous timeout period for all GPIB 448.2 Functions. 
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Serial Port VIs

Chapter

8

This chapter describes the VIs for serial port operations. 

The following figure shows the Serial palette which you access by 
selecting Functions»Instrument I/O»Serial:

For examples of how to use the Serial Port VIs, see 
examples\instr\smplserl.llb.

You can find helpful information about individual VIs online by using 
the LabVIEW Help window (Help»Show Help). When you place the 
cursor on a VI icon, the wiring diagram and parameter names for that 
VI appear in the Help window. You can also find information for front 
panel controls or indicators by placing the cursor over the control or 
indicator with the Help window open. For more information on the 
LabVIEW Help window, refer to the Getting Help section in Chapter 2, 
Creating VIs, of the LabVIEW User Manual.

In addition to the Help window, LabVIEW has more extensive online 
information available. To access this information, select Help»Online 

Reference. For most block diagram objects, you can select Online 

Reference from the object’s pop-up menu to access the online 
description. You can also access this information by pressing the 
button shown to the left, which is located at the bottom of LabVIEW’s 
Help window. For information on creating your own online reference 
files, see the Creating Your Own Help Files section in Chapter 25, 
Managing Your Applications of the LabVIEW User Manual.

 

This document was created with FrameMaker 4.0.4
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Common Serial Port VI Parameters

Port Number
When you use the serial port VIs under Windows 3.x, the port number 
parameter can have the following values:

0: COM1 5: COM6 10: LPT1
1: COM2 6: COM7 11: LPT2
2: COM3 7: COM8 12: LPT3
3: COM4 8: COM9 13: LPT4
4: COM5

When you use the serial port VIs under Windows 95 or Windows NT, 
the port number parameter is 0 for COM1, 1 for COM2, and so on. 

On a Sun SPARCstation under Solaris 1, the port number parameter for 
the serial port VIs is 0 for /dev/ttya, 1 for /dev/ttyb, and so on. 
Under Solaris 2, port 0 refers to /dev/cua/a, 1 to /dev/cua/b, 
and so on. Under HP-UX port number 0 refers to /dev/tty0p0, 1 to 
/dev/tty1p0, and so on.

On the Macintosh, port 0 is the modem, using the drivers .ain and 
.aout. Port 1 is the printer, using the drivers.bin and .bout. To get 
more ports on a Macintosh, you must install other boards, with the 
accompanying drivers.

For more information about configuring your serial ports, see the 
Serial I/O section of Appendix C, Common Questions.

Handshaking Modes
A common problem in serial communications is ensuring that both 
sender and receiver keep up with data transmission. The serial port 
driver can buffer incoming/outgoing information, but that buffer is of 
a finite size. When it becomes full, the computer ignores new data until 
you have read enough data out of the buffer to make room for new 
information.

Handshaking helps prevent this buffer from overflowing. With 
handshaking, the sender and the receiver notify each other when their 
buffers fill up. The sender can then stop sending new information until 
the other end of the serial communication is ready for new data.
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You can perform two kinds of handshaking in LabVIEW—software 
handshaking and hardware handshaking. You can turn both of these 
forms of handshaking on or off using the Serial Port Init VI. By default, 
the VIs do not use handshaking.

Software Handshaking–XON/XOFF
XON/XOFF is a software handshaking protocol you can use to avoid 
overflowing serial port buffers. When the receive buffer is nearly full, 
the receiver sends XOFF (<control-S> [decimal 19]) to tell the other 
device to stop sending data. When the receive buffer is sufficiently 
empty, the receiver sends XON (<control-Q> [decimal 17]) to indicate 
that transmission can begin again. When you enable XON/XOFF, the 
devices always interpret <control-Q> and <control-S> as XON and 
XOFF characters, never as data. When you disable XON/XOFF, you 
can send <control-Q> and <control-S> as data. Do not use XON/XOFF 
with binary data transfers because <control-Q> or <control-S> may be 
embedded in the data, and the devices will interpret them as XON and 
XOFF instead of as data.

Error Codes
You can connect the error code parameter to one of the error handler 
VIs. These VIs can describe the error and give you options on how to 
proceed when an error occurs. For more information on using the error 
handler VIs, refer to the Error Handling section in Chapter 8, Time & 

Dialog Functions, of the LabVIEW Function Reference Manual.

Some error codes returned by the serial port VIs are platform-specific. 
Please refer to your system documentation for a list of error codes.

Serial Port VI Descriptions

Bytes at Serial Port
Returns in byte count the number of bytes in the input buffer of the serial port indicated 
in port number.
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port number. See the Common Serial Port VI Parameters section of this chapter for 
a list of valid port numbers.

byte count is the number of bytes currently queued up in the serial port buffer.

error code. If error code is non-zero, an error occurred. Refer to Appendix D, Error 

Codes, for a list of error codes.

You can connect error code to one of the error handler VIs. These VIs describe the 
error and give you options on how to proceed when an error occurs. For more 
information on using the error handler VIs, refer to Chapter 12, Error Handler VIs, of 
the LabVIEW Function Reference Manual.

Some error codes returned by the serial port VIs are platform-specific. Please refer 
to your system documentation for a list of error codes.

Serial Port Break
Sends a break on the output port specified by port number for a period of time at least 
as long as the delay input requests.

port number. See the Common Serial Port VI Parameters section of this chapter for 
a list of valid port numbers.

delay is the time interval in msec for which the break must last. The actual period of 
the break can be longer than this interval. On the Sun, delay is ignored; the break 
occurs for at least 0.25 s and no more than 0.5 s.

error code. If error code is non-zero, an error occurred. Refer to Appendix D, Error 

Codes, for a list of error codes.

You can connect error code to one of the error handler VIs. These VIs describe the 
error and give you options on how to proceed when an error occurs. For more 
information on using the error handler VIs, refer to Chapter 12, Error Handler VIs, of 
the LabVIEW Function Reference Manual.
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Some error codes returned by the serial port VIs are platform-specific. Please refer 
to your system documentation for a list of error codes.

Serial Port Init
Initializes the selected serial port to the specified settings.

flow control etc. contains the following parameters. 

Input XON/XOFF. See the Common Serial Port VI Parameters section 
of this chapter for more information.

Input HW Handshake. On the PC and SPARCstation, this parameter 
corresponds to Request To Send (RTS) handshaking.

Input alt HW Handshake. On the PC, this parameter corresponds to 
Data Terminal Ready (DTR) handshaking. On the SPARCstation, this 
parameter is ignored.

Output XON/XOFF. See the Common Serial Port VI Parameters section 
of this chapter for more information.

Output HW Handshake. On the PC and SPARCstation, this parameter 
corresponds to Clear to Send (CTS) handshaking.

Output alt HW Handshake. On the PC, this parameter corresponds to 
Data Set Ready (DSR) handshaking. On the SPARCstation, this 
parameter is ignored.

XOFF byte is the byte used for XOFF (^S).
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XON byte is the byte used for XON (^Q).

Parity Error Byte. If the high byte is non-zero, the low byte is the 
character that is used to replace any parity errors found when parity is 
enabled.

buffer size indicates the size of the input and output buffers the VI allocates for 
communication through the specified port. If buffer size is less than or equal to 1 K, 
the VI uses 1 K as the buffer size. You may need to use larger buffers for large data 
transfers. The buffer size is in bytes.

port number. See the Common Serial Port VI Parameters section of this chapter for 
more information.

baud rate is the rate of transmission.

data bits is the number of bits in the incoming data. The value of data bits is between 
five and eight.

stop bits is 0 for one stop bit, 1 for one-and-a-half stop bits, or 2 for two stop bits. 

parity is 0 for no parity, 1 for odd parity, 2 for even parity, 3 for mark parity, or 4 
for space parity.

error code is -1 if baud rate, data bits, stop bits, parity, or port number are out of 
range, or if the serial port could not be initialized. Check the values of baud rate, 
data bits, stop bits, parity, and port number. If these values are valid, verify that the 
serial port has been initialized. Refer to Appendix D, Error Codes, for a list of error 
codes.

You can connect error code to one of the error handler VIs. These VIs can describe 
the error and give you options on how to proceed when an error occurs. For more 
information on using the error handler VIs, refer to Chapter 12, Error Handler VIs, of 
the LabVIEW Function Reference Manual.

Some error codes returned by the serial port VIs are platform-specific. Please refer 
to your system documentation for a list of error codes.
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Serial Port Read
Reads the number of characters specified by requested byte count from the serial port 
indicated in port number. 

port number. See the Common Serial Port VI Parameters section of this chapter for a 
list of valid port numbers.

requested byte count specifies the number of characters to be read. If you want to 
read all of the characters currently at the serial port, first execute the Bytes at Serial 
Port VI to determine the exact number of bytes ready to be read. Then use the byte 

count output of that VI as the requested byte count input to the Serial Port Read VI.

string read. The VI returns the bytes read in string read. 

error code. If error code is non-zero, an error occurred. Refer to Appendix D, Error 

Codes, for a list of error codes.

You can connect error code to one of the error handler VIs. These VIs describe the 
error and give you options on how to proceed when an error occurs. For more 
information on using the error handler VIs, refer to Chapter 12, Error Handler VIs, of 
the LabVIEW Function Reference Manual.

Some error codes returned by the serial port VIs are platform-specific. Please refer 
to your system documentation for a list of error codes.

Serial Port Write
Writes the data in string to write to the serial port indicated in port number. 
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port number. See the Common Serial Port VI Parameters section of this chapter for a 
list of valid port numbers.

string to write is the data to be written to the serial port. 

error code. If error code is non-zero, an error occurred. Refer to Appendix D, Error 

Codes, for a list of error codes.

You can connect error code to one of the error handler VIs. These VIs describe the 
error and give you options on how to proceed when an error occurs. For more 
information on using the error handler VIs, refer to Chapter 12, Error Handler VIs, of 
the LabVIEW Function Reference Manual.

Some error codes returned by the serial port VIs are platform-specific. Please refer 
to your system documentation for a list of error codes.
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Multiline Interface Messages

Appendix

A

This appendix lists multiline interface messages, which are commands 
that IEEE 488 defines. Multiline interface messages manage the 
GPIB—they perform tasks such as initializing the bus, addressing and 
unaddressing devices, and setting device modes for local or remote 
programming. These multiline interface messages are sent and 
received with ATN TRUE. The following list includes the mnemonics 
and messages that correspond to the interface functions.

For more information on these messages, refer to the ANSI/IEEE 
Standard 488.1-1987, IEEE Standard Digital Interface for 

Programmable Instrumentation.
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Multiline Interface Messages

Hex Oct Dec ASCII Msg

00 000 0 NUL

01 001 1 SOH GTL

02 002 2 STX

03 003 3 ETX

04 004 4 EOT SDC

05 005 5 ENQ PPC

06 006 6 ACK

07 007 7 BEL

08 010 8 BS GET

09 011 9 HT TCT

0A 012 10 LF

0B 013 11 VT

0C 014 12 FF

0D 015 13 CR

0E 016 14 SO

0F 017 15 SI

10 020 16 DLE

11 021 17 DC1 LLO

12 022 18 DC2

13 023 19 DC3
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14 024 20 DC4 DCL

15 025 21 NAK PPU

16 026 22 SYN

17 027 23 ETB

18 030 24 CAN SPE

19 031 25 EM SPD

1A 032 26 SUB

1B 033 27 ESC

1C 034 28 FS

1D 035 29 GS

1E 036 30 RS

1F 037 31 US

20 040 32 SP MLA0

21 041 33 ! MLA1

22 042 34 “ MLA2

23 043 35 # MLA3

24 044 36 $ MLA4

25 045 37 % MLA5

26 046 38 & MLA6

27 047 39 ’ MLA7

28 050 40 ( MLA8

29 051 41 ) MLA9

Hex Oct Dec ASCII Msg
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2A 052 42 * MLA10

2B 053 43 + MLA11

2C 054 44 , MLA12

2D 055 45 - MLA13

2E 056 46 . MLA14

2F 057 47 / MLA15

30 060 48 0 MLA16

31 061 49 1 MLA17

32 062 50 2 MLA18

33 063 51 3 MLA19

34 064 52 4 MLA20

35 065 53 5 MLA21

36 066 54 6 MLA22

37 067 55 7 MLA23

38 070 56 8 MLA24

39 071 57 9 MLA25

3A 072 58 : MLA26

3B 073 59 ; MLA27

3C 074 60 < MLA28

3D 075 61 = MLA29

3E 076 62 > MLA30

3F 077 63 ? UNL

Hex Oct Dec ASCII Msg
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40 100 64 @ MTA0

41 101 65 A MTA1

42 102 66 B MTA2

43 103 67 C MTA3

44 104 68 D MTA4

45 105 69 E MTA5

46 106 70 F MTA6

47 107 71 G MTA7

48 110 72 H MTA8

49 111 73 I MTA9

4A 112 74 J MTA10

4B 113 75 K MTA11

4C 114 76 L MTA12

4D 115 77 M MTA13

4E 116 78 N MTA14

4F 117 79 O MTA15

50 120 80 P MTA16

51 121 81 Q MTA17

52 122 82 R MTA18

53 123 83 S MTA19

54 124 84 T MTA20

55 125 85 U MTA21

Hex Oct Dec ASCII Msg
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56 126 86 V MTA22

57 127 87 W MTA23

58 130 88 X MTA24

59 131 89 Y MTA25

5A 132 90 Z MTA26

5B 133 91 [ MTA27

5C 134 92 \ MTA28

5D 135 93 ] MTA29

5E 136 94 ^ MTA30

5F 137 95 _ UNT

60 140 96 ` MSA0,PPE

61 141 97 a MSA1,PPE

62 142 98 b MSA2,PPE

63 143 99 c MSA3,PPE

64 144 100 d MSA4,PPE

65 145 101 e MSA5,PPE

66 146 102 f MSA6,PPE

67 147 103 g MSA7,PPE

68 150 104 h MSA8,PPE

69 151 105 i MSA9,PPE

6A 152 106 j MSA10,PPE

6B 153 107 k MSA11,PPE

Hex Oct Dec ASCII Msg



Chapter A     Multiline Interface Messages

 National Instruments Corporation A-7 LabVIEW Instrument I/O VI Reference Manual

6C 154 108 l MSA12,PPE

6D 155 109 m MSA13,PPE

6E 156 110 n MSA14,PPE

6F 157 111 o MSA15,PPE

70 160 112 p MSA16,PPD

71 161 113 q MSA17,PPD

72 162 114 r MSA18,PPD

73 163 115 s MSA19,PPD

74 164 116 t MSA20,PPD

75 165 117 u MSA21,PPD

76 166 118 v MSA22,PPD

77 167 119 w MSA23,PPD

78 170 120 x MSA24,PPD

79 171 121 y MSA25,PPD

7A 172 122 z MSA26,PPD

7B 173 123 { MSA27,PPD

7C 174 124 | MSA28,PPD

7D 175 125 } MSA29,PPD

7E 176 126 ~ MSA30,PPD

7F 177 127 DEL

Hex Oct Dec ASCII Msg
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Message Definitions

Mnemonics Definition

DCL Device Clear

GET Group Execute Trigger

GTL Go To Local

LLO Local Lockout

MLA My Listen Address

MSA My Secondary Address

MTA My Talk Address

PPC Parallel Poll Configure

PPD Parallel Poll Disable

PPE Parallel Poll Enable

PPU Parallel Poll Unconfigure

SDC Selected Device Clear

SPD Serial Poll Disable

SPE Serial Poll Enable

TCT Take Control

UNL Unlisten

UNT Untalk
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Operation of the GPIB

Appendix

B

This appendix describes basic concepts you need to understand to 
operate the GPIB. It also contains a description of the physical and 
electrical characteristics of the GPIB and configuration requirements 
of the GPIB.

Types of Messages

The GPIB carries device-dependent messages and interface messages.

• Device-dependent messages, often called data or data messages, 
contain device-specific information such as programming 
instructions, measurement results, machine status, and data files.

• Interface messages manage the bus itself. They are usually called 
commands or command messages. Interface messages perform 
such tasks as initializing the bus, addressing and unaddressing 
devices, and setting device modes for remote or local 
programming.

Do not confuse the term command as used here with some device 
instructions, which can also be called commands. These 
device-specific instructions are actually data messages.

Talkers,  Listeners,  and Controllers

GPIB devices can be Talkers, Listeners, and/or Controllers. A digital 
voltmeter, for example, is a Talker and may be a Listener as well. A 
Talker sends data messages to one or more Listeners. The Controller 
manages the flow of information on the GPIB by sending commands to 
all devices.

The GPIB is like an ordinary computer bus, except that the computer 
has its circuit cards interconnected via a backplane bus, whereas the 
GPIB has stand-alone devices interconnected via a cable bus.

The role of the GPIB Controller is similar to the role of the CPU of a 
computer, but a better analogy is to the switching center of a city 
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telephone system. The switching center (Controller) monitors the 
communications network (GPIB). When the center (Controller) 
notices that a party (device) wants to make a call (send a data 
message), it connects the caller (Talker) to the receiver (Listener).

The Controller addresses a Talker and a Listener before the Talker can 
send its message to the Listener. After the Talker transmits the 
message, the Controller may unaddress both devices.

Some bus configurations do not require a Controller. For example, one 
device may always be a Talker (called a Talk-only device) and there 
may be one or more Listen-only devices.

A Controller is necessary when you must change the active or 
addressed Talker or Listener. A computer usually handles the 
Controller function.

With the GPIB board and its software, your personal computer plays 
all three roles:

• Controller–to manage the GPIB

• Talker–to send data

• Listener–to receive data

The Controller-In-Charge and System Controller

Although there can be multiple Controllers on the GPIB, only one 
Controller at a time is active or Controller-In-Charge (CIC). You can 
pass active control from the current CIC to an idle Controller. Only one 
device on the bus—the System Controller—can make itself the CIC. 
The GPIB board is usually the System Controller.

GPIB Signals and Lines

The interface system consists of 16 signal lines and 8 ground-return or 
shield-drain lines.

The 16 signal lines are divided into three groups:

• Eight data lines

• Three handshake lines

• Five interface management lines
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Data Lines
The eight data lines, DIO1 through DIO8, carry both data and 
command messages. All commands and most data use the 7-bit ASCII 
or International Standards Organization (ISO) code set, in which case 
the eighth bit, DIO8, is unused or is used for parity.

Handshake Lines
Three lines asynchronously control the transfer of message bytes 
among devices. This process is called a three-wire interlocked 
handshake, and it guarantees that message bytes on the data lines are 
sent and received without transmission error.

NRFD (not ready for data)
NRFD indicates whether a device is ready to receive a message byte. 
All devices drive NRFD when they receive commands, and Listeners 
drive it when they receive data messages.

NDAC (not data accepted)
NDAC indicates whether a device has accepted a message byte. All 
devices drive NDAC when they receive commands, and Listeners 
drive it when they receive data messages.

DAV (data valid)
DAV tells whether the signals on the data lines are stable (valid) and 
whether devices can accept them safely. The Controller drives DAV 
when sending commands, and the Talker drives it when sending data 
messages.

Interface Management Lines
Five lines manage the flow of information across the interface.

ATN (attention)
The Controller drives ATN true when it uses the data lines to send 
commands and drives ATN false when a Talker can send data 
messages.

IFC (interface clear)
The System Controller drives the IFC line to initialize the bus and 
become CIC.
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REN (remote enable)
The System Controller drives the REN line, which places devices in 
remote or local program mode.

SRQ (service request)
Any device can drive the SRQ line to asynchronously request service 
from the Controller.

EOI (end or identify)
The EOI line has two purposes. The Talker uses the EOI line to mark 
the end of a message string. The Controller uses the EOI line to tell 
devices to respond in a parallel poll.

Physical and Electrical Characteristics

You usually connect devices with a cable assembly consisting of a 
shielded 24-conductor cable which has both a plug and a receptacle 
connector at each end. With this design, you can link devices in either 
a linear or a star configuration, or a combination of the two.

The standard connector is the Amphenol or Cinch Series 57 
Microribbon or Amp Champ type. You can use an adapter cable with a 
non-standard cable and/or connector for special interconnection 
applications.

The GPIB uses negative logic with standard transistor-transistor logic 
(TTL) level. When DAV is true, for example, it is a TTL low level 
( ≤ 0.8 V), and when DAV is false, it is a TTL high level ( ≥ 2.0 V).
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Figure B-1.   GPIB Connector Showing Signal Assignment
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Figure B-2.   Linear Configuration
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Configuration Requirements

To achieve the high data transfer rate for which the GPIB was 
designed, the physical distance between devices and the number of 
devices on the bus must be limited. The following restrictions are 
typical:

• A maximum separation of 4 m between any two devices and an 
average separation of 2 m over the entire bus.

• A maximum total cable length of 20 m.

• No more than 15 devices connected to each bus, with at least 
two-thirds powered on.

Contact National Instruments for bus extenders if your requirements 
exceed these limits.

Figure B-3.   Star Configuration
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Instrument I/O VI 

Common Questions

Appendix

C

This appendix answers common questions about LabVIEW and 
Instrument I/O. Questions are divided into GPIB and Serial I/O 
sections according to the relevant platform: All, Windows, Macintosh, 
Sun and HP-UX. Please contact National Instruments if you have 
further questions or suggestions regarding LabVIEW.

GPIB

Questions for All Platforms

When using a LabVIEW instrument driver,  I have trouble 
talking with my instrument.

Ensure that your GPIB interface is working properly. Use the example 
LabVIEW<->GPIB.vi located in examples\instr\
smplgpib.llb. Try a simple command to the instrument; for 
example, if the instrument is 488.2, the string *IDN? will ask the 
instrument to send its identification string (about 100 characters).

Once communication is established, you should have no problems with 
the instrument driver.

I get timeout errors with GPIB Read/Write in LabVIEW.

Try running a simple program to establish communication between 
LabVIEW and GPIB. Use the example LabVIEW<->GPIB.vi, 
located in examples\instr\smplgpib.llb. Try a simple 
command to the instrument; for example, if the instrument is 488.2, the 
string *IDN? will ask the instrument to send its identification string 
(about 100 characters).

If you still receive errors with GPIB, you may have a configuration 
problem. Open the GPIB configuration utility (Macintosh: NI-488 
Config; Windows: wibconf; Sun: ibconf; HP-UX: ibconf). 
Verify that the settings match your hardware settings. Exit the 
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configuration utility and run the ibic (Interface Bus Interactive 
Control) utility for your platform (Macintosh: ibic, which ships with 
your GPIB board; Windows: wibic; Sun: ibic; HP-UX: ibic). 
Try the following sequence:

: ibfind gpib0 Find the GPIB interface

id = 32000
gpib0: ibsic Clear the GPIB bus 

(Send Interface Clear)
[0130] [cmpl cic atn] Operation completed successfully
gpib0: ibfind dev1 Find device 1. 

Use appropriate instrument address.

id = 32xxx
dev1: ibwrt “*IDN?” Write string to instrument. 488.2 

instruments recognize this command 
and return their identification string.

count = 5 Five bytes were sent.
dev1: ibrd 100 Read up to 100 bytes from the 

instrument.

Fluke xxx Multimeter… Instrument returns identification 
string.

If you have any configuration errors, you will get an error message in 
one of these steps. The NI 488.2 Software Reference Manual that came 
with your GPIB board has detailed descriptions of the error messages.

Why can I communicate with my GPIB instrument with a 
LabVIEW VI running in execution highlighting mode but not 
when it is running full-speed?

This sounds like a timing problem. VIs run much slower with 
execution highlighting enabled than they will otherwise. Your 
instrument may need more time to prepare the data to send. Add a 
delay function or use service requests before the GPIB Read.vi to 
give the instrument enough time to generate the data it needs to send 
back to the computer. 
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Why can I write successfully to my GPIB instrument but can't 
read back from it?

When GPIB Write.vi executes, the computer is in talk mode and 
the instrument is in listen mode. When GPIB Read.vi executes, the 
device is supposed to switch to talk mode and the computer to listen 
mode. The device is prompted to switch modes by a termination signal 
which may be a character (End Of String) or a GPIB bus line (End Or 
Identify). So, if GPIB Read.vi times out or returns an EABO 
(Operation aborted) error, it means that the device is not receiving the 
right termination signal. To determine the termination mode for a 
given instrument, refer to its manual. As a rule of thumb, all IEEE 
488.2 devices terminate on <CR><LF> and assertion of the EOI (End 
Or Identify) line in the GPIB bus.

Use the configuration utility for your platform (Macintosh: NI-488 
Config; Windows: wibconf; Sun: ibconf; HP-UX: ibconf) to 
change the termination character.

A VI which talks with a GPIB instrument works fine on one 
platform and not on another.

Make sure that the instrument is configured properly in wibconf, 
NI-488 Config, or ibconf. Some older, 488.1 instruments do not 
automatically go to remote state. Go to the GPIB configuration utility 
for your platform and set the field “Assert REN when SC.” This will 
ensure that the instrument goes to remote state (as opposed to local 
state) when it is addressed.

Windows Only

I can communicate with my instrument using a Quick Basic 
program but not from LabVIEW.

The GPIB board has separate handlers for DOS and Windows. Quick 
Basic accesses the DOS handler, but LabVIEW accesses the Windows 
handler. Make sure that the board and device are configured properly 
through wibconf.exe.

Version 3.0.1 does not surrender time to other applications in this 
situation and thus greatly improves the performance of GPIB.
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Serial I/O

Questions for All Platforms

Why doesn’t my instrument respond to commands sent with 
Serial Port Write.vi?

Many instruments expect a carriage return or line feed to terminate the 
command string. he Serial Port Write.vi in LabVIEW sends 
only those characters included in the string input; no termination 
character is appended to the string. Many terminal emulation (for 
example, Windows Terminal) packages automatically append a 
carriage return to the end of all transmissions. With LabVIEW, you 
will need to include the proper termination character in your string 
input to Serial Port Write.vi if your instrument requires it.

Some instruments require a carriage return (\r); others require a line 
feed (\n). When you enter a return on the keyboard (on PC keyboards, 
this is the Enter key on the main alphanumeric keypad), LabVIEW 
inserts a \n (line feed). To insert a carriage return, use Concatenate 
Strings and append a Carriage Return constant to the string, or 
manually enter (\r) after selecting '\' Codes Display from the string 
pop-up menu. To learn more about '\' Codes Display , see the '\' Codes 

Display Option section in Chapter 12, String Controls and Indicators 
of the LabVIEW User Manual.

Make sure that your cable works. Many of our technical support 
questions are related to bad cables. In computer to computer 
communication with serial I/O, use a null-modem to reverse the 
receive and transmit signals.

See the example LabVIEW<->Serial.vi to establish 
communication with your instrument. It is located in examples\
instr\smplserl.llb . The VI also demonstrates the use of 
Bytes at Serial Port.vi before reading data back from the 
serial port.

How do I close a serial port so that other applications can use 
it?

You may wish to close the serial port after use. For example, on 
Windows, a VI may write information using Serial Port 
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Write.vi to lpt1, connected to a printer. After the operation is 
complete, LabVIEW still has control over the serial port. Other 
applications cannot use this port until LabVIEW has released control.

LabVIEW contains a Close Serial Driver.vi on all platforms. 
This VI tells LabVIEW to release control over the specified port. The 
Close Serial Driver.vi is not in the Serial palette; it is 
located in vi.lib\Instr\_sersup.llb. To access the VI, use 
the Functions»VI... or File»Open... commands.

How do I reset or clear a serial port?

Use Serial Port Init.vi to reinitialize the port. This VI will 
automatically clear the serial port buffers associated with the port 
number.

How can I add additional serial ports to my computer?

You can add additional serial ports to your IBM-compatible PC using 
AT bus serial interface boards from National Instruments.  (See 
Windows below).  If you are using another platform, you can use a 
third party board to add serial ports to your computer.  Some third party 
boards require a special language interface that does not conform to the 
standard API for serial ports on the platform.  In this case, you will 
need to write your own interface, probably through a CIN or DLL, to 
the driver.  The following sections explain how to use the serial port 
VIs included in LabVIEW to address boards which use the standard 
serial port interface on the different platforms.

Windows 3.x

LabVIEW for Windows uses the standard Microsoft Windows 
interface to the serial port. Thus, limitations in the use of serial ports 
in LabVIEW are due to limitations in Windows. For example, because 
Windows can only address ports COM1 through COM9, LabVIEW can 
only address these ports. Further, Windows allows access to only eight 
serial ports at any time; thus, LabVIEW can control a maximum of 
eight serial ports at any one time.

National Instruments now sells Plug and Play AT serial boards for a 
variety of solutions for serial communications.  The AT-485 and AT-
232 asynchronous serial interface boards are available in either 2 or 4-
port configurations.  Full Plug and Play compatibility gives you the 
benefits of switchless configuration for easier installation and 
maintenance. The AT-485 and AT-232 include the following software 
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components for use with Windows:  device driver, hardware diagnostic 
test, and configuration utility.  These boards have been tested with 
LabVIEW for Windows.  Contact National Instruments for more 
information:

Manufacturer: National Instruments

Product Name: AT-485 and AT-232

U.S. Office: Tel:  512-794-0100

Fax:  512-794-8411

FaxBack: 800-329-7177, order number 1430

A third party board which uses some work-around to overcome 
Windows limitations will in all probability not work well, if at all, with 
LabVIEW. It is possible to write a CIN or DLL to access such boards, 
but this is not recommended.  In general, boards that use the standard 
Windows interface should be completely compatible with LabVIEW.

Windows 95 and Windows NT

Unlike Windows 3.x , Windows 95 and Windows NT are not limited to 
only eight serial ports. Under Windows 95 and Windows NT, 
LabVIEW can address as many as 256 serial ports if you want. The 
default port number parameter is 0 for COM1, 1 for COM2, 2 for COM3 
and so on.

The file labview.ini contains the LabVIEW configuration options. 
To set the devices which will be used by the serial port VIs, set the 
configuration option labview.serialDevices to the list of 
devices to be used. For example, to set up your devices in a way similar 
to Windows 3.x:

labview.serialDevices=“COM1; COM2; COM3; COM4; 

COM5; COM6; COM7; COM8; COM9; COM10; LPT1; LPT2; 

LPT3; LPT4;”

The above should appear as a single line in your configuration .

Macintosh

LabVIEW uses standard system INITs to talk with the serial ports. By 
default, LabVIEW uses the drivers .aIn and .aOut, the modem port, 
as port 0, and drivers .bIn and .bOut, the printer port, for port 1. To 
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access additional ports, you must install additional boards with the 
accompanying INITs.

After the board and INIT(s) are installed, tell LabVIEW how to use the 
additional ports. The method used in LabVIEW 4.0 is slightly different 
to that used in previous versions.

Modify the global serpOpen.vi (located in vi.lib\Instr\
_sersup.llb) to accommodate the additional ports. All serial port 
VIs call Open Serial Driver.vi, which reads the appropriate 
input and/or output driver names from the serpOpen.vi. The front 
panel of serpOpen.vi contains two string arrays, named input 
driver names and out driver names.

When Open Serial Driver.vi is called, it uses the port number 
input as the index into the string arrays. Therefore, to allow LabVIEW 
to recognize additional serial ports, add additional string elements into 
the input and output driver names, then select Make Current Values 

Default and save the changes to serpOpen.vi.

Each serial port on a plug-in board has two names, one for input and 
one for output. The exact names and instructions for installing the 
drivers comes with the documentation for the board. Contact the board 
manufacturer if the instructions are missing or unclear.

The following boards work with LabVIEW for Macintosh:

Manufacturer: Creative Solutions, Inc.

Product Name: Hurdler HQS (4 ports) or 

HDS (2 ports)
Phone: 301-984-0262

Fax: 301-770-1675

Manufacturer: Greensprings

Product Name: RM 1280 (4 ports)
Phone: 415-327-1200

Fax: 415-327-3808

Sun and HP-UX

When you use the serial port VIs on a Sun SPARCstation under Solaris 
1, the port number parameter is 0 for /dev/ttya, 1 for /dev/ttyb, 2 for 
/dev/ttyc, and so on.  Under Solaris 2, port 0 refers to /dev/cua/a, 1 to 
/dev/cua/b, and so on.. Under HP-UX port number 0 refers to /dev/
tty00, 1 to /dev/tty01, and so on.
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Because other vendor’s serial port boards can have arbitrary device 
names, LabVIEW has developed an easy interface to keep the 
numbering of ports simple. In LabVIEW for Sun version 3.x, a 
configuration option exists to tell LabVIEW how to address the serial 
ports. LabVIEW will support any board which uses standard UNIX 
devices. Some manufacturers suggest using cua rather than tty 
device nodes with their boards. LabVIEW for Sun can address both 
types of nodes.

The file .labviewrc (.Xdefaults in previous versions)contains 
the LabVIEW configuration options. To set the devices which will be 
used by the serial port VIs, set the configuration option 
labview.serialDevices to the list of devices to be used. For 
example, the default is:

labview.serialDevices:/dev/ttya:/dev/ttyb:/dev/

ttyc:...:/dev/ttyz

Note: This requires that any third party serial board installation include a 

method of creating a standard /dev file (node) and that the user knows 

the name of that file.

The following boards should work with LabVIEW for Sun:

Manufacturer: Sun

Product Name: SBus Serial Parallel Controller 
(8 serial, 1 parallel)

Manufacturer: Artecon, Inc.

Product Name: SUNX-SB-300P 

ArtePort SBus Card with 3 Ser / 1 Par Ports
SUNX-SB-400P 

ArtePort SBus Card with 4 Ser / 1 Par Ports
SUNX-SB-1600 

ArtePort SBus Card with 16 Serial Ports

For any of these products contact SunExpress at 800-873-7869.

How can I control the DTR and RTS serial lines?

Serial Port Init.vi can be used to configure the serial port for 
hardware handshaking; however, some applications may require 
manual toggling of the DTR and RTS lines. Because the interface to 
the serial ports is platform-dependent, each platform has a separate 
mechanism to control the lines.
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Windows 

The LabVIEW for Windows distribution contains a VI which you can 
use to drive the DTR and RTS serial lines. The VI serial line 
ctrl.vi, located in vi.lib\Instr\_sersup.llb, can be used 
to control these lines.  The VI will toggle these lines according to the 
function input.  Valid codes for the input are:

0 - noop
1 - clear DTR
2 - set DTR
3 - clear RTS
4 - set RTS
5 - set DTR protocol
6 - clr DTR protocol
7 - noop2

Macintosh 

On the Macintosh, you can use the Device Control/Status 
function to control the serial port. Inside Macintosh (see Volume II, 
pages 245-259 and Volume. IV, pages 225-228), contains specific 
information on what csCodes can be sent to the serial port. A 
summary of the codes and their functions is listed here:

code param Effect

13 baudRate Set baud rate (actual rate, as an integer)

14 serShk Set handshake parameters

16 byte Set miscellaneous control options

17 Asserts DTR

18 Negates DTR

19 char Replace parity errors

20 2 chars Replace parity errors with alternate 
character

21 Unconditionally set XOff for output 
flow control
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22 Unconditionally clear XOff for output 
flow control

23 Send XOn for input flow control if 
XOff was sent last

24 Unconditionally send XOn for input 
flow control

25 Send XOff for input flow control if 
XOn was sent last

26 Unconditionally send XOff for input 
flow control

27 Reset SCC channel

Sun

LabVIEW for Sun contains no specific support to toggle the hardware 
handshaking lines of the serial ports. To manually control these lines, 
you must write a CIN. See the section Steps for Creating a CIN in 
Chapter 1, CIN Overview, of the LabVIEW Code Interface Reference 

Manual for further details on how to write a CIN.

Why can't I allocate a serial buffer larger than 32kbytes?

You can not use a buffer size on Serial Port Init.vi that is 
larger than 32kbytes because Windows and Macintosh limit the serial 
port buffer to 32k; thus, if you allocate a buffer larger than this, 
LabVIEW truncates the buffer size to 32k.  This is not a problem on 
the Sun.

Windows Only

How do I access the parallel port? 

In LabVIEW for Windows, port 10 is LPT1, port 11 is LPT2, and so 
on. To send data to a printer connected to a parallel port, use the 
Serial Port Write.vi. See Chapter 8, Serial Port VIs, for more 
details.
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What do the error numbers received from the serial port VIs 
mean? 

The Serial Port VIs in LabVIEW for Windows return the errors 
reported by the Windows GetCommError function. Error numbers 
returned by the Serial Port VIs are 0x4000 (16,384) 'Or'-ed with the 
error numbers in the following table. Note that the error returned 
reflects the status of the serial port; the error may have been generated 
as the result of a previous serial port function. The return values can be 
a combination of the following errors:

Hex Value Error Name Meaning

0x0001 CE_RXOVER Receiving queue overflowed. There was 
either no room in the input queue or a 
character was received after the end-of-file 
character was received.

0x0002 CE_OVERRUN Character was not read from the hardware 
before the next character arrived. The 
character was lost.

0x0004 CE_RXPARITY Hardware detected a parity error.

0x0008 CE_FRAME Hardware detected a framing error.

0x0010 CE_BREAK Hardware detected a break condition.

0x0020 CE_CTSTO CTS (clear-to-send) timeout. While a 
character was being transmitted, CTS was 
low for the duration specified by the fCtsHold 
member of COMSTAT.

0x0040 CE_DSRTO DSR (data-set-ready) timeout. While a 
character was being transmitted, DSR was 
low for the duration specified by the fDsrHold 
member of COMSTAT.

0x0080 CE_RLSDTO RLSD (receive-line-signal- detect) 
timeout.While a character was being 
transmitted, RLSD was low for the duration 
specified by the fRlsdHold member of 
COMSTAT.
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To use this table, take the error number and dissect it into its error 
components. For example, if Serial Port Write.vi returns the 
error 16,408, then the errors returned are CE_BREAK and CE_FRAME 
(16,408 = 16,384 + 16 + 8 = 0x4000 + 0x0010 + 0x0008).

Sun Only

I receive an error -37 when performing serial I/O.

Error -37 means that LabVIEW cannot find the appropriate serial 
device. This indicates that either a) the /dev/tty? files do not exist 
on your machine, or b) LabVIEW cannot find the file serpdrv.

By default, LabVIEW addresses /dev/ttya as port 0, /dev/ttyb 
as port 1, and so on. These devices must exist and the user must have 
read and write permissions to access the devices. You can change the 
devices LabVIEW accesses with the serial port VIs by adding the 
serialDevices configuration option to your .Xdefaults file. 
See the LabVIEW Configuration Options section in the LabVIEW for 

Sun Release Notes on how to use this option.

The serpdrv file is shipped with LabVIEW and serves as the 
interface between LabVIEW and the Sun serial ports. This file needs 
to be in the location specified by the libdir configuration option, set 

0x0100 CE_TXFULL Transmission queue was full when a function 
attempted to queue a character.

0x0200 CE_PTO Timeout occurred during an attempt to 
communicate with a parallel device.

0x0400 CE_IOE I/O error occurred during an attempt to 
communicate with a parallel device.

0x0800 CE_DNS Parallel device was not selected.

0x1000 CE_OOP Parallel device signaled that it is out of paper.

0x8000 CE_MODE Requested mode is not supported, or the 
idComDev parameter is invalid. If set, 
CE_MODE is the only valid error.

Hex Value Error Name Meaning
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to the LabVIEW directory by default. This means that serpdrv needs 
to be in the same directory as gpibdrv and vi.lib.

Serial I/O hangs on a Solaris 1.x machine.

LabVIEW for Sun uses asynchronous I/O calls when performing serial 
port operations. In the Generic_Small kernel, asynchronous I/O has 
been commented out. To access the serial ports from LabVIEW for 
Sun, the user must use the standard Generic kernel (not 
Generic_Small), or rebuild the Generic_Small kernel and 
reboot the SPARC.
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Error Codes

Appendix

D

This appendix lists the error codes returned by LabVIEW functions, 
including the name and description of each code.

VISA Error Codes

The following table lists the VISA error codes and their descriptions: 

Table D-1.      VISA Error Codes 

Code Name Description

-1073807360 VI_ERROR_SYSTEM_ERROR Unknown system error 
(miscellaneous error).

-1073807346 VI_ERROR_INV_OBJECT 
VI_ERROR_INV_SESSION

The given session or object reference 
is invalid.

-1073807344 VI_ERROR_INV_EXPR Invalid expression specified for 
search.

-1073807343 VI_ERROR_RSRC_NFOUND Insufficient location information or 
the device or resource is not present in 
the system.

-1073807342 VI_ERROR_INV_RSRC_NAME Invalid resource reference specified.  
Parsing error.

-1073807341 VI_ERROR_INV_ACC_MODE Invalid access mode.

-1073807339 VI_ERROR_TMO Timeout expired before operation 
completed.

-1073807338 VI_ERROR_CLOSING_FAILED Unable to deallocate the previously 
allocated data structures 
corresponding to this session or object 
reference.
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-1073807331 VI_ERROR_NSUP_ATTR The specified attribute is not defined 
or supported by the referenced 
resource.

-1073807330 VI_ERROR_NSUP_ATTR_STATE The specified state of the attribute is 
not valid, or is not supported as 
defined by the resource.

-1073807329 VI_ERROR_ATTR_READONLY The specified attribute is read-only.

-1073807322 VI_ERROR_INV_EVENT Specified event type is not supported 
by the resource.

-1073807321 VI_ERROR_INV_MECH Invalid mechanism specified.

-1073807320 VI_ERROR_HNDLR_NINSTALLED A handler was not installed.

-1073807319 VI_ERROR_INV_HNDLR_REF The given handler reference is 
invalid.

-1073807318 VI_ERROR_INV_CONTEXT Specified event context is invalid.

-1073807308 VI_ERROR_RAW_WR_PROT_VIOL Violation of raw write protocol 
occurred during transfer.

-1073807307 VI_ERROR_RAW_RD_PROT_VIOL Violation of raw read protocol 
occurred during transfer.

-1073807306 VI_ERROR_OUTP_PROT_VIOL Device reported an output protocol 
error during transfer.

-1073807305 VI_ERROR_INP_PROT_VIOL Device reported an input protocol 
error during transfer.

-1073807304 VI_ERROR_BERR Bus error occurred during transfer.

-1073807302 VI_ERROR_INV_SETUP Unable to start operation because 
setup is invalid (due to attributes 
being set to an inconsistent state).

Table D-1.      VISA Error Codes (Continued)

Code Name Description
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-1073807300 VI_ERROR_ALLOC Insufficient system resources to 
perform necessary memory 
allocation.

-1073807299 VI_ERROR_INV_MASK Invalid buffer mask specified.

-1073807298 VI_ERROR_IO Could not perform read/write 
operation because of I/O error.

-1073807297 VI_ERROR_INV_FMT A format specifier in the format string 
is invalid.

-1073807295 VI_ERROR_NSUP_FMT A format specifier in the format string 
is not supported.

-1073807294 VI_ERROR_LINE_IN_USE The specified trigger line is currently 
in use.

-1073807286 VI_ERROR_SRQ_NOCCURRED Service request has not been received 
for the session.

-1073807282 VI_ERROR_INV_SPACE Invalid address space specified.

-1073807279 VI_ERROR_INV_OFFSET Invalid offset specified.

-1073807276 VI_ERROR_NSUP_OFFSET Specified offset is not accessible from 
this hardware.

-1073807273 VI_ERROR_WINDOW_NMAPPED The specified session is not currently 
mapped.

-1073807265 VI_ERROR_NLISTENERS No Listeners condition is detected 
(both NRFD and NDAC are 
deasserted).

-1073807264 VI_ERROR_NCIC The interface associated with this 
session is not currently the controller 
in charge.

-1073807257 VI_ERROR_NSUP_OPER The given session or object reference 
does not support this operation.

Table D-1.      VISA Error Codes (Continued)

Code Name Description
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Instrument Driver Error Codes

The following table lists the error codes reserved for LabVIEW 
instrument drivers.  Error codes -1200 to -1299 are reserved for 
instrument driver specific I/O error.  -1300 and above are reserved for 
instrument specific error codes.  All instrument specific error codes 
should be represented with a corresponding error message in the 
PREFIX Error Message VI.

-1073807242 VI_ERROR_NSUP_WIDTH Specified width is not supported by 
this hardware.

-1073807239 VI_ERROR_INV_PROT The protocol specified is invalid.

-1073807237 VI_ERROR_INV_SIZE Invalid size of window specified.

-1073807232 VI_ERROR_WINDOW_MAPPED The specified session already contains 
a mapped window.

-1073807231 VI_ERROR_NIMPL_OPER The given operation is not 
implemented.

Table D-2.      Instrument Driver Error Codes 

Status Description Set By

0 No error:  the call was successful

-1200 Invalid syntax string VISA Transition Library

-1201 Error finding instruments VISA Transition Library

-1202 Unable to initialize interface or instrument VISA Transition Library

-1205 Invalid Instrument Handle VISA Transition Library

-1210 Parameter out of range Instrument Driver VI

-1215 Error closing instrument VISA Transition Library

-1218 Error getting attribute VISA Transition Library

Table D-1.      VISA Error Codes (Continued)

Code Name Description
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GPIB Error Codes

The following table lists the GPIB error codes and their descriptions:

-1219 Error setting attribute VISA Transition Library

-1223 Instrument identification query failed Instrument Driver Initialize VI

-1224 Error clearing instrument VISA Transition Library

-1225 Error triggering instrument VISA Transition Library

-1226 Error polling instrument VISA Transition Library

-1230 Error writing to instrument VISA Transition Library

-1231 Error reading from instrument VISA Transition Library

-1236 Error interpreting instrument response Instrument Driver VI

-1240 Instrument timed out VISA Transition Library

-1250 Error mapping VXI address VISA Transition Library

-1251 Error unmapping VXI address VISA Transition Library

-1252 Error accessing VXI address VISA Transition Library

-1260 Function not supported by controller VISA Transition Library

-1300 Instrument-specific error

-13xx Developer specified error codes

Table D-3.      GPIB Error Codes 

Code Name Description

0 EDVR Error connecting to driver.

1 ECIC Command requires GPIB Controller to be CIC.

Table D-2.      Instrument Driver Error Codes (Continued)

Status Description Set By
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2 ENOL Write detected no Listeners.

3 EADR GPIB Controller not addressed correctly.

4 EARG Invalid argument or arguments.

5 ESAC Command requires GPIB Controller to be SC.

6 EABO I/O operation aborted.

7 ENEB Non-existent board.

8 EDMA DMA Hardware error detected.

9 EBTO DMA hardware µP bus timeout.

11 ECAP No capability.

12 EFSO File system operation error.

13 EOWN Shareable board exclusively owned.

14 EBUS GPIB bus error.

15 ESTB Serial poll byte queue overflow.

16 ESRQ SRQ stuck on.

17 ECMD Unrecognized command.

19 EBNP Board not present.

20 ETAB Table error.

30 NADDR No GPIB address input.

31 NSTRG No string input (write).

32 NCNT No count input (read).

Table D-3.      GPIB Error Codes (Continued)

Code Name Description
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Serial Port Error Codes
The following table lists the Serial Port error codes and their 
descriptions:

Table D-4.      Serial Port Error Codes

Code Name Description

61 EPAR Serial port parity error.

62 EORN Serial port overrun error.

63 EOFL Serial port receive buffer overflow.

64 EFRM Serial port framing error.

65 SPTMO Serial port timeout, bytes not received at serial port.
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Customer Communication

Appendix

E

For your convenience, this appendix contains forms to help you gather the information necessary 
to help us solve your technical problems and a form you can use to comment on the product 
documentation.  When you contact us, we need the information on the Technical Support Form 
and the configuration form, if your manual contains one, about your system configuration to 
answer your questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to 
quickly provide the information you need.  Our electronic services include a bulletin board 
service, an FTP site, a FaxBack system, and e-mail support.  If you have a hardware or software 
problem, first try the electronic support systems.  If the information available on these systems 
does not answer your questions, we offer fax and telephone support through our technical support 
centers, which are staffed by applications engineers.  

Electronic Services

Bulletin Board Support

National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of 
files and documents to answer most common customer questions.  From these sites, you can also 
download the latest instrument drivers, updates, and example programs.  For recorded 
instructions on how to use the bulletin board and FTP services and for BBS automated 
information, call (512) 795-6990. You can access these services at:

United States:  (512) 794-5422 or (800) 327-3077
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635  551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  1 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support

To access our FTP site, log on to our Internet host, ftp.natinst.com, as  anonymous and use your 
Internet address, such as joesmith@anywhere.com, as your password.  The support files 
and documents are located in the /support directories.

 

This document was created with FrameMaker 4.0.4



FaxBack is a 24-hour information retrieval system containing a library of documents on a wide 
range of technical information.  You can access FaxBack from a touch-tone telephone at the 
following numbers:

(512) 418-1111 or (800) 329-7177

E-M ail Support (currently U. S.  only)

You can submit technical support questions to the appropriate applications engineering team 
through e-mail at the Internet addresses listed below.  Remember to include your name, address, 
and phone number so we can contact you with solutions and suggestions. 

GPIB:  gpib.support@natinst.com LabVIEW:  lv.support@natinst.com
DAQ:  daq.support@natinst.com HiQ:  hiq.support@natinst.com
VXI:  vxi.support@natinst.com VISA:  visa.support@natinst.com
LabWindows:  lw.support@natinst.com

Fax and Telephone Support
National Instruments has branch offices all over the world.  Use the list below to find the 
technical support number for your country.  If there is no National Instruments office in your 
country, contact the source from which you purchased your software to obtain support.

 Fax  Telephone

Australia 03 9 879 9422 03 9 879 9179
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Canada (Ontario) 519 622 9310 519 622 9311
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 71 11
Finland 90 527 2321 90 502 2930
France 1 48 14 24 24 1 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Italy 02 48301892 02 48301915
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 95 800 010 0793 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
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Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and 
use the completed copy of this form as a reference for your current configuration.  Completing 
this form accurately before contacting National Instruments for technical support helps our 
applications engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem, 
include the configuration forms from their user manuals.  Include additional pages if necessary.

Name _________________________________________________________________________

Company ______________________________________________________________________

Address _______________________________________________________________________

______________________________________________________________________________

Fax (___)___________________ Phone (___) _______________________________________  

Computer brand ________________ Model ________________ Processor __________________

Operating system (include version number) ___________________________________________

Clock speed ______MHz   RAM _____MB  Display adapter _________________________  

Mouse ___yes   ___no     Other adapters installed ______________________________________

Hard disk capacity _____MB Brand ____________________________________________  

Instruments used ________________________________________________________________

______________________________________________________________________________

National Instruments hardware product model __________  Revision_______________________

Configuration___________________________________________________________________

National Instruments software product ___________________________  Version ____________

Configuration___________________________________________________________________

The problem is: _________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

List any error messages: __________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

The following steps reproduce the problem: ___________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________
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National Instruments encourages you to comment on the documentation supplied with our 
products.  This information helps us provide quality products to meet your needs.

Title: LabVIEW Instrument I/O VI Reference Manual

Edition Date: November 1995

Part Number: 320537C-01

Please comment on the completeness, clarity, and organization of the manual.

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

Thank you for your help.

Name _________________________________________________________________________

Title __________________________________________________________________________

Company ______________________________________________________________________

Address _______________________________________________________________________

______________________________________________________________________________

Phone (      ) ____________________________________________________________________

Mail to: Technical Publications Fax to: Technical Publications

National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway, MS 53-02 (512) 794-5678

Austin, TX  78730-5039
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Glossary

A

ANSI American National Standards Institute. 

array Ordered, indexed set of data elements of the same type.

ASCII American Standard Code for Information Interchange. 

asynchronous Mode in which multiple processes share processor time; one 
executes

execution while the others wait for interrupts, such as while performing 
device I/O or waiting for a clock tick.

ATN The GPIB attention line that distinguishes between commands 
and data messages. When ATN is asserted, bytes on the GPIB 
DIO lines are commands.

C

CIC See Controller-In-Charge. 

Prefix Meaning Value

n- nano- 10-9

µ- micro- 10-6

m- milli- 10-3

k- kilo- 103

M- mega- 106
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commands or GPIB message that performs tasks such as initializing the bus,
command messages addressing and unaddressing devices, and setting device modes.

Controller or The device that manages the GPIB by sending interface messages
Controller-In-Charge to other devices. The GPIB itself can also act as Controller-In-

Charge.

CPU Central processing unit. 

CR Carriage return. 

CTS Clear To Send (line). 

D

data or data messages Device-dependent messages that contain programming 
instructions, measurement results, machine status, and so on.

DAV Data valid. One of the three GPIB handshake lines. See 
handshake. 

device An instrument, peripheral, computer, or other electronics 
equipment that can be programmed over the GPIB. 

device function A function that operates on or otherwise pertains to a GPIB 
device rather than to the GPIB board in the computer. 

DIO Digital Input/Output (line).

DIO1 through DIO8 The GPIB lines that transmit command or data bytes from one 
device to another.

DMA Direct memory access. High-speed data transfer between the 
GPIB and memory that is not handled directly by the CPU. DMA 
is not available on some systems. 

driver Common term for software used to manipulate a device or 
interface board.

DSR Data Set Ready (line).

DTR Data Terminal Ready (line). 
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E

EABO An error code that means the I/O operation aborted.

ECIC An error code that means the function requires the GPIB board to 
be Controller-In-Charge.

EOI End or identify. A GPIB line that is used to signal either the last 
byte of a data message (END) or carry the parallel poll identify 
(IDY) message.

EOS or EOS byte A 7- or 8-bit End-of-String character that is sent as the last byte 
of a data message.

ESAC An error code which means the GPIB board is not System 
Controller as required.

ETAB An error code which means there is a table problem.

G

General Purpose Interface Bus See GPIB.

GPIB General Purpose Interface Bus is the common name for the 
communications interface system defined in ANSI/IEEE 
Standard 488.1-1987 and ANSI/IEEE Standard 488.2-1987. 
Hewlett-Packard, the inventor of the bus, calls it the HP-IB.

GPIB address The address of a device on the GPIB, composed of a primary 
address (MLA and MTA) and perhaps a secondary address 
(MSA). The GPIB board has both a GPIB address and an I/O 
address.

GPIB board Reference to the National Instruments family of GPIB boards.

GTL Go to local. The GPIB command used to place an addressed 
Listener in local (front panel) control mode.

H

handshake The mechanism used to transfer bytes from the source handshake 
function of one device to the acceptor handshake function of 
another device. The three GPIB lines DAV, NRFD, and NDAC 
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are used in an interlocked fashion to signal the phases of the 
transfer, so that bytes can be sent asynchronously (for example, 
without a clock) at the speed of the slowest device.

hex Hexadecimal.

high-level function A device function that combines several rudimentary board 
operations into one function so that the user does not have to be 
concerned with bus management or other GPIB protocol matters. 
See low-level function.

I

IDY Mnemonic for identify, a remote GPIB message. 

IEEE Institute of Electrical and Electronic Engineers.

IFC Mnemonic for interface clear, a remote GPIB message. 

interface message A broadcast message sent from the Controller to all devices and 
used to manage the GPIB. Common interface messages include 
Interface Clear, listen addresses, talk addresses, and Serial Poll 
Enable/Disable. See data or data messages.

I/O Input/output. In the context of this manual, the transmission of 
commands or messages between the computer via the GPIB 
board and other devices on the GPIB.

ISO International Standards Organization.

ist An individual status bit of the status byte used in the parallel poll 
configure function.

L

LabVIEW Laboratory Virtual Instrument Engineering Workbench.

LF Linefeed.

Listener A GPIB device that receives data messages from a Talker.
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LLO Local lockout. The GPIB command used to tell all devices that 
they can or should ignore remote (GPIB) data messages or local 
(front panel) controls, depending on whether the device is in local 
or remote program mode.

LOK Lockout bit. 

low-level function A rudimentary board or device function that performs a single 
operation. 

M

m Meters.

MB Megabytes of memory. 

MLA My Listen Address.

MSA My Secondary Address.

MTA My Talk Address.

N

NaN Digital display value for a floating-point representation of not a 

number, typically the result of an undefined operation, such as 
log(-1).

NDAC Not data accepted. One of the three GPIB handshake lines. See 
handshake.

NL New line or linefeed.

NRFD Not ready for data. One of the three GPIB handshake lines. See 
handshake. 

O

oct Octal. 
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P

parallel poll configure The process of polling all configured devices at once and reading 
a composite poll response. See serial poll.

parallel poll configure See PPC.

parallel poll disable See PPD.

parallel poll enable See PPE.

parallel poll unconfigure See PPU.

PPC The GPIB command that configures an addressed Listener to 
participate in polls.

PPD The GPIB command that disables a configured device from 
participating in polls. There are 16 PPD commands.

PPE The GPIB command that enables a configured device to 
participate in polls and to assign a DIO response line. There are 
16 PPE commands.

PPU The GPIB command that disables any device from participating 
in polls.

R

REN Remote enable. A GPIB line controlled by the System Controller 
but used by the CIC to place devices in remote program mode.

RTS Request To Send (line).

S

SCPI Standard Commands for Programmable Instruments. 

SCSI Small Computer System Interface (bus). 

sec Seconds. 

serial poll The process of polling and reading the status byte of one device 
at a time. See parallel poll.



Glossary

 National Instruments Corporation G-7  LabVIEW Instrument I/O VI Reference Manual

SRQ Service request. The GPIB line that a device asserts to notify the 
CIC that the device needs servicing.

status byte The data byte sent by a device when it is serially polled.

System Controller The single designated Controller that can assert control (become 
CIC of the GPIB) by sending the Interface Clear (IFC) message. 
Other devices can become CIC only by having control passed to 
them.

T

Talker A GPIB device that sends data messages to Listeners.

timeout A feature of LabVIEW that prevents I/O functions from hanging 
indefinitely when there is a problem on the GPIB.

TTL Transistor-transistor logic. 

U

UNL Unlisten. The GPIB command that unaddresses any active 
Listeners.

UNT Untalk The GPIB command that unaddresses an active Talker.

V

VI Virtual instrument. LabVIEW program; so called because it 
models the appearance and function of a physical instrument.

VISA Virtual Instrument Software Architecture. A single interface 
library for controlling VXI, GPIB, RS-232, and other types of 
instruments.

W

wire Data path between nodes.
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A
action VIs, for instrument drivers, 2-7
address parameter, GPIB 488.2 functions

specifying, 1-13
address parameter, GPIB functions

changing primary and secondary 
addresses, 7-2

default primary address, 7-2
primary address, 7-2
secondary address, 7-2

address string parameter, traditional GPIB 
functions, 6-2

AllSPoll function, 7-9 to 7-10
ANSI/IEEE Standard 488.1-1987, 1-9
application instrument driver VIs

definition, 2-6
example, 2-6
instrument driver development 

considerations, 3-24
purpose and use, 2-6

Assert or unassert remote enable. See sre 
(Unassert or assert remote enable function).

ATN (attention) line, B-3

B
block diagram

for instrument drivers, 3-19
bulletin board access for instrument driver, 1-2
bus extenders for GPIB devices, B-7
bus management functions

FindLstn, 1-13, 7-16 to 7-17
list of functions, 1-15 to 1-16
overview, 1-15
ResetSys, 7-17 to 7-18
SendIFC, 7-18

SendLLO, 7-18 to 7-19
SetRWLS, 7-19 to 7-20
TestSRQ, 7-20
TestSys, 7-21
WaitSRQ, 7-22

bus parameters, GPIB 488.2 functions, 7-2
byte count parameters, GPIB 488.2 

functions, 7-2
Bytes at Serial Port VI, 8-7

C
cac (Become active Controller) function, 

6-19
CD-ROM distribution of instrument 

drivers, 1-2
CIC (Controller-In-Charge), B-2
Close VI

PREFIX Close VI, 4-6 to 4-7
required for instrument drivers, 2-7

cmd (Send IEEE 488 commands)
 function, 6-20

command messages, GPIB, B-1
command strings

functions (table), 6-6 to 6-7
compatible hardware. See hardware 

compatible with GPIB.
component instrument drivers VIs

action/status, 2-7
close VI, 2-7
configuration VIs, 2-7
data VIs, 2-7
developer-specified VIs, 2-8
initialize VI, 2-7
template VIs, 2-8
utility VIs, 2-7
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Conduct parallel poll function. See rpp 
(Conduct parallel poll) function.

configuration utility, for changing GPIB 
function parameters, 7-2

configuration, GPIB
linear configuration (illustration), B-6
requirements, B-7
star configuration (illustration), B-7

connector pane, for instrument drivers
rules for creating, 3-20 to 3-21
selecting pattern with extra terminals 

(note), 3-21
connector, GPIB, B-5
Controller functions

cac (Become active Controller), 6-19
cmd (Send IEEE 488 commands), 6-20
dma (Set DMA mode or programmed I/O 

mode), 6-20
gts (Go from active Controller to 

standby), 6-20 to 6-21
ist (Set individual status bit), 6-21
llo (Local lockout), 6-22
loc (Place Controller in local state), 6-22
off (Take controller offline), 6-22
ppc (Parallel poll configure, enable and 

disable), 6-22 to 6-23
ppu (Parallel poll unconfigure), 6-23
rpp (Conduct parallel poll), 6-23
rsc (Release or request 

system control), 6-23
rsv (Request service and/or set the serial 

poll status byte), 6-24
sic (Send interface clear), 6-24
sre (Unassert or assert 

remote enable), 6-25
Controller-In-Charge (CIC), B-2
Controllers

address string when using multiple 
Controllers, 6-2

compatibility of National Instruments 
GPIB boards, 1-10 to 1-12

controlling IEEE 488.1 and IEEE 488.2 
devices, 1-14

forcing GPIB board to be 
Controller, 7-18

GPIB error codes (table), 6-11 to 6-12
IEEE Standard 488.2, 1-9
LLO (Local Lockout) 

message, 7-18 to 7-19
operation of GPIB Controller, B-2
PPE (Parallel Poll Enable) 

message, 6-21
required capabilities, 1-10
status bits (table), 6-10

controls
descriptions for online help, 3-22
front panel of instrument drivers

guidelines for placing, 3-17 to 3-18
required controls, 3-16 to 3-17

customer communication, xix, E-1

D
data acquisition boards

compatibility with LabVIEW software
LabVIEW for HP-UX, 1-11
LabVIEW for 

Macintosh, 1-11 to 1-12
LabVIEW for Sun, 1-11
LabVIEW for Windows 3.x, 1-10
LabVIEW for Windows NT, 1-11

data dependency
in instrument drivers, 3-13

data lines, GPIB, B-3
data messages, GPIB, B-1
data types

icons for, xvii to xviii

data VIs, for instrument drivers, 2-7
DAV (data valid) line, B-3
DCL (Device Clear) message, 6-4, 6-24, 7-17
Design, 3-4
DevClear function, 7-3
DevClearList function, 7-10
developer-specified VIs, for instrument 

drivers, 2-8
Device Clear message. See DCL (Device 

Clear) message.
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device functions
command strings functions 

(table), 6-6 to 6-7
loc (Go to local), 6-17
off (Take device offline), 6-18
pc (Pass control), 6-18
ppc (Parallel poll configure), 6-18 to 6-19

dma (Set DMA mode or programmed I/O 
mode) function, 6-20

documentation
conventions, xvi to xviii

organization of manual, xv to xvi

related documentation, xviii

DTR serial lines
Macintosh, C-9 to C-10
Sun, C-10
Windows, C-9

E
electrical characteristics of GPIB, B-4 to B-7
EnableLocal function, 7-11
EnableRemote function, 7-11 to 7-12
EOI (end or identify) line, B-4
error codes

GPIB (table), D-5 to D-6
instrument driver (table), D-4 to D-5
serial port VIs, 8-3
serial ports (table), D-7
VISA (table), D-1 to D-4

error handler VIs
connecting error codes with, 8-7

error message VI
PREFIX Error Message VI, 4-7 to 4-8

error parameters
traditional GPIB functions, 6-2

error query VI
PREFIX Error Query VI, 4-9 to 4-10

error reporting
instrument driver front panel, 3-17
instrument driver template VIs, 4-5
instrument drivers, 2-9

errors
ESAC error, 6-25

GPIB error codes (table), 6-11 to 6-12
obtaining error information, 1-13

ESAC error, 6-25

F
Fast Data Channel Mode, 5-27
Fast Data Channel Number, 5-27
Fast Data Channel Pair, 5-27
Fast Data Channel Signal Enable, 5-28
FindLstn function

description, 7-16 to 7-17
implementation of Find All Listeners 

protocol, 1-13
FindRQS function, 7-12 to 7-13
Format & Append function, 3-12
front panel

for instrument drivers
control guidelines, 3-17 to 3-18
general requirements, 3-16
required controls, 3-16 to 3-17

functional body of instrument drivers
application VIs, 2-5
component VIs, 2-5
external interface model, 2-2
internal interface model, 2-4 to 2-5

Functions palettepalette
GPIB 488.2, 7-1
GPIB Traditional option, 6-1
Instrument I/O option, 6-1, 7-1, 8-1

functions. See Controller functions; device 
functions.

G
general functions

list of functions, 1-17
overview, 1-17
MakeAddr, 7-27
SetTimeOut, 7-28

General Purpose Interface Bus. See GPIB.
GET (Group Execute Trigger) message, 6-12
Go from active Controller to standby 

function. See gts (Go from active Controller 
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to standby)
Go To Local function. See loc (Go to local) 

device function.
Go To Local message. See GTL (Go To Local) 

message.
GPIB

ANSI/IEEE Standard 488.1-1987, 1-9
command messages, B-1
common questions, C-1 to C-3
compatible GPIB hardware

LabVIEW for 
Macintosh, 1-11 to 1-12

LabVIEW for Sun, 1-11
LabVIEW for Windows 3.x, 1-10

configuration
linear configuration 

(illustration), B-6
requirements, B-7
star configuration (illustration), B-7

Controller-In-Charge, B-2
Controllers, B-2 to B-4
data lines, B-3
data messages, B-1
definition, 1-9
electrical characteristics, B-4 to B-7
error codes, D-5 to D-6
GPIB connector signal assignment, B-5
handshake lines, B-3
history, 1-9
IEEE 488.1 standard, 1-9
IEEE 488.2 standard, 1-9
IEEE Standard 488-1975, 1-9
interface management lines, B-3 to B-4
Listeners, B-1 to B-2
physical characteristics, B-4 to B-7
questions and answers about 

instrument I/O, C-1 to C-3
System Controller, B-2
Talkers, B-1 to B-2
types of messages, B-1

GPIB 488.2 functions
bus management functions

FindLstn, 7-16 to 7-17

list of functions, 1-15 to 1-16
ResetSys, 7-17 to 7-18
SendIFC, 7-18
SendLLO, 7-18 to 7-19
SetRWLS, 7-19 to 7-20
TestSRQ, 7-20
TestSys, 7-21
WaitSRQ, 7-22

compared with traditional GPIB 
functions, 1-12

enhancements and additions, 1-12
example in smplgpib.llb, 7-1
general functions

list of functions, 1-17
MakeAddr, 7-27
SetTimeOut, 7-28

getting help, 7-1
low-level I/O functions

list of functions, 1-16
RcvRespMsg, 7-23
ReceiveSetup, 7-24
SendCmds, 7-25
SendDataBytes, 7-25 to 7-26
SendSetup, 7-26 to 7-27

multiple-device functions
AllSPoll, 7-9 to 7-10
DevClearList, 7-10
EnableLocal, 7-11
EnableRemote, 7-11 to 7-12
FindRQS, 7-12 to 7-13
list of functions, 1-15
PPoll, 7-13
PPollUnconfig, 7-14
SendList, 7-14 to 7-15
TriggerList, 7-15 to 7-16

overview, 1-9 to 1-10
parameter descriptions, 7-2
single-device functions

DevClear, 7-3
PassControl, 7-5
PPollConfig, 7-4
ReadStatus, 7-5 to 7-6
Receive, 7-6 to 7-7
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Send, 7-7 to 7-8
Trigger, 7-8 to 7-9

GPIB 488.2 option, Functions palette, 7-1
GPIB 488.2 palette, 7-1
GPIB 488.2 VIs

bus management function
FindLstn, 1-13

GPIB Clear function, 6-4
GPIB error parameter, GPIB 488.2 

functions, 7-2
GPIB Initialization function

changing primary address, 7-2
description, 6-4 to 6-5

GPIB Misc Function
changes from previous versions, 1-13

GPIB Misc function
description, 6-5 to 6-7

GPIB option, Function palette
GPIB 488.2 palette, 7-1

GPIB Primary Address, 5-28
GPIB Read function

description, 6-7 to 6-8
GPIB Secondary Address, 5-28
GPIB Serial Poll function, 6-9
GPIB Status function

description, 6-9 to 6-12
no longer used, 1-13

GPIB Traditional Functions palette, 6-1
GPIB Trigger function, 6-12 to 6-13
GPIB Wait function

description, 6-13 to 6-14
GPIB Write function

description, 6-16
leaving devices in addressed state, 6-3

Group Executive Trigger message. See GET 
(Group Executive Trigger) message.

GTL (Go To Local) message, 7-11
gts (Go from active Controller to standby) 

function, 6-20 to 6-21

H
handshake lines, GPIB

DAV (data valid), B-3

NDAC (not data accepted), B-3
NRFD (not ready for data), B-3

handshaking
handshaking modes, serial port 

VIs, 8-2 to 8-3
software handshaking 

(XON/XOFF), 8-3
hardware, 1-9
hardware compatible with GPIB

LabVIEW for HP-UX, 1-11
LabVIEW for Macintosh, 1-11 to 1-12
LabVIEW for Sun, 1-11
LabVIEW for Windows NT, 1-11

Hewlett-Packard’s HP-IB, 1-9

I
I/O interfaces of instrument drivers, 2-3
icon, for instrument drivers, 3-20
IDY (Identify) message, 6-19
IFC (interface clear) line, B-3
IFC (Interface Clear) message, 6-23, 6-24, 

7-17, 7-18
Immediate Servant, 5-29
Increment Destination Count, 5-29
Increment Source Count, 5-29
indicators

descriptions for online help, 3-22
initialize VI

PREFIX Initialize VI, 4-10 to 4-12
required for instrument drivers, 2-7

instrument driver development
adding component VI VIs, 3-9 to 3-10
application VIs, 3-23
assembling command 

strings, 3-11 to 3-12
block diagram guidelines, 3-19
checklist, 3-24 to 3-27
connector pane guidelines, 3-20 to 3-21
data dependency considerations, 3-13
design of structure, 3-1 to 3-7

example, 3-6 to 3-7
guidelines and recommendations, 

3-4 to 3-6



Index

LabVIEW Instrument I/O VI Reference Manual Index-6  National Instruments Corporation

organization, 3-3 to 3-4
structure and VI hierarchy, 3-2

error reporting, 3-21
front panel guidelines

control guidelines, 3-17 to 3-18
general requirements, 3-16
required controls, 3-16 to 3-17

icon guidelines, 3-20
loop termination conditions, 3-10 to 3-11
modifying templates, 3-8 to 3-9
online help information, 3-21 to 3-23

control and indicator descriptions, 
3-22

VI descriptions, 3-22
programmatically checking parameter 

ranges, 3-13 to 3-15
instrument driver template VIs

advantages, 1-3
close VI, 2-7
initialize VI, 2-7
lists of available templates, 1-3
modifying, 3-8 to 3-9
overview, 1-3
PREFIX Close, 4-6 to 4-7
PREFIX Error Message, 4-7 to 4-8
PREFIX Error Query, 4-9 to 4-10
PREFIX Initialize, 4-10 to 4-12
PREFIX Message-Based Template, 4-13 

to 4-14
PREFIX Register-Based 

Template, 4-14 to 4-16
PREFIX Reset, 4-16 to 4-17
PREFIX Revision Query, 4-17 to 4-19
PREFIX Self-Test, 4-19 to 4-20
purpose and use, 2-7, 4-1

instrument drivers
definition, 1-1, 2-1
distribution methods, 1-1 to 1-2

bulletin board access, 1-2
CD-ROM distribution, 1-2
Internet access, 1-2

error codes (table), D-4 to D-5
external interface model

functional body, 2-2
I/O interface, 2-3
illustration, 2-2
Interactive Developer Interface, 2-3
programmatic interface, 2-3
subroutine interface, 2-4

internal design model
application VIs, 2-6
component VIs, 2-6 to 2-8
error reporting, 2-9
functional body, 2-4 to 2-5
illustration, 2-5

libraries of drivers, 1-1
overview, 1-1 to 1-3

Instrument I/O option, 6-1, 7-1, 8-1
instrument I/O, questions about

GPIB, C-1 to C-3
serial I/O, C-4 to C-13

Interactive Developer Interface for 
instrument drivers, 2-3

Interface Clear (IFC) message. See IFC 
(Interface Clear) message.

interface management lines, GPIB
ATN (attention), B-3
EOI (end or identify), B-4
IFC (interface clear), B-3
REN (remote enable), B-4
SRQ (service request), B-4

Interface Number, 5-30
Interface Type, 5-30
Internet access to instrument drivers, 1-2
IO Protocol, 5-28
ist (Set individual status bit) function, 6-21

L
LabVIEW GPIB 488.2 VIs. See GPIB 

488.2 VIs.
LabVIEW software

compatibility with data acquisition 
boards

LabVIEW for HP-UX, 1-11
LabVIEW for Macintosh, 1-11
LabVIEW for Sun, 1-11
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LabVIEW for Windows 3.x, 1-10
LabVIEW for Windows NT, 1-11

LabVIEW-compatible GPIB hardware. See 
hardware compatible with GPIB.

lines. See signals and lines, GPIB.
Listeners, B-1 to B-2
llo (Local lockout) function, 6-22
LLO (Local Lockout) message, 7-18 to 7-19
loc (Place Controller in local state) 

function, 6-22
Local lockout function. See llo (Local 

lockout) function.
Local Lockout message. See LLO (Local 

Lockout) message.
Lockout State, setting, 7-19
loop termination method, including in 

instrument drivers, 3-10 to 3-11
low-level I/O functions

list of functions, 1-16
overview, 1-16
RcvRespMsg, 7-23
ReceiveSetup, 7-24
SendCmds, 7-25
SendDataBytes, 7-25 to 7-26
SendSetup, 7-26 to 7-27

LPE (Local Poll Enable) message, 6-22

M
Mainframe Logical Address, 5-30
MakeAddr function

changing primary and secondary address 
formats, 7-2

description, 7-27
manual. See documentation.
Manufacturer ID, 5-30
Maximum Queue Length, 5-31
message-based template VI

PREFIX Message-Based Template VI, 
4-13 to 4-14

mnemonics for multiline interface 
messages, A-8

Model Code, 5-31
multiline interface messages, A-2 to A-7

definitions, A-8
mnemonics, A-8

multiple-device functions
AllSPoll, 7-9 to 7-10
DevClearList, 7-10
EnableLocal, 7-11
EnableRemote, 7-11 to 7-12
FindRQS, 7-12 to 7-13
list of functions, 1-15
overview, 1-15
PPoll, 7-13
PPollUnconfig, 7-14
SendList, 7-14 to 7-15
TriggerList, 7-15 to 7-16

N
NDAC (not data accepted) line, B-3
NRFD (not ready for data) line, B-3

O
off (Take controller offline) function, 6-22
online help information for instrument 

drivers
control and indicator descriptions, 3-22
VI descriptions, 3-22

P
Parallel Poll Enable (PPE) 

message, 6-19, 6-21, 6-23
parallel poll functions

ppc (Parallel poll configure) Controller 
function, 6-22 to 6-23

ppc (Parallel poll configure) device 
function, 6-18 to 6-19

ppu (Parallel poll unconfigure) function, 
6-23

rpp (Conduct parallel poll) function, 
6-23

parameter range checking, for instrument 
drivers, 3-13 to 3-15

Pass control function. See pct (Pass control) 
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function.
PassControl function, 7-5
Pick Line & Append function, 3-12
Place Controller in local state function. See loc 

(Place Controller in local state) function.
port number parameter, serial port VIs, 8-2
ppc (Parallel poll configure, enable and 

disable) function, 6-22 to 6-23
PPE (Parallel Poll Enable) 

message, 6-19, 6-21, 6-23
PPoll function, 7-13
PPollConfig function, 7-4
PPollUnconfig function, 7-14
ppu (Parallel poll unconfigure) function, 6-23
PREFIX Close VI, 4-6 to 4-7
PREFIX Error Message VI, 4-7 to 4-8
PREFIX Error Query VI, 4-9 to 4-10, 

4-10 to 4-12
PREFIX Message-Based Template VI,

 4-13 to 4-14
PREFIX Register-Based Template VI,

4-14 to 4-16
PREFIX Reset VI, 4-16 to 4-17
PREFIX Revision Query VI, 4-17 to 4-19
PREFIX Self-Test VI, 4-19 to 4-20
primary address, GPIB. See address 

parameter, GPIB 488.2 VIs.

Q
questions and answers about I/O

GPIB, C-1 to C-3
serial I/O, C-4 to C-13

R
RcvRespMsg function, 7-23
ReadStatus function, 7-5 to 7-6
Receive function, 7-6 to 7-7
ReceiveSetup function, 7-24
register-based template VI

PREFIX Register-Based Template VI, 
4-14 to 4-16

Release or request system control function. 

See rsc (Release or request system control) 
function.

Remote Enable (REN) message. See REN 
(Remote Enable) message.

Remote With Lockout State, 7-19
REN (remote enable) line, B-4
REN (Remote Enable) message

releasing or requesting with rsc 
function, 6-23

sending with SetRWLS function, 7-19
unasserting or asserting, 6-25, 7-11, 7-17

Request service and/or set the serial poll 
status byte. See rsv (Request service and/or 
set the serial poll status byte) function.

Reset (RST) message, 7-17
reset VI

PREFIX Reset VI, 4-16 to 4-17
ResetSys function, 7-17 to 7-18
Resource Lock State, 5-31
Resource Manufacturer Identification, 5-31
Resource Manufacturer Name, 5-32
Resource Name, 5-32 to 5-33
responsibility for addressing, 6-2
revision query VI

PREFIX Revision Query VI, 
4-17 to 4-19

rpp (Conduct parallel poll) function, 6-23
rsc (Release or request system control) 

function, 6-23
rsv (Request service and/or set the serial poll 

status byte) function, 6-24
RTS serial lines

Macintosh, C-9 to C-10
Sun, C-10
Windows, C-9

S
SCPI (Standard Commands for 

Programmable Instruments), 1-10
SDC (Selected Device Clear) 

message, 6-4, 6-24
secondary address, GPIB. See address 

parameter, GPIB 488.2 VIs.
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Selected Device Clear (SDC) message. See 
SDC (Selected Device Clear) message.

self-test VI
PREFIX Self-Test VI, 4-19 to 4-20

Send End Enable, 5-33
Send function, 7-7 to 7-8
Send IEEE 488 commands functions. See cmd 

(Send IEEE 488 commands) function.
Send interface clear function. See sic (Send 

interface clear) function.
SendCmds function, 7-25
SendDataBytes function, 7-25 to 7-26
SendIFC function, 7-18
SendList function, 7-14 to 7-15
SendLLO function, 7-18 to 7-19
SendSetup function, 7-26 to 7-27
serial I/O, questions about, C-4 to C-13
Serial option, 8-1
Serial palette, 8-1
serial poll functions

GPIB Serial Poll VI, 6-9
Serial Port

error codes, D-7
serial port boards, accessing

HP-UX, C-7 to C-8
Macintosh, C-6 to C-7
Windows 3.x, C-5 to C-6
Windows 95 and Windows NT, C-6

serial port buffer
handshaking modes, 8-2 to 8-3
software handshaking (XON/XOFF), 8-3

serial port VIs
Bytes at Serial Port, 8-3 to 8-4, 8-7
common parameters, 8-2
examples in smplserl.llb, 8-1
getting help, 8-1
handshaking modes, 8-2 to 8-3
list of VIs, 1-17
overview, 1-17
port number parameter, 8-2
Serial Port Break, 8-4 to 8-5
Serial Port Init, 8-5 to 8-7
Serial Port Write, 8-7 to 8-8

software handshaking 
(XON/XOFF), 8-3

Set DMA mode or programmed I/O mode 
function. See dma (Set DMA mode or 
programmed I/O mode) function.

Set individual status bit function. See ist (set 
individual status bit) function.

SetRWLS function, 7-19 to 7-20
SetTimeOut function

changing timeout value, 7-2
description, 7-28

sic (Send interface clear) function, 6-24
signal and lines, GPIB

data lines, B-3
handshake lines

DAV (data valid), B-3
NDAC (not data accepted), B-3
NRFD (not ready for data), B-3

interface management lines
ATN (attention), B-3
EOI (end or identify), B-4
IFC (interface clear), B-3
REN (remote enable), B-4
SRQ (service request), B-4

single-device functions
list of functions, 1-14
overview, 1-14
DevClear, 7-3
PassControl, 7-5
PPollConfig, 7-4
ReadStatus, 7-5 to 7-6
Receive, 7-6 to 7-7
Send, 7-7 to 7-8
Trigger, 7-8 to 7-9

Slot, 5-33
software handshaking (XON/XOFF), 8-3
sre (Unassert or assert remote enable) 

function, 6-25
SRQ, B-4

asserting, 7-12
description, B-4
determining current state, 7-20
requesting with rsv function, 6-24
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standards
ANSI/IEEE Standard 488.1-1987, 1-9
IEEE 488.1 standard, 1-9
IEEE Standard 488.2, 1-9
IEEE Standard 488-1975, 1-9
Standard Commands for Programmable 

Instruments (SCPI), 1-10
status bits

ist (Set individual status bit) 
function, 6-21

table, 6-10
status parameters

GPIB 488.2 functions, 7-2
traditional functions, 6-2
traditional GPIB functions, 6-2

status VIs, for instrument drivers, 2-7
subroutine interface for instrument drivers, 2-4
Suppress End Enable, 5-34
System Controller. See also Controllers.

designation of, 7-2
GPIB Controller as, 6-21
making Controller-in-Charge, 7-17
operation of, B-2

T
Talkers, B-1 to B-2
template VIs. See instrument driver 

template VIs.
Termination Character, 5-34
Termination Character Enable, 5-34, 5-34
TestSRQ function, 7-20
TestSys function, 7-21
Timeout Value, 5-34
timeout value

changing with SetTimeOut 
function, 7-2, 7-28

traditional GPIB functions
behavior, 6-3
compared with GPIB 488.2 

functions, 1-13
examples in smplgpib.llb, 6-1
getting help, 6-1
GPIB Clear function, 6-4

GPIB Initialization, 6-4 to 6-5
GPIB Misc, 1-13, 6-5 to 6-7
GPIB Read, 6-7 to 6-8
GPIB Serial Poll, 6-9
GPIB Status, 6-9 to 6-12
GPIB Trigger, 6-12 to 6-13
GPIB Wait, 6-13 to 6-14
GPIB Write, 6-16
lists of functions, 1-12 to 1-13
overview, 1-12
parameter description, 6-2
Wait for GPIB RQS, 6-15

Trigger function, 7-8 to 7-9
Trigger Identifier, 5-35
TriggerList function, 7-15 to 7-16
troubleshooting. See questions and answers 

about instrument I/O.

U
Unassert or assert remote enable. See sre 

(Unassert or assert remote enable) function.
User Data, 5-35
utility VIs, for instrument drivers, 2-7

V
Version of Implementation, 5-36
Version of Specification, 5-36
VI descriptions, 3-22
Virtual Instrument Software Architecture 

(VISA), 1-4
VISA Assert Trigger function, 5-3 to 5-4
VISA Attribute Node, 5-26 to 5-38

description, 1-6
list of attributes, 1-6 to 1-8
VISA Attribute Descriptions

Fast Data Channel Mode, 5-27
Fast Data Channel Number, 5-27
Fast Data Channel Pair, 5-27
Fast Data Channel Signal 

Enable, 5-28
GPIB Primary Address, 5-28
GPIB Secondary Address, 5-28
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Immediate Servant, 5-29
Increment Destination Count, 5-29
Increment Source Count, 5-29
Interface Number, 5-30
Interface Type, 5-30
IO Protocol, 5-28
Mainframe Logical Address, 5-30
Manufacturer ID, 5-30
Maximum Queue Length, 5-31
Model Code, 5-31
Resource Lock State, 5-31
Resource Manufacturer 

Identification, 5-31
Resource Manufacturer Name, 5-32
Resource Name, 5-32 to 5-33
Send End Enable, 5-33
Slot, 5-33
Suppress End Enable, 5-34
Termination Character, 5-34
Termination Character Enable, 5-34, 

5-34
Timeout Value, 5-34
Trigger Identifier, 5-35
User Data, 5-35
Version of Implementation, 5-36
Version of Specification, 5-36
VXI Commander Logical 

Address, 5-36
VXI Logical Address, 5-37
VXI Memory Address Space, 5-37
VXI Memory Base Address, 5-37
VXI Memory Size, 5-37
Window Access, 5-38
Window Base Address, 5-38
Window Size, 5-38

VISA Clear function, 5-4
VISA Close function, 5-4 to 5-5
VISA Disable Event function, 5-12 to 5-13
VISA Discard Events function, 5-13 to 5-14
VISA Enable Event function, 5-14
VISA Find Resource function, 5-5 to 5-6
VISA function

list of functions, 1-4 to 1-6

VISA functions overview, 1-4
VISA In8 / In16 / In32 function, 5-16 to 5-17
VISA Library Function, 5-1
VISA Library palette, 5-1
VISA Library Reference

definition, 1-4
overview, 1-4

VISA Lock function, 5-6
VISA Map Address function, 5-23, 5-25
VISA Memory Allocation function, 5-18, 

5-23
VISA Memory Free function, 5-18, 5-24
VISA Move In8 / Move In16 / Move In32 

function, 5-19 to 5-20
VISA Move Out8 / Move Out16 / Move 

Out32 function, 5-20 to 5-21
VISA Open function, 5-7 to 5-8
VISA Operation Descriptions

Event Handling functions
VISA Disable Event function, 

5-12 to 5-13
VISA Discard Events function, 

5-13 to 5-14
VISA Enable Event 

function, 5-14
VISA WaitOnEvent function, 

5-15 to 5-16
High Level Register Access functions

VISA In8 / In16 / In32 function, 
5-16 to 5-17

VISA Memory Allocation 
function, 5-18

VISA Memory Free function, 5-18
VISA Move In8 / Move In16 / Move 

In32 function, 5-19 to 5-20
VISA Move Out8 / Move Out16 / 

Move Out32 function, 
5-20 to 5-21

VISA Out8 /Out16 / Out32 
function, 5-21 to 5-22

Low Level Register Access functions
VISA Map Address function, 

5-23, 5-25
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VISA Memory Allocation 
function, 5-23

VISA Memory Free function, 5-24
VISA Peek8 / Peek16 / Peek32 

function, 5-24
VISA Poke 8 / Poke 16 / Poke 32 

function, 5-25
VISA Assert Trigger function, 5-3 to 5-4
VISA Clear function, 5-4
VISA Close function, 5-4 to 5-5
VISA Find Resource function, 5-5 to 5-6
VISA Lock function, 5-6
VISA Open function, 5-7 to 5-8
VISA Read function, 5-8 to 5-9
VISA Read STB function, 5-9 to 5-10
VISA Status Description function, 5-10
VISA Unlock function, 5-11
VISA Write function, 5-11 to 5-12

VISA Operation Parameters, 5-2 to 5-3
VISA Out8 /Out16 / Out32 function, 

5-21 to 5-22
VISA Peek8 / Peek16 / Peek32 function, 5-24
VISA Poke8 / Poke16 / Poke32 function, 5-25
VISA Read function, 5-8 to 5-9
VISA Read STB function, 5-9 to 5-10
VISA session input control, required for 

instrument driver front panel, 3-17
VISA session output control, required for 

instrument driver front panel, 3-17
VISA Status Description function, 5-10
VISA Unlock function, 5-11
VISA WaitOnEvent function, 5-15 to 5-16
VISA Write function, 5-11 to 5-12
VXI Commander Logical Address, 5-36
VXI Logical Address, 5-37
VXI Memory Address Space, 5-37
VXI Memory Base Address, 5-37
VXI Memory Size, 5-37

W
Wait for GPIB RQS, 6-15
wait state vector bits (table), 6-14
WaitSRQ function, 7-22

Window Access, 5-38
Window Base Address, 5-38
Window Size, 5-38
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